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In This Guide 
This guide covers the following module: NovoExpress (Opteon) Software 

1 Prologue 

This chapter provides basic information for NovoExpress (Opteon) and the 
software guide, including overview of NovoExpress (Opteon), scope of this guide, 
keyboard shortcuts and glossary. 

2 Installation 

This chapter describes the installation requirements, procedures to install, start 
and uninstall the NovoExpress (Opteon) software, NovoExpress (Opteon) license 
registration and dissociation, and user management feature. 

3 Use NovoExpress (Opteon) Software 

This chapter provides information needed to use NovoExpress (Opteon) software, 
including overview of NovoExpress (Opteon) software interface, Title Block, Menu, 
Workspace Toolbar, Cytometer Setting panel, Fluorochrome Setting panel, 
Cytometer Control panel, Plate Manager panel, Experiment Manager panel, 
Cytometer Status panel, Gate Manager panel, Status Bar, Instrument 
Configuration window, Manage Plate Types window, New Reference Control 
Specimen window, Reference Spectra window, Option Setting window, 
Fluorochrome Library window. 

4  Sample Acquisition 

This chapter provides the information for sample acquisition function, including 
Cytometer Setting panel, Fluorochrome Setting panel, Sample Keywords, Work 
List and Cytometer Control panel. 

5 Data Analysis 

This chapter provides information for data analysis tools, including Plots, Gates, 
Statistics, Spectral Unmixing and Compensation, Cell Cycle Analysis, Cell 
Proliferation Analysis, Statistical Tables, Heat Maps. 

6 Plate Manager 

This chapter provides the information for the Plate Manager panel, including 
overview of Plate Manager panel and context menu. 
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7 Experiment Manager 

This chapter provides the information for the Experiment Manager function, 
including Experiment Manager Toolbar, Hierarchy, Templates, Import and Export 
Data. 

8 Reports 

This chapter provides information for the Report function, including Report 
Interface, Automatically Generate Reports, Report Options, Report Editor, Report 
Output and Batch Print Reports. 

9 QC Test 

This chapter describes the procedures to run QC Test and view the report for 
Agilent flow cytometers. 

10 Troubleshoot 

This chapter provides the information for troubleshooting Instrument and 
associated accessories, including prompted message ID, software messages, 
possible causes, recommended solutions, and procedures to create technical 
support files. 

11 Version History 
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1 Prologue 

This chapter provides basic information for NovoExpress (Opteon) and the 
software guide, including overview of NovoExpress (Opteon), scope of this guide, 
keyboard shortcuts and glossary. 

About NovoExpress (Opteon) 

NovoExpress (Opteon) Software provides users with the ability to control data 
collection and analysis on NovoCyte Opteon Spectral flow cytometer and 
associated accessories. The software contains features to control Quality Control 
(QC) test, sample acquisition, data analysis, and report generation.  

 

NOTE NovoExpress (Opteon) software is compatible with NovoCyte Opteon Spectral Flow 
Cytometer and associated accessories only. When opening any experiment files 
(*.ncf) generated by NovoExpress software (e.g., NovoExpress v1.6.2 and below) in 
NovoExpress (Opteon) software, following error message will be prompted. Please 
contact Agilent technical support for any further questions. 

 

Using this Guide 

This guide contains an overview and information on using NovoExpress (Opteon) 
software. For information on the operation and maintenance of NovoCyte Opteon 
Spectral flow cytometer and associated accessories, please refer to associated 
operator's guide. 
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Keyboard Shortcuts 

 

Shortcuts Command 

Overall Situation 

Ctrl + [ Switch the active sample to the previous sample  

Ctrl + ] Switch the active sample to the next sample  

Ctrl + 1 Create a dot plot  

Ctrl + 2 Create a density plot  

Ctrl + 3 Create a histogram  

Ctrl + 4 Create a contour plot  

Ctrl + 5 Create a cell cycle diagram  

Ctrl + 6 Create a cell proliferation diagram 

Ctrl + 7 Create a Spectrum Density plot 

Ctrl + 8 Create a Spectrum Dot plot 

Ctrl + N New file  

Ctrl + O Open the file  

Ctrl + S Save the file  

Ctrl + W Close the file  

F3 Next sample without template  

F4 Next sample  

F5 Run / Stop / Run single well / Stop Single Well 

F6 Run Plate / Stop 

F7 Pause / Continue 

F8 Restart 

Plot 

Alt + 1 Change to dot plot 

Alt + 2 Change the density plot  

Alt + 3 Change to histogram  

Alt + 4 Change to contour plot  

Alt + 5 Change to cell cycle diagram  



Prologue 
 
 

NovoExpress (Opteon) Software Guide 14 

Alt + 6 Change to cell proliferation diagram 

Alt + 7 Change to Spectrum Density plot 

Alt + 8 Change to Spectrum Dot plot 

Alt + Q Quick compensation  

Ctrl + + Zoom In 

Ctrl + - (Minus Key) Zoom Out 

Ctrl + A Auto Range  

Ctrl + B Bi-Range gates  

Ctrl + C Copy the plot or gate  

Ctrl + D Duplicate a plot or gate  

Ctrl + E Elliptical gate  

Ctrl + F Full Range  

Ctrl + H Range gate or Vertical Range gate  

Ctrl + J Freehand gate 

Ctrl + L Logic gates 

Ctrl + M Move 

Ctrl + P Polygonal gate  

Ctrl + Q Quadrant gate  

Ctrl + R Rectangular gate  

Ctrl + T Adjust threshold 

Ctrl + V Paste gate  

Ctrl +Y or Ctrl + Shift + Z Redo  

Ctrl + Z Undo  

Experiment Manager 

Ctrl + C Copy 

Ctrl + D Duplicate 

Ctrl + V Paste 

F2 Rename 
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Glossary 

Term Definition 

Absolute count Number of cells or particles per unit volume. Instrument is a volumetric 
instrument, thus, exact volumes of acquired sample can be determined 
without the need for counting beads. After the dilution factor and unit of 
measure (default is # of events per µL) are defined by user, 
NovoExpress (Opteon) can display number of events within specified 
gate per unit volume in the statistical information chart. 

Active sample The sample currently displayed and being analyzed. The Cytometer 
Control and Cytometer Setting panels display basic information 
regarding the active sample. In the Experiment Manager panel, the 
active sample is indicated by a red arrow. To switch the active sample, 
double-click on a new sample in the Experiment Manager panel, use 
the Switch Active Sample buttons from the Sample tab of the Menu 
Bar, or use the combination of Ctrl + [ or Ctrl + ] on the keyboard to go 
backward or forward. 

Adjust on Plot A function to adjust threshold value on plot. 

Analysis The process of plotting, gating, and comparing statistical information 
on collected parameters of samples. 

Auto Range A function which allows user to display the range for the X-axis and Y-
axis to fit the experimental data. 

Backflush Clear blockages in the sample pipeline. 

Batch Print Reports A function to print or create PDF of multiple specimen and sample 
reports. 

Bi-Range Gate Draws a gate with two ranges 

Fluorochrome Bi-Variate 
Plot 

A matrix of plots with selected unmixed fluorescent parameters plotted 
against each other. 

Blank samples Samples without collected event data. A blank sample must first be 
created before sample collection begins. Created blank samples 
contain the default settings from the previously created sample. See 
the icon for a blank sample in Hierarchy. 

Cell cycle plot Uses a histogram of DNA content to derive cell cycle phase populations 
based on curve fitting to the histogram. 

Cell proliferation plot Generates c modeling results to analyze different cell generations 
during the cell proliferation procedure. 

Cleaning Clear biological hazards that may exist in the pipeline. 



Prologue 
 
 

NovoExpress (Opteon) Software Guide 16 

Compensation Matrix A matrix used to compensate the fluorescence spillover between 
different fluorochromes. It is inversely related to the Spillover Matrix. 

Contour plot Two-parameter plot. Each axis can plot a parameter. The plot uses 
contour lines to indicate the density of populations on the plot. 

Core Diameter The diameter of hydrodynamic focusing which corresponds to the flow 
rate. 

Debubble Clear bubbles present in the sample line. 

Decontamination Decontaminate the instrument when it is known to have contamination 
or to prevent the occurrence of contamination 

Density plot Two-parameter plot. Each axis can plot a parameter. The color of a 
point on the plot will be an indicator of the number of events at that 
point. 

Distance Filter When the timing distance of two events of a sample is less than or 
equal to the set value, these two events will be filtered out, or aborted. 
The software will not display the aborted events. 

Dot plot Two-parameter plot. Each axis can plot a parameter. Multiple 
overlapping points will be displayed the same as a single point in a dot 
plot. 

Elliptical Gate Draws an elliptical gate  

Event Refers to a particle that passes the acquisition threshold and has a set 
of data on intensity collected. Events are due to particles including 
microspheres and cells. 

Experiment File The NovoExpress (Opteon) Software saved experimental data files. A 
file can store experimental data from multiple samples. 

Experiment Manager The NovoExpress (Opteon) Software uses samples, specimens, and 
groups in a hierarchy structure to organize the experimental data, 
instrument settings, analysis and other information. The organization is 
displayed in the Experiment Manager panel. 

Export to LIS A function allows a user to export data analysis results in the 
designated format to CSV file and such CSV file can be parsed by a 
Laboratory Information System (LIS) or read by other programs. 

Extensive Rinse Extensively rinse tubing 

FCS Data file standard for flow cytometry. NovoExpress (Opteon) is 
compatible with FCS 3.0 and 3.1. 

Fluidics maintenance 
sequences 

A function to program and run multiple fluidics maintenance 
sequences in pre-defined order 

Fluorescence compensation Different fluorochromes emit different emission spectrums. When 
emission spectrums overlap, this is known as spectrum overlap. When 
the overlap occurs within a detection channel, fluorescence 
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compensation can be used to mathematically compensate by 
removing the signal that does not belong in the channel. 

Freehand Gate Draws a freehand gate. 

Free Unused File Space When events of a sample or all samples are deleted, the file space is 
not automatically released. Click on this icon to free the file space. The 
file space can also be released by saving the file to the hard drive. Large 
files may take longer to release. 

Full Range Sets the full range of the X and Y-Axes.  

Gain A parameter corresponds to the output current of a photodetector for 
fluorescent signal detection. 

Gate Used to select a specific population of events. Gate types include 
rectangular, elliptical, polygonal, freehand, range, and bi-range gates. 
Gates can also be combined to create logic gates. Gates are used to 
further analyze specific populations. 

Group A part of the NovoExpress (Opteon) Software’s hierarchy structure. The 
group can contain multiple specimens. 

Heat Map Heat map can be used to visualize the data in a well plate format. It 
uses different color to display the result of a specified statistical 
parameter. 

Histogram Plot Single-parameter plot. The X-axis will plot a parameter, and the Y-axis 
will plot the number of events. 

HT Abbreviation for High Throughput. 

Instrument settings The settings include the sample, the stop condition, the sample flow 
rate, and the threshold settings. 

Layer The option to superimpose multiple plots to make a comparison. This 
tool is available with histograms and dot plots. The overlay plots then 
contain these superimposed layers. 

LIS (Laboratory Information 
System) 

Result of a statistical table and plots can be exported and parsed by LIS 

Logic gate The combination of individual gates using the logic operators AND, OR, 
or NOT to create logic gates. 

Merge Samples Merge two or more samples when they were collected from same 
instrument (i.e., same instrument serial number, and same optical 
configuration), with same data acquisition parameters selected in the 
Cytometer Setting panel, with same data acquisition mode (i.e., 
Absolute Count mode applied or not), and the total events from 
merged samples are less than 10 million.  

Overlay Display the data from multiple samples and gates in one plot with 
different colors. 



Prologue 
 
 

NovoExpress (Opteon) Software Guide 18 

Parameters Refers to fluorescent or scattering intensity measurements. 
Parameters can be differentiated by the specific light channel or 
measurement type (height or area). 

Plot Tool for displaying sample information, including fluorescent or 
scattered light intensity. In the NovoExpress (Opteon) Software, plots 
include dot plots, density plots, contour plots, histograms, cell cycle 
plot, cell proliferation plot, spectrum density plot and fluorochrome bi-
variate plot 

Polygon Gate Draws a polygon gate. 

Priming Use after the instrument has been inactive for a long period of time to 
fill the tubing with fresh sheath fluid and clear any bubbles 

Purge If Instrument needs to be shipped, click this button and follow the 
procedure shown on the popup window to purge the fluidic system 
before packaging and shipment. 

QC test In QC test, Instrument QC Particles are used to check the instrument 
performance. Measured data are used to determine if the instrument 
parameters fall within a standard range to ensure stable and reliable 
operation of the instrument. 

QC test reports QC test reports contain parameters for individual QC test results, and it 
can also plot results over a period of time in the Levey-Jennings 
reports. 

Quick compensation Use scrollbars in two-parameter plots to quickly adjust the Spillover 
Matrix after unmixing or fluorescence compensation of a sample. 

Quadrant Gate Draws a quadrant gate. 

Range Gate Draws a gate with single range. 

Reagent Lots Sets the type of the reagent in prompted window. 

Rectangular Gate Draws a rectangular gate 

Reference Control A series of single-stained and/or unstained samples which  provide the 
reference fluorescence spectra (spectral signatures) necessary to 
unmix the data by spectral flow cytometer.  

Reference Spectra Spectral signatures of a fluorochrome or an unstained sample from all 
fluorescence detection channels of all lasers. It is essential for 
conducting spectral unmixing and compensation (when Virtual Filter is 
used).  

Report Reports can be either a specimen report or a sample report. A sample 
report can contain plots, statistical information, compensation 
matrices, and collection information for the sample. A specimen report 
will contain information for all the samples included in the specimen. 
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Reset Layout Resets the layout of the panels to the default layout. 

Rinse A function to rinse fluidic system. 

Raw Workspace The workspace which allows users to view and create plots of raw 
fluorescence channel data, FSC, BSSC, VSSC, Width and Time, and is 
mainly used to analyze raw data. 

Sample The basic unit of experimental data organization. Samples contain the 
information from sample data collection, instrument settings, 
fluorescence compensation, reporting, analysis and data. 

Sample currently in 
acquisition 

Usually, sample currently in acquisition is same as active sample; 
however, they do not have to be same sample. After sample acquisition 
is started, user can switch active sample to other sample for analysis 
purpose. In Experiment Manager panel, sample currently in acquisition 
has a flash arrow (alternating green and dark green). If sample currently 
in acquisition is same as active sample, the arrow alternating red and 
green. 

Sample flow rate The flow rate of the sample can be used to control the number of 
events collected per second. 

Specimen A part of the NovoExpress (Opteon) Software’s hierarchy structure. 
Specimen can be composed of many samples; multiple samples of the 
same test items can be placed in a specimen; a clinical specimen can 
correspond to a patient. 

Spectrum Density Plot A density plot with the fluorescence channel(s) of selected lasers 
plotted in horizontal axis, and the Mean Fluorescence Intensity (MFI) 
value plotted in vertical axis. 

Spectrum Dot Plot A dot plot with the fluorescence channel(s) of selected lasers plotted in 
horizontal axis, and the Mean Fluorescence Intensity (MFI) value 
plotted in vertical axis. 

Spillover Matrix A matrix where each row contains value of spillover of a fluorochrome 
into the others. It is inversely related to the compensation matrix. 

Statistical table A customizable table of statistical information for batch data analysis. 
It can contain multiple samples, multiple gates, and statistical 
information for multiple parameters. 

Stop condition A defined number of events, length of time, or volume of collection, 
where sample collection is stopped immediately after reaching the 
condition. 

Storage Gate Filter out events outside the selected gate. 

System Log A window records information including user login and log out, and 
instrument operating activities including data acquisition, fluidics 
maintenance, etc. 



Prologue 
 
 

NovoExpress (Opteon) Software Guide 20 

Technical Support Request A function which automatically collects instrument configurations, 
NovoExpress (Opteon) system logs, current screenshot, current 
experiment file and other information that helps diagnosis and 
troubleshooting of instrument. 

Templates Set contains the group, instrument settings, specimens and samples, 
fluorescence compensation, reporting, analysis, etc., can be saved as 
*.nct file format. 

Threshold The minimum value of defined parameters where if the signal is lower 
than the defined value, the data will be discarded. By setting an 
appropriate threshold value, the target events can be effectively 
captured. A threshold value too high will discard target events, while a 
threshold too low will include a large noise from small events being 
collected. 

Transaction Log A window which displays recorded information related to changes to 
the experiment file, such as Time, Computer, Software Version, User, 
and Action. 

Unclog Clear blockages in the flow cell. 

Unmix The mathematical method used in spectral flow cytometer to 
deconvolute the abundance of individual fluorochrome  in a multi-color 
sample using the spectral signature of each individual fluorochrome as 
the reference.  

Unmixed Workspace The workspace which allows users to view and create plots of unmixed 
fluorescence data, FSC, BSSC, VSSC, Width and Time. It is mainly used 
to analyze unmixed data.   

Virtual Filter An individual optical bandpass filter or a combination of multiple 
consecutive ones to allow using compensation to analyze spectral flow 
cytometer data in the same way as conventional flow cytometers.  

Work List Displays the samples as rows in a table. Sample settings are also listed 
and can be set in the table, including specimen name, sample name, 
parameters, stop condition, sample flow rate, threshold, compensation, 
and analysis is reporting information. Allows the user to quickly create 
and manage multiple samples. 

Workspace In the main interface of the NovoExpress (Opteon) Software, the middle 
area where plots are displayed. 
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2 Installation 

This chapter describes the installation requirements, procedures to install, start 
and uninstall the NovoExpress (Opteon) software, NovoExpress (Opteon) license 
registration and dissociation, and user management feature.  

Installation Requirements 

Before installing the NovoExpress (Opteon) Software, ensure that your computer 
meets the following minimum requirements: 

Hardware 

• Processor: quad-core 2.5 GHz 
• Computer Memory: 16 GB 
• Hard Drive: 50 GB free space 
• Screen Resolution: 1366 X 768 pixels 

Software 

• Operating System: Windows 10 (x64)/Windows 11 (x64) 
• PDF Reader Software 

Install NovoExpress (Opteon) Software 

Following the instructions below to Install NovoExpress (Opteon) Software: 
 

1 Download NovoExpress (Opteon) Software installation package from  
https://www.agilent.com/chem/NovoExpress and unzip it. Double-click 
Setup.exe file in the NovoExpress (Opteon) installation directory to start the 
installation process. 

https://www.agilent.com/chem/NovoExpress
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2 The NovoExpress (Opteon) Software installation wizard will be prompted as 
shown below. Click Next to continue. 

   

3 Read the license agreement and accept all terms by selecting the checkbox 
and clicking Next. 

  

4 Choose the installation location. By default, the NovoExpress (Opteon) 
Software will be installed in C:\Program Files (x86)\NovoExpress (Opteon). 
To install the software into another location, enter the target location or click 
Browse to select a destination folder. If the selected path does not exist, the 
installation wizard will automatically create the directory. After selecting the 
destination folder, click Install to continue. 
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5 After the installation is complete, click Finish to finish the installation and start 
the software. If you would not like to immediately start the software, uncheck 
the Run NovoExpress (Opteon) box, and click Finish. 
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Start NovoExpress (Opteon) Software 

After the successful installation of the NovoExpress (Opteon) Software, the 
program can be started by the following methods: 
• Double Click NovoExpress (Opteon) Shortcut from Desktop 

  

• Click NovoExpress (Opteon) from Start Menu 
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Uninstall NovoExpress (Opteon) Software 

The NovoExpress (Opteon) Software can be uninstalled by the following methods: 
• From Control Panel 

Click Start > Windows System > Control Panel > Programs and Features 

In the prompted window, select NovoExpress (Opteon) and select 
Uninstall/Change. 

 

  

• From Start Menu 
Click Uninstall under NovoExpress (Opteon) folder 
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NovoExpress (Opteon) License 

Free Trial 

NovoExpress (Opteon) is available for a 30-day free trial. The Register 
NovoExpress window will automatically pop up every time starting the 
NovoExpress (Opteon) software during the trial expiration. Click the Evaluate 
button to start the free trial of NovoExpress (Opteon). 

 

Registration will be needed to use the software after the trial expires. User can 
enter the NovoExpress (Opteon) Software License Key which comes with 
instrument. User can also purchase it separately from Agilent. 
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NovoExpress (Opteon) Registration 

The Register NovoExpress window will automatically pop up when starting the 
NovoExpress (Opteon) software if the software is not registered yet. You can also 
click File > About > Register NovoExpress to open the Register NovoExpress  
window. There are two ways to register NovoExpress (Opteon). 
• If the computer is connected to the internet, enter a valid Agilent issued license 

key and a valid email address and click the Register button to register 
NovoExpress (Opteon). 

 

• If the computer is not connected to the internet, click the Offline Registration 
button to switch to offline registration mode. Write down the Machine Code 
displayed in the window and go to another computer that is connected to the 
internet and open the Get Registration Code web page 
(https://www.agilent.com/chem/NovoExpress). On the web page, enter the 
Machine Code into the specified textbox, type a valid Agilent issued license 
key, and then click Get Registration Code. Write down the Registration Code, 
enter it to the Register NovoExpress window, and click Register button to 
register NovoExpress (Opteon). 

https://www.agilent.com/chem/novoexpress
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NOTE A license key is required for NovoExpress (Opteon) software registration or license 
transfer. Software will automatically record the license key. However, it is still 
recommended to keep a safe record of license key assigned to each computer or 
user. 

 
 

NovoExpress (Opteon) Dissociation 

NovoExpress (Opteon) supports license transfer to another computer. Each 
license may be transferred up to 5 times. If you want to transfer the NovoExpress 
(Opteon) license to another computer, log in the software with Administrator 
account, click File > About > Dissociate NovoExpress to open the Dissociate 
NovoExpress window. 
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The license key recorded during software registration will be automatically filled in 
the text box. User can click the Dissociate button to dissociate or decouple 
NovoExpress (Opteon) from this computer. After dissociation, the license key can 
be used to register NovoExpress (Opteon) on another computer. 

 

NOTE Please connect NovoCyte workstation to the internet when dissociating the license. 
Contact Agilent technical support for how to dissociate the license if no connection 
to the internet is available. 

 
 

NOTE Only the users with the Administrator privilege can conduct this license 
dissociation process. 

 

User Management 

A user management feature is included with the NovoExpress (Opteon) Software 
allowing for separate user settings to be saved in different accounts. 

When starting the NovoExpress (Opteon) Software, a login window will appear. By 
checking the Auto Log in box, the software will automatically login with the 
associated user account and the login window will not appear in the future.  

The NovoExpress (Opteon) Software initially includes a system administrator 
account with username as “administrator”. The default password for this account 
is “administrator”. This system administrator account has the highest privilege 
and the username “administrator” cannot be changed. This system administrator 
and users with the Administrator privilege can add, delete, and modify information 
for all the other users and user groups. There is no limit to the number of user 
groups or user accounts. Each user belongs to a specific user group. The methods 
for adding, modifying and deleting a user group are described in User Groups. The 
methods for adding, modifying, and deleting a user account are described in  
Users. A user can directly enter the username and password to log in the software, 
or select the specific user group first, select the username, and enter the correct 
password to log in the software.  
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User Groups 

NovoExpress (Opteon) contains a user group management feature to allow groups 
of multiple users. Only users with Administrator privilege can add, modify, and 
delete user groups. The root parent group “Organization” is included by default. 
Users can only add group under this root group. 

Add a User Group 

New user groups can only be added through an account with Administrator 
privilege. To add a new user group: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear.  
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4 Click Add Group. The Add User Group window will appear. 

 

5 Enter the group name and select the desired parent group for the created user 
group in the prompted window.  

6 Click Add and the new user group is created. 
 
 

Modify a User Group 

User groups can only be modified through an account with Administrator privilege. 
To modify a user group: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear.  
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4 Select the group to be modified. Click Modify. The Modify Group window will 
appear. 

 

5 Modify the group name and select the desired parent group for the modified 
user group in the prompted window. 

6 Click Modify and the user group is modified. 
 
 

Delete a User Group 

User groups can only be deleted through an account with Administrator privilege. 
To delete a user group: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
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3 Click User > Management. The User Management window will appear. Select 
the group to be deleted. Click Delete. 

 

4 Click Yes in the prompted window and the selected user group is deleted. 

 
 
 

NOTE When the selected user group is deleted, the user accounts in the group will 
automatically be moved to the deleted group’s parent group. 

 
 

NOTE The root parent group Organization cannot be deleted. 
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Display the Users in a User Group 

The right half of the User Management window displays the users contained in the 
user groups with checkbox checked in the left half of the window. All displayed 
usernames are automatically listed in the alphabetical order. 

   

Users 

NovoExpress (Opteon) contains a user management feature to allow different 
settings and privileges for each user account. Only users with the Administrator 
privilege can add, modify, delete and unlock user accounts.  

Add a New User 

New users can only be added through an account with Administrator privilege. To 
add a new user: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear.  
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4 Select a user group. Click Add User. The Add User window will appear. 

 

5 Enter username and password and assign user privilege (User or 
Administrator) for the created account in the prompted window.  

6 Click Add and the new user account is created. 
 
 

Modify User Information 

Accounts with Administrator privilege can modify username, user privilege, access 
privilege, and reset password for each user, while other accounts can only modify 
its own username, user group name, and password. 
• From the administrator account or an account with Administrator privilege: 

a After logging in, select the Setting tab. 
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b Click User > Management. The User Management window will appear. 
Select the user group, and then the user account you would like to modify. 

 

c Click Modify. The Modify window below will appear allowing the user to 
make changes to the account. 

 

• From individual user accounts: 
a After logging in, select the Setting tab. 
b Click User > Modify. The Modify window shown below will appear, 

allowing the user to make changes to the logged in account. Please note 
User Privilege and Access Privilege can only be modified by accounts 
with Administrator privilege. 
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Access Privilege 

Several functions in NovoExpress (Opteon) are only accessible to accounts with 
specified Access Privileges, including: 
• Photodetector Gain Adjustment 
• View Transaction Log 
• View System Log 
• Decontaminate Instrument 
• Delete Sample Events 
• Adjust Distance Filter Setting 
• Calibrate Fluidics Station/Cart 
• Purge Instrument 
• Power Down/Up NovoSampler 
• Merge Samples 
• Configure Lasers 
• Adjust Laser Power Setting 

To modify the Access Privilege for users, click the  button in the Modify 
window and then select or unselect checkboxes in the popup Access Privilege 
window. Click OK to confirm changes. 
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Delete a User 

User accounts can only be deleted through an account with Administrator 
privilege. To delete a user account: 
1 Login to the software as the administrator or an account with Administrator 

privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear. 

 

4 Select the user account that you would like to delete. 
5 Click Delete. 
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6 In the confirmation window, click Yes. 
 

Unlock a User 

If a user account is locked (refer to Settings in this guide for more details), it can 
only be unlocked through an account with Administrator privilege. To unlock a 
user account: 
1 Login to the software as the administrator or an account with Administrator 

privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear. When 

a user account is locked, a suffix of [Locked] is displayed after the name of the 
user account as shown below. 

 

4 Select the user account that you would like to unlock. 
5 Click Modify from User Management window, uncheck Account is locked out 

and click Modify in the prompted window. 
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6 In the confirmation window, click Yes. 
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3 Use NovoExpress (Opteon) Software 

This chapter provides information needed to use NovoExpress (Opteon) software, 
including overview of NovoExpress (Opteon) software interface, Title Block, Menu, 
Workspace Toolbar, Cytometer Setting panel, Fluorochrome Setting panel, 
Cytometer Control panel, Plate Manager panel, Experiment Manager panel, 
Cytometer Status panel, Gate Manager panel, Status Bar, Instrument 
Configuration window, Manage Plate Types window, New Reference Control 
Specimen window, Reference Spectra window, Option Setting window, 
Fluorochrome Library window. 

NovoExpress (Opteon) Software Interface 

After starting the NovoExpress (Opteon) Software, the initial interface (i.e., main 
window) may look different depending on whether NovoSampler S is connected. 
• If NovoSampler S is not connected, user will see following interface which 

includes a Title Block, Menu, Cytometer Setting panel, Toolbar, Experiment 
Manager panel, Cytometer Control panel, Workspace, and Status Bar. 
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• If NovoSampler S is connected, user will see following interface. Compared to 
the software interface with instrument alone, differences are observed in the 
Menu Bar, Cytometer Control panel, Experiment Manager panel, and Work 
List. The Plate Manager panel is only visible when NovoSampler S is installed. 

 

Title Block 

The Title Block displays the data file name in the center. It also provides options 
for opening, saving, and closing an experiment file. 

 

Please refer to table below for description of each icon located in Title Block. 
 

Icon Description 

 

Clicking this icon prompts a drop-down menu with options to 
resize (e.g., Restore, Minimize) the display window and close the 
software. 
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Saves the experiment file. 

 

Creates a new experiment file. 

 

Opens an experiment file. 

 
Undo drawing gates, deleting gates, zooming in or zooming out on 
a plot, etc. This operation is only effective for plot related 
functions.  

 
Redo drawing gates, delete gates, zooming in or zooming out on a 
plot, etc. This operation is only effective for plot related functions. 

 
Displays the data file name (*.ncf). 

  
Minimizes window. 

  
Maximizes window. 

 
Restores window. 

 
Closes window. 

Menu 

The Menu contains functions for instrument control and data analysis which 
includes File, Home, Instrument, Sample, Plot, Gate, Unmix, View and Setting 
tabs.  
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File 

 

Please refer to table below for description of each icon located in File tab. 
 
 

Icon Description 

 

New: Click to create experiment file. 

  
• New Blank Experiment: Creates a new experiment file. 
• New from Template: Imports a template (*.nct) for the new experiment. 
• New from Experiment File: Creates a new experiment file with the experiment 

setting and data analysis method inherited from an existing experiment file. The 
Absolute Counting and Sample Recovery setting (i.e., enabled or disabled) from 
the existing experiment file will be automatically applied to the newly created 



Use NovoExpress (Opteon) Software 
 
 

NovoExpress (Opteon) Software Guide 45 

sample. Both the User-Defined Keywords, and the keywords listed in Edit 
Keywords window in the existing experiment file will also be automatically 
included in the newly created sample. Please refer to Sample Keywords in this 
guide for more information. 

 

Open: Click to open experiment (*.ncf) file. 

 
• Open Experiment File: Opens an experiment file. 
• Import FCS files: Imports selected FCS file(s) to the current specimen. 
• Import FCS Files from Folder: Imports all FCS files in a selected folder to the 

current FCS specimen. 

 

Close: Click to close the current experiment file and creates a new experiment file. 

 

Save: Click to save the experiment data, experiment setup, and data analysis of the 
current experiment file. 

 

Save As: Click to save the current experiment file to a specified location. 

 

Print: Click to print sample report/batch print reports 
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• Print Report for Active Sample: Prints the report for the current sample. 
• Batch Print Reports: Opens the Batch Print Reports window. Refer to Batch Print 

Reports in this guide for more details. 

 

 

About: Click to view the software information (e.g., version, copyright), check for any 
available software updates, register or dissociate NovoExpress license, and view the 
help document (i.e., software guide) information. 
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• About NovoExpress (Opteon): Displays the software version and copyright 

information. 
• Check for Updates: When NovoCyte workstation is properly connected to 

internet, clicking this function will automatically check for software updates. 
• Register NovoExpress: When clicked, following window will appear to allow user 

to register the NovoExpress (Opteon) software. This function will be available only 
when NovoExpress (Opteon) License is not registered. Refer to NovoExpress 
(Opteon) Registration in this guide for more details.  

 
 

• Dissociate NovoExpress: This function will be available only when the software is 
currently registered. When clicked, following window will appear to allow user to 
dissociate or decouple NovoExpress (Opteon) from this computer. Refer to 
NovoExpress (Opteon) Dissociation in this guide for more details. 
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• Help Document: Opens the help file (i.e., NovoExpress (Opteon) Software Guide). 

 

Options: Click to open the Options window. Refer to Option Settings in this guide for 
details. 

  

 
Recent Documents: Shows recently opened data files. Up to 10 files can be 
displayed. Click the file name to directly open the corresponding file. 

 
Logout: Exits and logs out of the current account. The login window will appear. User 
needs to enter the correct username and password again and click Log In to log back 
into the software. 
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Lock out: Lock out from the current session. When clicked, following window will be 
prompted. User needs to enter the correct password again and click Log In to 
continue operation of the software.  
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Home 

 

Please refer to table below for description of each icon located in Home tab. 
 

Icon Description 

Clipboard 

 

Copy: Copies the selected gate or selected data. 

 

Paste: Pastes the copied gate to other plots or pastes the copied item in the Experiment 
Manager. 

 
Duplicate: Creates a duplicate of the plot (the gates will not be included.) or creates a 
duplicate sample or specimen. 

Editing 

 
Undo: Undo drawing gates, deleting gates, zooming in or zooming out on a plot, etc. This 
operation is only effective for plot-related functions.  

 
Redo: Redo drawing gates, delete gates, zooming in or zooming out on a plot, etc. This 
operation is only effective for plot-related functions. 

 
Select All: Selects all the gates in the current plot. 

 
Delete: Deletes the selected gate. 

Experiment 

 

Work List: Users may view and edit the Work List. Refer to Work List in this guide for more 
details.  

 

 

Plate View: Click to open Plate View window. This function is only available when 
NovoSampler S is used. This window is read only and is used to view the sample 
information for each well on a plate view. The Plate drop-down menu lists the Plate ID for 
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all the created plates. Select a Plate ID from the drop-down menu and view the sample 
information for this plate. Check the Show Specimen Name checkbox to enable the 
specimen’s name associated with each well to be shown. Check the Display sample has 
data checkbox to also show samples which have collected data. 

 
 

 

Statistical Table: Creates a statistical analysis table. Please refer to Statistical Tables in 
this guide for more details. 

 

 

Heat Map: Creates a heat map for the defined parameter in a plate layout format. Please 
refer to Heat Map in this guide for more details. 
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Tools 

 

Batch Print Reports: Click to print or create PDF of multiple test reports. Please refer to 
Batch Print Reports in this guide for more details. 
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Free Unused File Space: When events of a sample or all samples are deleted, the file 
space is not automatically released. Click on this icon to free the file space. The file space 
can also be released by saving the file to the hard drive. Large files may take longer to 
release. 

 

Export to LIS: Allows user to export data analysis results in the designated format to CSV 
file and such CSV file can be parsed by a Laboratory Information System (LIS) or read by 
other programs. When clicked, following window will be prompted. 

 
• Statistical table template: Sets the proper statistical table template to export the data. 

To add a statistical table template, export the statistical table as a template to the 
default folder “User data root folder\Statistical Table Templates”. Refer to Statistical 
Table Management for details. 
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• Export plots in Specimen/Sample report as image: Once selected, plots in the 
specimen report or sample report will be exported as images in the selected image file 
format to the designated folder. 

• Image file format: Sets the image file format of the export plots, including PNG, JPEG, 
Bitmap, GIF and TIFF format. 

• Export: Exports the data and the plots into designated folders. The data will be 
exported into *.csv file in UTF-8 code. * is the same as the experiment name. The 
created csv file will be automatically saved in “User data root folder\LIS Results” 
folder, and plots will be saved in “User data root folder\LIS Plots” folder. The default 
user data root folder is “D:\NovoExpress (Opteon) Data\administrator” and can be 
changed. Refer to Setting for details of changing the default user data root folder. 

 

Transaction Log: Displays the Transaction Log window. Records can be filtered by Time, 
Computer, User, and Action. Only accounts with the View Transaction Log privilege can 
access the Transaction Log.  

 

 

System Log: Displays the System Log window. Only accounts which have the View 
System Log privilege can access the System Log. The System Log window records 
information including user login and log out, and instrument operating activities including 
data acquisition, fluidics maintenance, etc. 
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Technical Support Request: Technical Support Request Creation Wizard automatically 
collects instrument configurations, NovoExpress (Opteon) system logs, current 
screenshot, current experiment file and other information that helps diagnosis and 
troubleshooting of instrument. You can also attach any other files using this function. 
Refer to Technical Support Request in this guide for details. 

  

Instrument 

This panel allows user to view the instrument configuration, conduct instrument 
operation and maintenance. The availability of these functions depends on the 
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model of instrument connected to the workstation. When NovoSampler S is 
connected, additional functions are available.  

 
When NovoCyte Opteon spectral flow cytometer is connected 

 
When NovoCyte Opteon spectral flow cytometer and NovoSampler S are connected  

Please refer to table below for description of each icon located in Instrument tab. 
 

Icon Description 

Instrument 

 

Information: Click to display the instrument information including Product Model, AD 
boards, Laser board, NovoSampler S (if connected) and fluidics station S (or cart) 
information. This function is only available when the instrument is connected and 
powered on. 
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Configuration: Displays instrument model, optical configuration and detection channel 
and options for the NovoSampler S. Refer to Instrument Configuration in this guide for 
details. 

 

QC Test Report: Displays results from QC tests. The results can be viewed individually 
or plotted over a time interval in a Levey-Jennings chart. Please refer to QC Test in this 
guide for details. 

 

Operation 

NOTE All the functions or actions listed in this tab are only available when the instrument or 
associated accessories is properly connected and powered on. 

 

 

Shut Down: Starts the shutdown process. After completion, the instrument will 
automatically turn off. To clean sample injection probe while shutting down instrument, 
refer to NovoCyte Opteon Spectral Flow Cytometer Operator’s Guide for more 
information. 

 

QC Test: Runs the instrument QC test. 

 

Calibrate Fluidics Station (or Fluidics Cart): Long distance transportation, movement 
and other reasons may cause the fluidics station S (or Fluidics Cart) system 
malfunction. Use this function to re-calibrate the fluidics station S (or Fluidics Cart). 
After clicking the button, it will ask to remove the instrument reagent containers from 
the fluidics station S (or Fluidics Cart) before calibration. Only accounts with the 
Calibrate Fluidics Station (or Fluidics Cart) privilege can calibrate the fluidics station S 
(or Fluidics Cart). 

 

Replace Fluidic System Consumables: Click to open the Replace Fluidic System 
Consumables window and follow the instructions to replace fluidic system 
consumables. Refer to NovoCyte Opteon Spectral Flow Cytometer Operator’s Guide for 
more information. 
 

NOTE The software monitors the accumulated running time of the fluidic system 
consumables to ensure the consumables are changed in a timely manner 
for optimal flow cytometry results. When the accumulated running time is 
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reached, NovoExpress (Opteon) software will prompt a message to remind 
the users to replace the consumables. 

 

  

Schedule Power On & Off: Click to open the Schedule Power On & Off window. User 
can schedule the instrument to be powered on or off at user defined time with user 
defined frequency.  

 
• Start Date: Select the start date of the instrument power on and off. The start date 

cannot be set to 7 days or more over the current date. 
• End Date: Select the end date of the instrument power on and off. 
• Start Time: Select the start time of instrument power on or off. 
• Recur On: Select the recurring frequency of instrument power on or off. 
• Add: Click to add the selected start time and recurring frequency to the schedule 

table. 
• Remove: Click to remove the selected schedule from the schedule table. 
• Set: Click to confirm and make the schedule effective.  
• Clear: Click to clear the schedule. 

After the scheduled power on and off was executed, and the software is launched with 
the instrument properly connected, following Power On & Off Timing Log window will 
pop up. User can view the Date, Status and Remark of the executed power on and off 
function in this window. 
• End Date: Select the end date of the instrument power on and off. 
• Start Time: Select the start time of instrument power on or off. 
• Recur On: Select the recurring frequency of instrument power on or off. 
• Add: Click to add the selected start time and recurring frequency to the schedule 

table. 
• Remove: Click to remove the selected schedule from the schedule table. 
• Set: Click to confirm and make the schedule effective.  
• Clear: Click to clear the schedule. 

After the scheduled power on and off was executed, and the software is launched with 
the instrument properly connected, following Power On & Off Timing Log window will 
pop up. User can view the date, status and remark of the executed power on and off 
function in this window. 
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Fluidics Maintenance 

NOTE All the functions or actions listed in this tab are only available when the instrument is 
properly connected and powered on. 

 

 

Debubble: Removes the air bubbles from the fluidic system.  

 

Cleaning: Uses a cleaning solution to decontaminate the biohazards that may exist in 
the fluidic system.  

 

Rinse: Rinses the fluidic system using a rinsing solution.  

 

Priming: After the instrument has not been in use for certain period of time, this 
function clears the air bubbles and primes the fluidic system with fresh sheath fluid.  

 

Unclog: Clears blockage from the flow cell.  

 

Fluidics Maintenance Sequences: program and run multiple fluidics maintenance 
sequences in pre-defined order. 
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• Fluidics Maintenance Type: Select fluidics maintenance type (i.e., Debubble, 

Cleaning, Rinse, Priming, Unclog) 
• Iterations: Set the number of iterations for the selected fluidics maintenance 

sequence. 
• Add: Click to add the selected fluidics maintenance sequence to the table. 
• Remove: Click to remove the selected fluidics maintenance sequence from the 

table. 
• Total Iterations: The total number of iterations. 
• Finished Iterations: The number of completed iterations. 
• Shut down instrument after finishing the selected fluidics maintenance 

sequences: Check to shut down the instrument after finishing the selected fluidics 
maintenance sequences. 

• Start: Click to start the fluidics maintenance sequences in the pre-defined order (top 
to bottom). 

• Stop: Click to stop the fluidics maintenance sequences. The fluidics maintenance 
sequence currently running will continue until completed, but the remaining 
scheduled fluidics maintenance sequences will be aborted. 

• Continue: Click to continue the remaining fluidics maintenance sequences which 
was not completed. 

 

Purge: If Instrument needs to be shipped, click this button and follow the procedure 
shown on the popup window to purge the fluidic system before packaging and 
shipment. Only accounts with the Purge Instrument privilege enabled can perform the 
purge operation. Refer to Purge Fluidic System before Shipment in NovoCyte Opteon 
Spectral Flow Cytometer Operator’s Guide for detailed procedure. 
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Decontamination: If Instrument is known to have contamination or to prevent the 
occurrence of contamination, click this button and follow the instruction shown in the 
popup window to decontaminate the instrument. Only accounts with the 
Decontaminate Instrument privilege can perform this decontamination operation. 
Refer to Decontamination in NovoCyte Opteon Spectral Flow Cytometer Operator’s 
Guide for detailed procedure. 

NovoSampler S 

NOTE The functions or actions listed in this tab (except Manage Plate Types) are only 
available when the NovoSampler S is properly connected. 

 

 

Mix: Click to mix the sample. The Mix button from the Cytometer Control panel has the 
same function. 

 

Reset: Click to move the sample tray to the home position. This will allow a reset of the 
NovoSampler S in case of misalignment or error 

 

Calibrate: Click to calibrate the NovoSampler S with the instrument. 

 

Power Down/Up: When clicked, NovoSampler S will be powered on (if currently 
powered off) and allow the operation of the NovoSampler S. After execution, the status 
indication LED on NovoSampler S will light up in green color. NovoExpress (Opteon) will 
prompt a message to restart the software. After the software restarts, a dialog box 
requesting to calibrate the NovoSampler S will be shown. Click Calibrate to start the 
automatic calibration procedure. The software features for control and use of the 
NovoSampler S will be available after restart of the NovoExpress (Opteon) Software. If 
the NovoSampler S is already powered on, clicking this button will power off the 
NovoSampler S, and the status indication LED on NovoSampler S will turn off. 
NovoExpress (Opteon) will prompt a message to restart the software. After the 
software restart, only the instrument stand-alone features will be available. This feature 
is only visible when logged into NovoExpress (Opteon) Software with the account with 
Power Down/Up NovoSampler privilege. 

 

Manage Plate Types: Click to add, remove, and modify plate settings in prompted 
window. Refer to Manage Plate Types in this guide for more details. 
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Sample 

  

Please refer to table below for description of each icon located in Sample tab. 
 

Icon Description 

Import and Export 

 

Import FCS File: Import data from FCS format files. 

 

Export FCS File: Exports the current data into a FCS file. 

 

Export CSV File: Exports the current data into a CSV file. 
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Export Plots: Exports the plots of the active sample into files in PNG, JPEG, Bitmap, GIF, 
TIFF into designated path. Check Only export plots in sample report to export plots in the 
sample report only. 

 

Switch Active Sample 

 

Previous: Switches the Active Sample to the previous sample. 

 

Next: Switches the Active Sample to the next sample. 

 

Select: Switches to an Active Sample from the prompted drop-down menu. 

 

Others 

 

Delete Events: Deletes events from a sample. Users may select events inside a gate, 
outside a gate, or all events to delete. If the threshold or the photodetector gain has been 
adjusted during data acquisition, the Prior to last threshold or photodetector gain 
change radio button will be available to allow event deletion before the last adjustment. 
Only accounts with the Delete Sample Events privilege can perform this operation. 
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NOTE  After deleting the events from a sample, the file size does not 
automatically decrease. When saving the file, the software will prompt a 
window, asking if the unused file space is to be released or not. To 
manually release the unused space, refer to Home in this guide for details. 

 

 

Absolute Count Setting: Sets up absolute counting conditions for active sample. 

 
• Dilution Factor:  

The Dilution Factor is conversion coefficient used to calculate the absolute 
counting results for the original sample. For instance, if the original sample is 
diluted 10 times and is run on the instrument, enter 1:10 in the Dilution Factor. 
NovoExpress (Opteon) software will show the absolute counting results for the 
original sample by multiplying the concentration of the sample run on instrument 
by 10.  

• Absolute Count Unit:  
The Absolute Count Unit is parameter to set the unit for the absolute counting. 
User can select one of the units (i.e., No./µL, No./mL, or No./L) to present absolute 
count result for number of interested particles per microliter, per milliliter, or per 
liter.  

• Set as Default:  
Set the Absolute Count setting (i.e., Dilution Factor and Absolute Count Unit) as 
default for new samples. 
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NOTE  Changing the settings in File > Options >Absolute Count tab also sets the 
settings as default. 

 

• Show Absolute Count in Statistics:  
Show Absolute Count column in the statistical table of the plots in the workspace. 

 

NOTE  There are three states of the checkbox: 
•  : Show Absolute Count column for all plots of the sample. 
•  : No change. 
•  : Hide Absolute Count column for all plots of the sample. 

 

• Apply to All Samples in the Experiment File:  
Set Absolute Count Setting for all samples in the experiment file. 

• Apply to All Samples in the Same Specimen:  
Set Absolute Count Setting for all samples belonging to the same specimen as the 
active sample. 

 

Further information on absolute count calculations is described in Calculation of 
Statistics in this guide. 

 

Distance Filter Setting: Sets up distance filter values for active sample. This window can 
be edited only when Adjust Distance Filter Setting is checked in Access Privilege 
window. 

 
• Distance Filter:  

Allows user to set the distance filter value in the range of 0-12 µs. This option is 
automatically disabled once the data collection for selected active sample is 
started.  

• Set as Default:  
When checked, the distance filter value user set in Distance Filter area above will 
be set as default for any newly created samples. The software will at the same 
time apply this value to Default Distance Filter Setting for New Samples in 
Options > Other tab.  

• Apply to All Uncollected Samples in the Experiment File:  
Check to apply the distance filter value user set in Distance Filter area above to all 
uncollected samples in the current experiment file. 

• Apply to All Uncollected Samples in the Same Specimen:  
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Check to apply the distance filter value user set in Distance Filter area above to all 
uncollected samples in the same specimen. 

 

Laser Power Setting: Sets up laser power values for active sample. When clicked, 
following window will be prompted. User can set the laser power for selected sample by 
either directly entering the power percentage (i.e., 20%-100%) or selecting one from drop 
down menu of associated laser. This window can be edited only when Adjust Laser 
Power Setting is checked in Access Privilege window. 

  

NOTE  Under following situations, user cannot edit this window. 
• Adjust Laser Power Setting privilege is not enabled in the Access 

Privilege window.  
• Data collection for the selected sample is already completed 
• For reference control specimen, as long as one of the control samples is 

collected, the laser power setting of all other control samples cannot be 
edited. 

Apply Changes to All Lasers: When checked, any changes to the power setting of a laser 
will be automatically applied to the other remaining lasers. 
Set as Default: Check to set the current setting as the default setting for all newly created 
samples. 
Apply to All Uncollected Samples in the Experiment File: When checked, the software 
will apply the laser power setting defined in this window to all uncollected samples within 
the same experiment file.  
Apply to All Uncollected Samples in the Same Specimen: When checked, the software 
will apply the laser power setting defined in this window to all uncollected samples within 
the same specimen. 

NOTE      When all reference control samples are not collected, and user selects 
any of the reference control samples, the Apply to All Uncollected 
Samples in the Same Specimen option will be automatically checked by 
default (i.e., any changes to the laser power setting in this window will 
be automatically applied to other reference control samples). User 
cannot edit this option. 
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NOTE      When the reference spectra exist for a selected experiment sample, and 
user changes the laser power setting in this window, the following 
window will be prompted after user clicks OK or Apply. 

 
If user clicks Yes, the new laser power setting will be applied to selected 
sample, and the associated existing reference spectra will be deleted. 

Plot 

 

Please refer to table below for description of each icon located in Plot tab. 
 

Icon Description 

Properties 

 

Plot Type: Changes the plot type for the selected plot. 

 

Overlays: Click to open the Edit Overlays window. User 
can edit overlays in this prompted window. Overlay is 
only available for dot plots and histograms. Please refer 
to Overlays in this guide for more details. 
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. 

 
Gating: The gate and its events are selected as the 
current data source for plotting. 

 
Apply to All Plots: Apply the selected gate to all plots. 

 
Show Title on Plot: Toggle on and off the display of a 
title on plots. This is set for all data analysis plots in the 
Workspace. 

 
Plot Name: Sets the name of a plot. 

X -Axis, Y –Axis 

 

 

Allows user to set plot properties for the X and Y-axes 
including the plotted parameter, scale, and the display 
range. 
User can set the minimum and maximum displayed 
values in Min and Max box for the parameter selected 
from Parameter drop-down list or click Auto Range   
to automatically sets the range of the X and Y-Axes 
according to the range of the dataset or click Full Range 

 to set the full range of the X and Y-Axes. The default 
range is 224=16,777,216. User can also set designated 
plot scale (i.e., Linear, Log or Biexponential) from the 
drop-down list of Scale. 

Format 

 

Format: Controls format settings for the plots. Available 
settings depend on the type of the selected plots. 
• Smooth: Smooths the data in histogram and density 

plots. 
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• Pseudocolor: Density plots are displayed in pseudo-
color to visualize event density. 

• Events Displayed: Click to set the number of events 
to be displayed in the dot plot, density plot or contour 
plot. When clicked, following window will be 
prompted. Please refer to Plot Formatting in this 
guide for more details. 

 
• Show Fitting Result: Displays the results for the cell 

cycle analysis. 
• Filling: Sets the histogram fill mode: None, Filled, or 

Tinted. 
• Contour Level: Sets the contour levels in contour 

plots. The three levels are: 10%, 5%, and 2%. 
• Show Outlier: Show outlier events as dots on 

contour plot. 

Output 

 

Save As Image: The plot can be exported in JPEG, BMP, 
PNG, GIF, TIFF, and EMF formats. EMF format is a 
vector format which, when exporting, uses 600dpi 
resolution TIFF format. 

 

Copy: Selects from the drop-down menu to copy to the 
clipboard. The plots can then be pasted into Microsoft 
Word, PowerPoint, Excel, and other documents.  
Pull-down options include:  
• Copy Plot (Bitmap): Copies the selected plot as a 

Bitmap. 
• Copy Plot with Statistics (Bitmap): Copies the 

selected plot and associated statistical information 
as a Bitmap.  

• Copy Vector Graphics (EMF): Copies the selected 
plot as an EMF. 

• Copy Statistics (Text): Copies the statistics for the 
selected plot in text format. 
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Gate 

 

Please refer to table below for description of each icon located in Gate tab. 
Icon Description 

Current Selection 

 

Provides a drop-down menu of all available gates. A gate can be 
selected from this list. The Edit button is available only when a 
logic gate is selected. Click the Edit button to open the Edit 
Logic Gate window for modifying the setting of a logic gate. 
Please refer to Gates in this guide for more details. 

 

Format 

 

Formats the selected gate.  
Gate Name: Sets the name for the selected gate. 
Color: Sets the color for the selected gate. 
Show Percentile: Shows the percentage of the gated events 
relative to the total number of events on the plot. 
If the Show population percentile in gate label in Setting > 
Analysis is not checked, the Show Percentile option here will be 
disabled. 
Show Name: Shows the gate name in gate label on plot. 
If the Show gate name in gate label option in Setting > Analysis 
is not checked, the Show Name option here will be disabled. 

Apply Gate 
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Gating: Applies the current gate to the selected plot. 

 

Create Plot: Creates a new plot and applies the current gate to 
the new plot.  

 

Export Events: Click to export data for the events inside the 
current gate in either FCS or CVS format. When clicked, 
following window will be prompted. Please refer to Export Gate 
Events in this guide for more details. 

 

Unmix 

  

Please refer to table below for description of each icon located in Unmix tab. 
Icon Description 

New 

  

New Reference Control Specimen: Click to open the New Reference Control 
Specimen window. User can create and define the Reference Control specimen and 
samples in this window. Please refer to New Reference Control Specimen in this 
guide for more details. 
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Active Sample 

 

Reference Spectra: Click to view the Reference Spectra information for active sample 
in the prompted window. Depending on whether Spectral Unmix or Compensation is 
selected to analyze the data, this window may display different information. This 
function is not available if no active sample is selected. Please refer to Reference 
Spectra in this guide for more details. 

 
When Spectral Unmix is selected 
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When Compensation is selected 

 

Quick Compensation: Click to display the Compensation scrollbars on the active plot 
and enable quick compensation. Refer to Quick Compensation in this guide for more 
details. 

Active Reference Control Specimen: Following functions are available only when active sample is 
selected to be Reference Control sample.  

 

Setup: Click to open the Reference Control Specimen Setup window. User can also 
access this window by double clicking the Reference Control Specimen node from 
Experiment Manager panel. User can modify the Reference Control specimen 
settings defined previously. Refer to New Reference Control Specimen in this guide 
for details of each function. 
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Reference Spectra: Click to open and view the Reference Spectra for Reference 
Control specimen in prompted window. User can also access this window by double 
clicking the Reference Spectra under Reference Control Specimen node from 
Experiment Manager panel. Depending on whether Spectral Unmix or Compensation 
is selected to analyze the data, this window may display different information. Refer 
to Reference Spectra in this guide for details of each function. 
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When Spectral Unmix is selected 

 
When Compensation is selected 

 

Auto Update Mode: Allows user to enable or disable the Reference Spectra auto 
update mode. By default, this function is disabled. User can click this icon once to 
enable the auto update mode (icon will be highlighted) and click it again to disable the 
auto update mode (icon will not be highlighted). When auto update mode is enabled, 
and there are any changes to the spectra (e.g., changes to the negative or positive 
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population gating of single-stained control sample), the software will automatically 
update the Reference Spectra and re-do the Spectral Unmixing (or Compensation). 
User can also enable this mode by checking Auto update Reference Spectra and 
conduct unmixing when population changed option from New Reference Control 
Specimen window (Refer to New Reference Control Specimen in this guide for 
details).  

 

 

Update Reference Spectra and Conduct Unmixing: Click to select Update Reference 
Spectra and Conduct Unmixing to manually update the Reference Spectra for active 
Reference Control specimen, and start the unmixing immediately, or select Update 
Reference Spectra to only update the Reference Spectra for active Reference Control 
specimen but no unmixing afterward. User can also access these two functions by 
right clicking the Reference Spectra under Reference Control Specimen node from 
Experiment Manager panel. This function is available only when Auto Update mode 
is disabled, and there are changes made to the Reference Spectra Specimen. 

 

View 

  

Please refer to table below for description of each icon located in View tab. 
Icon Description 

Show 

  
Shows or hides the corresponding panel. Plate 
Manager is available only when NovoSampler S is 
connected. 

 

Reset Layout: Resets the layout of the panels to the 
default layout. 
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Zoom 

 

Zoom to: Selects the scaling of the size of the plots 
inside the workspace in the drop-down menu (50%-
200%). 
This function is equivalent to adjusting the sliding bar 
at the bottom-right corner of the software. 

 

100%: Restores the size of the plots inside the 
workspace to the default setting. 
This function is equivalent to adjusting the sliding bar 
at the bottom-right corner of the software to 100% 
value. 

 
Zoom out: Decreases the size of the plots inside the 
workspace. 
This function is equivalent to adjusting the sliding bar 
at the bottom-right corner of the software. One click 
corresponds to 1% increment. 

 
Zoom in: Increases the size of the plots inside the 
workspace. One click corresponds to 1% increment. 

Setting 

   

Please refer to table below for description of each icon located in Setting tab. 
 

Icon Description 

User 

 

Management: Use this function to manage all user groups and user accounts which includes 
adding, deleting, and modifying user groups and user accounts. This function is only 
available for accounts with the Administrator privilege. 

 

Modify: Use this function to change the username and password of the currently logged in 
account. 

Options 

 

Option Settings: Click to define General, Experiment, Analysis, Absolute Count, Statistical 
Table, Report, and Security related settings in prompted window and sub-windows. Refer to 
Option Settings in this guide for details. 

Experiment 
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Reagent Lots: Allows user to define reagent lot related settings. 

 
• Reagent Type: Sets the type of the reagent. 
• Lot ID: Sets the ID of the active lot.  
• Import: Import the lot file download from https://www.agilent.com/en/support/qc-

particles-lot-file.The Lot ID will be listed after importing the lot file. 
• Expiration Date: Sets the expired date of the active lot.  
• Lot File: Display the lot file associated to the selected Lot ID. 

Library 

 

Fluorochromes: Allows user to view and edit fluorochromes stored in the library. Refer to 
Fluorochrome Library in this guide for details. 

 

https://www.agilent.com/en/support/qc-particles-lot-file
https://www.agilent.com/en/support/qc-particles-lot-file


Use NovoExpress (Opteon) Software 
 
 

NovoExpress (Opteon) Software Guide 79 

 

Reference Spectra: Allows user to view and edit Reference Spectra stored in the library. 
Refer to Reference Spectra Library in this guide for details. 

 

Workspace Toolbar 

  

Please refer to table below for description of each icon located in Workspace 
Toolbar. 

 

Icon Description 

 
Raw Workspace: Click to switch to Raw Workspace. In this workspace, user can 
view and create plots of raw fluorescence channel data, FSC, BSSC, VSSC, Width 
and Time. It is mainly used to analyze raw data (i.e., not the unmixed or 
compensated data). Any plot (except Spectrum Density plot) created in Raw 
Workspace will be automatically created (i.e., synchronized) in Unmixed 
Workspace. User cannot create Cell Cycle plot, Cell Proliferation plot and 
Fluorochrome Bi-variate plot in Raw Workspace. 

 
Unmixed Workspace: Click to switch to Unmixed Workspace. In this workspace, 
user can view and create plots of unmixed (or compensated) fluorescence 
channel data, FSC, BSSC, VSSC, Width and Time. It is mainly used to analyze 
unmixed or compensated data (i.e., not the raw data). Any plot (except Cell Cycle 
plot, Cell Proliferation plot) created in Unmixed Workspace will be automatically 
created (i.e., synchronized) in Raw Workspace. User cannot create Spectrum 
Density plot when working in this workspace 
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Dot Plot: Creates a dot plot. 

 

Density Plot: Creates a density plot. 

 

Histogram: Creates a histogram. 

 

Contour Plot: Creates a contour plot. 

 

Gate Pointer: Use to select charts, gates, and statistical data. 

 

Rectangular Gate: Draws a rectangular gate. To use, select the tool, click and 
drag inside a plot to draw a rectangle gate. 

 

Elliptical Gate: Draws an elliptical gate. To use, select the tool, click and drag 
inside a plot to draw an elliptical gate. 

 

Polygon Gate: Draws a polygon gate. To use, select the tool, click inside a plot to 
begin creating the polygon. Click at additional locations inside the plot to add 
vertices to the polygon. To close the gate, either click on the first point of the 
polygon or double click on the last point. 

 
Freehand Gate: Draws a freehand gate. To use, select the tool, click inside start 
point in a plot to begin creating the freehand gate. Move mouse cursor inside the 
plot to draw the gate. Double click the end point to close the gate. 

 

Quadrant Gate: Draws a quadrant gate. To use, select the tool, and click inside 
the plot to divide it into quadrants. 

 

Logic Gate: Creates logical gates. Click the icon to open the Create Logic Gate 
window. In the window, select two current gates and define the logic gate with 
AND or OR. Select one gate if you wish to define logic gate with NOT. The logic 
gate name and color can also be defined in this window. 
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Range Gate: Draws a range gate.  

 

Bi-Range Gate: Draws a bi-range gate.  

 

Vertical Range Gate: Draws a vertical range gate. This function is only available 
for Spectrum Density plot. 

 

Zoom In: Zooms in on a specified area of a plot. To use, select the tool, click and 
drag inside a plot to create a rectangle. The plot will be zoomed in on the area 
inside the rectangle. To zoom in only along one axis, click and drag along either 
the X-axis or the Y-axis on the plot.  

 

Zoom Out: Zooms out on a specified area of a plot. To use, select the tool, and 
click on a plot to zoom out. Continue to click to zoom out further. To zoom out 
only along one axis, click on either the X-axis or Y-axis on the plot.  

 

Auto Range: The display range for the X-axis and Y-axis are automatically 
adjusted to fit the experimental data. 

 

Full Range: The display range for a plot is set to the maximum. 

 

Move: Use to adjust the display parameters of a plot by dragging the plot area. To 
use, select the tool, click and drag inside the plot to achieve the desired display 
range. To only adjust along one axis, click and drag along either the X-axis label or 
Y-axis label. The display range will only be adjusted along the selected axis. 

 

Synchronize Plot Scale: When selected, the axis range and scale of same 
parameter on different plots of same sample will be automatically synchronized 
when user change axis range or scale. 

 

Adjust Threshold: Use this tool to adjust threshold value on plot. Refer to 
Threshold Settings in this guide for detailed procedures. 

 

Quick Compensation: Allows user to quickly adjust the Spillover Matrix through 
scrollbars. To use, select the tool. Scrollbars appear on plots to allow for 
adjustment of Spillover Matrix. This function is only available in Unmixed 
Workspace.  

 

Show Statistics: Shows or hides the statistical tables below plots. 

 

Cell Cycle Plot: Creates a cell cycle analysis plot. This function is available only 
when user works in Unmixed Workspace. Refer to Cell Cycle Analysis in this 
guide for more details. 

 

Cell Proliferation Plot: Creates a cell proliferation plot. This function is only 
available in Unmixed Workspace. Refer to Cell Proliferation Analysis in this guide 
for more details. 
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Spectrum Density Plot: Creates a spectrum density plot. This function is only 
available in Raw Workspace. Refer to the Spectrum Density (Dot) Plot in this 
guide for more details 

 

Spectrum Dot Plot: Creates a spectrum dot plot. This function is only available in 
the Raw Workspace. Refer to the Spectrum Density (Dot) Plot in this guide for 
more details 

 

Fluorochrome Bi-Variate Plots: Opens Fluorochrome Bi-Variate Plots window. 
This function is only available in the Unmixed Workspace. Refer to Fluorochrome 
Bi-Variate Plots in this guide for more details. 

 

Previous Plot: Switches the active plot to the previous plot. Use this tool when 
the plot window is maximized. 

 

Next Plot: Switches the active plot to the next plot. Use this tool when the plot 
window is maximized. 

Cytometer Setting Panel 

The Cytometer Setting panel sets the data collection parameters, stop conditions, 
flow rate, and threshold. This panel is displayed by default. User can click 
Fluorochrome Setting button on the bottom of this panel to switch to 
Fluorochrome Setting panel (refer to Fluorochrome Setting for details). For more 
details of Cytometer Setting panel, please refer to Cytometer Setting in this guide. 
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Fluorochrome Setting Panel 

The Fluorochrome Setting panel allows user to view and edit the fluorochromes 
for current selected sample. User can click the Fluorochrome Setting button on 
bottom of the Cytometer Setting panel or click Fluorochrome Setting node in 
Experiment Manager to access this window. Depending on whether Spectral 
Unmix or Compensation is selected to analyze the data, this window may display 
different information. Please refer to Fluorochrome Setting in this guide for more 
details. 
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When Spectral Unmix is selected 

 
When Compensation is selected 

Cytometer Control Panel 

The Cytometer Control panel contains the Active Sample Information and the 
Experiment Control panel. The Experiment Control panel contains different 
functions when NovoSampler S is connected. Please refer to Cytometer Control 
for in this guide for more details. 
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When NovoSampler S is not connected  

 
When NovoSampler S is connected  

Plate Manager 

The Plate Manager allows user to set up the working mode, plate type, mixing and 
rinsing conditions when NovoSampler S is used. Please refer to Plate Manager in 
this guide for more details. 
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Experiment Manager 

The Experiment Manager contains the sample hierarchy structure and functions 
for copying, pasting templates, and importing and exporting sample data. 
additional information (e.g., Well ID) is displayed when NovoSampler S is 
connected. Please refer to Experiment Manager in this guide for more details. 

   
When NovoSampler S is not connected 



Use NovoExpress (Opteon) Software 
 
 

NovoExpress (Opteon) Software Guide 87 

   
When NovoSampler S is connected 

Cytometer Status Panel 

The Cytometer Status panel displays the fluidic reagent status, photodetector 
gains, and laser powers. This panel is hidden by default. To show this panel, check 
the Cytometer Status box in the Show group of the View tab. 
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Gate Manager Panel 

The Gate Manager displays all gates of the active sample in list mode or tree 
mode. This panel is displayed by default after initial installation of the software. 
User can click Reset Layout or check Gate Manager option from View tab of 
software main window to display it again after closes it. This panel allows user to 
modify gate name, color and color precedence and also shows gate hierarchy and 
gate statistics. Please refer to Gate Manager in this guide for more details. 

 

Status Bar 

The status bar located at the bottom of the software main window displays the 
instrument’s status through color indicators. If the instrument is connected, the 
indicator can be green, red, or yellow, indicating a normal condition, an error, or a 
warning, respectively. If the instrument is not connected to the computer, the 
indicator is greyed out. 

Green Indicator 

The indicator light is green if the instrument is connected and without warnings or 
errors.  

User may observe following green indicator during normal operation of the 
instrument. 
• The status bar will display Ready as shown below if the instrument has 

completed the initializing sequence and is ready for additional commands. 
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• The status bar displays Instrument initializing as shown below after powering 
on the instrument. The initializing sequence flushes the fluidic lines in the 
instrument to prepare for sample acquisition. 

 

• The status bar displays Instrument shutting down as shown below after 
shutting down the instrument. The shutting down sequence flushes the fluidic 
lines and automatically powers off the instrument when complete. 

 

• The status bar displays Sample acquiring during sample acquisition. 

 

Flashing Red Indicator 

If an error occurs, the indicator flashes red. An error message is displayed with the 
cause and possible solutions. An example red indicator is shown below. Please 
refer to Troubleshoot in this guide for details. 

 

User can click on the indicator to view detailed description of the error in the 
prompted message box. 

 

Flashing Yellow Indicator 

If a warning occurs, the indicator flashes yellow. A warning message displays the 
cause of the problem and possible solutions. An example yellow indicator is 
shown below. Please refer to Troubleshoot in this guide for details. 

 

User can click on the indicator to view the detailed description in the prompted 
message box. 
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Grey Indicator 

If the instrument is not connected to the computer, the indicator is grey. The 
instrument is either powered off or there is problem with the USB connection 
between the computer and instrument. Also, if multiple instances of the 
NovoExpress (Opteon) Software are running, only the first instance of the software 
will connect to the instrument. The remaining instances will not connect to the 
instrument and the indicator light will be grey.  

  

Instrument Configuration 

To open the Instrument Configuration window, click the Configuration icon from 
the Instrument tab of the Menu Bar. User can view the instrument configuration 
from this window.  

 

NovoExpress (Opteon) Software automatically detects the channel parameters, 
excitation lasers, and detection channels of a connected instrument. The software 
also detects if the NovoSampler S is connected with NovoCyte Opteon Spectral 
flow cytometer.  

If the instrument is powered off or not connected to the workstation, user can use 
the Instrument Configuration window to select the designated optical 
configuration to view the associated information. 
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Instrument Configuration with Instrument Connected  

The Instrument Configuration window displays the instrument type, current 
optical configuration, detection channel parameters for currently connected 
instrument, and status of NovoSampler S when the instrument is connected to the 
workstation and powered on. This window will display channel parameter, 
excitation laser, detection channel wavelength in tabular format.  

The status of the NovoSampler S is displayed in the lower left corner of this 
window. When the workstation is connected to the instrument and the instrument 
is powered on, it can automatically detect the installed NovoSampler S and this 
box will be automatically checked. 

 

Instrument Configuration with Instrument Disconnected  

When there is no instrument connected to the workstation or the instrument is 
powered off, user can view and select any one of available optical configurations 
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of the instrument displayed in the Optical Configuration field. The information 
displayed in this window will be automatically updated based on the selection. 
After selecting the optical configuration, click OK, and the software will restart. 
After restarting, the Cytometer Setting panel, the Cytometer Control panel, the 
Experiment Manager panel, and the Work List are all updated according to the 
new configuration settings. When the instrument is connected to the workstation 
and powered on, the software will automatically detect the current hardware 
setting, and display the corresponding information of the connected instrument. 

User can also view the NovoSampler S related software interface and functions by 
checking the NovoSampler S installed checkbox located at the lower left corner of 
Instrument Configuration window and clicking OK. The software will prompt a 
dialog box, asking to restart software. After restarting, the Cytometer Control 
panel, the Experiment Manager panel and the Work List are all updated, and the 
Plate Manager panel will be visible. 
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Manage Plate Types 

If NovoSampler S is used, user can add, remove, and modify plate settings in the 
Manage Plate Types window. To open this window, click the Manage Plate Types 
button from Instrument > NovoSampler S. 

 

 

 

NOTE When NovoSampler S is used, a new plate type must be calibrated before it could 
be used. Once calibrated, the same type of plate can be used for an experiment 
without any calibration needed. 

 
 

NOTE Plate Type is defined by the format of the plate and the geometry of the well. For 
example, two U-bottom 96-well plates are considered as different types if they have 
different height of the well. 

 
 

NOTE Specify the plate name in detail to help easy recognition of different plate type, such 
as Nunc 96-Well Polypropylene Plates, Corning Carbo-BIND 96-well plates, etc. 
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All the available plate types are listed in the left panel in the Manage Plate Types 
window. Please refer to NovoSampler S Operator’s Guide for more details on 
compatible plates. 

All functions in this window are described below. 
• Name: The name of the selected plate type. User cannot edit this area if the 

built-in plate type is selected. However, when new plate (i.e., user defined 
plate) is added, user can edit its name in this area. 

• Plate Format: The plate format of the selected plate type. This property cannot 
be changed. 

• Max Volume: Set the limit for the maximum sampling volume user can define 
in the Stop Condition of Cytometer Setting panel for an experiment. Max 
Volume can be set in a range between 10 µL to 5000 µL. 

 

NOTE Define an appropriate Max Volume to avoid running out of sample for a well during 
an experiment. 

 
 

• SIP Movement Offset (+ Down, - Up): The sample injection probe height offset 
relative to the default height when aspirating the sample from each well or 
tube. Positive value means the height is decreased. Negative value means the 
height is increased. The SIP Movement Offset can be set in a range between -
10 mm to 5 mm with default value of zero. 

 

NOTE Set SIP Movement Offset to be Positive can help to reduce the dead volume from 
each well. 

 
 

 
 

 

Be cautious to set the SIP Movement Offset. Incorrect setting would result in 
collision of SIP to the bottom of the well. When NovoSampler S is used, the SIP 
height is automatically calibrated during plate type calibration. Normally, there is no 
need to adjust the SIP Movement Offset. 

 
 

• Mix Speed: The mix speed of the orbital shaker. Refer to table below for the 
range of mix speed and default mix speed for each compatible plate.  
 

Auto-Sampler Plate Type Range of Mixing 
Speed (rpm) 

Default Mixing 
Speed (rpm) 

NovoSampler S 96 well plate (U, V and Flat bottom) 200 - 3000 1500 

24 well plate 200 - 3000 2500 

48 well plate 200 - 3000 1500 

40 tube rack (12 X 75 mm tubes) 200 - 1200 1000 
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384 well plate 200 - 3000 2500 

24 tube cooling rack (12 X 75 mm 
tubes) 

200 - 1200 1000 

96 well plate (U, V and Flat bottom) 
with cooling box 

200 - 2000 1500 

40 tube rack (1.5/2.0 mL tubes) 200 - 1500 1500 

 

NOTE Determine the proper mixing speed and volume before running the experiment can 
help to avoid any potential spills during the experiment running. 

 

 

NOTE When NovoSampler S is selected to work in Standard and High-Throughput mode, 
the software will automatically apply the default settings for mixing cycle, rinse 
cycle, mixing speed, acceleration, mixing duration, sampling volume and flow rate. 

 

• Mix Acceleration: The acceleration time for the orbital shaker to reach the 
specified Mix Speed. Mix Acceleration can be set 1 second (default) to 10 
seconds for NovoSampler S.  

• Mix Duration: The mixing time for the orbital shaker to mix the sample when 
NovoSampler S works in Custom mode. Mix Duration can be set from 1 
second to 120 seconds. However, the default mix duration may vary when 
NovoSampler S works in other mode (i.e., Standard and High Throughput 
mode). Please refer to Plate Manager in this guide for more details.  

• Built-in: Checked if the selected plate is the built-in plate type. Built-in plate 
types cannot be renamed or deleted. The built-in information is read only.  
 

NOTE The built-in plate type has been tested with biological samples, including human 
peripheral blood sample and cultured cell lines, to determine the default mixing 
settings. At the default mixing settings, the biological samples can be effectively 
mixed and uniformly suspended inside each well. 

 

• Calibrated: Indicate if the selected plate type is calibrated. Only calibrated 
plate type can be used in experiments.  

• Reset to Default: Click this button to reset the Max Volume and SIP 
Movement Offset of the selected plate type to default, and reset the Max 
Volume, SIP Movement Offset, Mix Speed, Mix Acceleration, and Mix 
Duration of the selected plate type to default. Only built-in plate types can be 
reset to default. 
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• Remove: Click this button to delete the selected plate type. Only user defined 
plate types can be removed. 

• Add: Click this button to add a user defined plate type. Enter plate type name 
for new plate type in the prompted window. The Copy from function helps to 
quickly set up a customer plate type based on the format of an existing plate 
type. Choose a proper existing plate type from the Copy from drop-down list. 
The Plate Format, Max Volume and SIP Movement Offset settings are copied 
from the Copy From plate type. 

 

• Calibrate: This function is available only when NovoSampler S is connected. 
Click this button to calibrate the selected plate type. Only calibrated plate type 
can be used in experiments. The Calibrated checkbox indicates if the selected 
plate type is already calibrated. Figure below shows the dialog box prompted 
when the Calibrate button is clicked. 

 

Click OK after properly placing a plate of the selected plate type on the orbital 
shaker. It will take several minutes to complete the plate type calibration 
process. If the plate is not placed properly, the calibration could fail and a 
dialog box shown below will be prompted. Reposition the plate properly and 
conduct the calibration again. 

 

 

 Before loading multi-well plates or tube racks, identify the correct orientation to 
position the plate or the tube rack onto the orbital shaker. Make sure the sample 
plate is positioned properly on the orbital shaker and completely contact the 
surface of the orbital shaker without any tilting. Incorrect placement may cause 
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misalignment between the sample wells and sample injection probe, resulting in 
damage to the sample injection probe or the orbital shaker. 

 
 

NOTE Before calibrating 40 tube rack (12 X 75 mm tubes) or 24 tube cooling rack (12 X 75 
mm tubes), ensure a 12 X 75 mm tube is fully inserted in each position of the tube 
rack. Before calibrating the 40 tube rack (1.5/2.0 mL tubes), ensure to cut off the 
cap from a 1.5 or 2.0 mL tube and fully insert the tube in each position of the tube 
rack. 

 
 

NOTE Once plate type calibration is initiated, the Calibrate button in the Manage Plate 
Types window will automatically become Stop Calibration button. Click Stop 
Calibration will stop the plate type calibration. 

 

New Reference Control Specimen 

The New Reference Control Specimen window allows user to create and define 
new Reference Control specimen and sample.  

This window can be accessed using one of the methods below. 
• Click the New Reference Control Specimen icon from the Unmix tab. 

 

• Right click file node or group node in Experiment Manager panel and select 
New Reference Control Specimen. 
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In the prompted window, user can view and define the Unstained Control sample, 
auto fluorescence settings, and single stained control sample, etc. 
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The functions included in this window are described below. 
• Import samples from FCS file: Check to create Reference Control specimen 

from imported FCS file. Refer to Conduct Spectral Unmixing from Imported 
FCS Files for more details. This option is unchecked by default. 

• Auto update Reference Spectra and conduct unmixing when population 
changed: When checked, if there are any changes to the gated population 
(e.g., changes to the gating of autofluorescence population, negative or 
positive population gating of single stained control sample), the associated 
Reference Spectra will be automatically updated followed by automatic data 
unmixing (or compensation) accordingly. This option is unchecked by default. 

• Plot on: Allows user to select Height or Area when creating the plot.  
• Side Scatter (SSC): Allows user to select VSSC (405nm SSC) or BSSC (488nm 

SSC) when creating the dot plot for unstained and single stained sample. The 
BSSC is checked by default. For instrument not equipped with VSSC module, 
this option will be automatically disabled.  

• Parameter for calculation: Allows user to select Mean or Median when 
calculating the Reference Spectra. The Median is checked by default. 

• Unstained Controls: Allows user to define the Unstained Control sample. 
 Name: Displays the name of the Unstained Control sample. User can 

double click associated cell and enter the desired name. Unstained is 
displayed by default. 

 Control Type: Displays the type of the Unstained Control sample. User can 
select Beads or Cells from the drop-down menu of associated cell. Cells 
is selected by default. 

 

 Notes: Displays the relevant notes associated with the unstained sample. 
User can double click the associated cell and enter the notes. 

 Sample Name: Displays the sample name of the Unstained Control 
sample. When user imports the control sample from an FCS file, the 
header of this column will be automatically changed to FCS File/Sample 
Name and user can select the designated FCS file from the drop-down 
menu of selected cell. 
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 Add: Click to add a new Unstained Control sample. 
 Remove: Click to remove selected Unstained Control sample. 
 Set as Negative: Click to set the main population of the selected 

Unstained Control sample as the negative population for all Single Stained 
Control samples. 

• Auto Fluorescence: Allows user to define the auto fluorescence control tag. 
 Auto Fluorescence: Displays the name of the auto fluorescence control 

tag. A default name (i.e., AF Main) is automatically generated based on 
associated population. User cannot edit it.  

 Population: Displays the population of the auto fluorescence control tag. 
User can select designated population from the drop-down menu of 
associated cell.  

 

 Negative Population: Displays the negative population of the auto 
fluorescence control tag. User can select designated population from the 
drop-down menu of associated cell as the negative population. When 
defined, the software will subtract it from the main population during 
calculation of the auto fluorescence Reference Spectra. 

 
 

NOTE Ensure to select the same unstained sample for the Negative Population and 
Population. Following error may be prompted if different samples are selected and 
user clicks OK in New Reference Control Specimen window. 

 
 

 Add: Click to add a new auto fluorescent control tag. 
 Remove: Click to remove selected auto fluorescent control tag.  
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• Single Stained Controls: Allows user to define the Single Stained Control 
sample. 

 

 Edit: Click to add new Single Stained Control sample in prompted Edit 
Fluorochrome window below. Refer to Fluorochrome Setting in this guide 
for more details of this window. 

 

 Duplicate: Click to duplicate the selected single stained control sample 
and add the duplicated single stained control sample as new control 
sample with suffix of duplicating number added to the end of the sample 
name. For example, if user selects fluorochrome 5-CFDA, clicks Duplicate, 
a duplicated single stained control sample with name of 5-CFDA Cells 1 
will be automatically added below the selected sample. Note the default 
control type is Cells. When user changes the control type to Beads, the 
sample name will be changed accordingly. 
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NOTE When user clicks Edit from the Single Stained Controls panel to open the Edit 
Fluorochrome window, double click the selected fluorochrome, and click OK. The 
software will automatically add the selected fluorochrome into the Single Stained 
Controls panel as a new control sample with the associated sample name same as 
the fluorochrome name. If user double clicks the selected fluorochrome more than 
once, the software will add a duplicated sample with the suffix of Control Type and 
a duplicating number added to the end of the sample name.  

NOTE The suffix of a duplicated control sample can also be changed in the Experiment 
Manager, Cytometer Control (Active Sample Information), Worklist, and Plate 
Manager window.  

NOTE When user edits the Single Stained Controls panel in Reference Control Specimen 
Setup window or New Reference Control Specimen window, any changes to the 
Emission Channel or Virtual Filter information will be automatically applied to any 
duplicated single stained control samples with the same fluorochrome.  

 Remove: Click to remove selected Single Stained Control sample. 
 Reset Negative: Click to reset the negative population for the Single 

Stained Control samples to its default negative population. 
 Fluorochrome: Displays the name of the fluorochrome selected for Single 

Stained Control sample. User cannot edit it. 
 Display Name: Displays the name to be displayed for the associated 

fluorochrome. User can double click associated cell and enter the desired 
name. When defined, the newly created plot and statistical table will use 
Display Name as parameter name. When not defined, the newly created 
plot and statistical table will use Fluorochrome as parameter name.  

 Marker: Displays the antibody or biomarker for the associated 
fluorochrome. User can double click associated cell and edit the name. 

 

NOTE The default name of the Single Stained Control sample will be combination of 
defined Marker and Display Name (or Fluorochrome). For example, if user defines 
CD3 for Marker, BV510 for Display Name, then the name of the single stained 
sample will be CD3 BV510. 

 

 Control Type: Displays the type of the Single Stained Control sample. User 
can select Beads or Cells from the drop-down menu of associated cell. 
Cells is selected by default. 
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 Negative Population: Displays the negative population of the Single 
Stained Control. User can select designated population from the drop-
down menu of associated cell to define it as the negative population. 

 

 Emission Channel: Displays the emission channel information for 
associated fluorochrome. Software will use this information to create 
histogram of Single Stained Control sample by default. Any changes to 
this information will be automatically applied to any duplicated single 
stained control samples with the same fluorochrome. 

 Notes: Displays the relevant notes associated with the single stained 
sample. User can double click the associated cell and enter the notes. 

 Sample Name: Displays the sample name of the Single Stained Control 
sample.  

 FCS File: This column is displayed only after user imports FCS files as 
single stained control samples. When displayed, it shows the FCS file 
name of the Single Stained Control sample. User can select the 
designated FCS file from the drop-down menu of selected samples.  

 

• OK:  Click to make all changes effective. The Reference Control specimen with 
node icon of  and defined Reference Control samples (e.g., Unstained and 
Single Stained control samples) will be automatically created in Experiment 
Manager (see example below). 
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Selected plots associated with defined control sample(s) will be also 
automatically created in each workspace (refer to table below for the type of 
plots software automatically creates in each workspace). 

Reference Control Sample Raw Workspace Unmixed Workspace 

Unstained Control Sample • Density Plot of FSC 
Height (or Area) versus 
BSSC (or VSSC) Height 
(or Area) 

• Spectrum Density Plot 

• Density Plot of FSC Height 
(or Area) versus BSSC (or 
VSSC) Height (or Area) 

• Density plot of defined auto 
fluorescence and defined 
fluorochrome Height (or 
Area) versus BSSC (or VSSC) 
Height (or Area) 

Single Stained Control Sample • Density Plot of FSC 
Height (or Area) versus 
BSSC (or VSSC) Height 
(or Area) 

• Spectrum Density Plot 
• Histogram plot of 

emission channel 
versus event count 

• Density Plot of FSC Height 
(or Area) versus BSSC (or 
VSSC) Height (or Area) 

• Density plot of defined 
fluorochrome Height (or 
Area) versus defined auto 
fluorescence and other 
defined fluorochrome Height 
(or Area)  

• Cancel:  Click to cancel the operation. 

Conduct Spectral Unmixing from Imported FCS Files 

To perform Spectral Unmixing directly from the imported FCS file:  
1 Click Unmix > New Reference Control Specimen to open the New Reference 

Control Specimen window. Select the Import Samples from FCS files and 
click Import button. 

 
 

NOTE This window can also be accessed by right clicking the experiment file and 
selecting New Reference Control Specimen in the Experiment Manager window. 
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2 In the prompted window, select the single file or multiple files while pressing 
the Shift key in the keyboard. Click Open to import the selected file(s) to the 
software. 

 

3 Ensure all the selected FCS files are successfully imported to the software. 
Click OK to continue.  
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4 Set the unmixing parameters in the New Reference Control Specimen window 
(i.e., Area or Height, VSSC or BSSC, Median or Mean).  

 

5 Ensure the selected FCS file for each unstained and single stained sample is 
correct. To select different single stained FCS file, click the FCS file name, 
select the desired file from the pull-down menu. 

 
 

 The software will automatically identify the fluorochrome and marker associated 
with unstained and single stained sample based on the keyword of the file name 
(e.g., CD3 FITC). Users need to verify and select the correct FCS file for each 
unstained and Single Stained Control sample. 

 

6 Click OK and NovoExpress (Opteon) will automatically create the 
corresponding unstained and Single Stained Control samples, calculate the 
Reference Spectra based on the samples imported. Once generated, the 
Reference Spectra can be applied to other experiment samples.  

Reference Spectra 

User can view and edit the Reference Spectra information for associated 
specimen or sample through the Reference Spectra window. This window will 
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display different information depending on whether user selects Spectral Unmix or 
Compensation to analyze the data (Refer to Right-Click Menu of Experiment 
Manager in this guide for instructions to switch between Spectral Unmix and 
Compensation). 
• When Spectral Unmixing is selected, user can view and edit Spectral Source, 

Spectral Plot, Spectral Data, Similarity Index, Spillover Spreading Matrix 
(SSM), and Spillover Matrix after Unmixing associated information, etc. in this 
window.  

  

• When Compensation is selected, user can view and edit Compensation 
Matrix, Spillover Matrix, Spillover Spreading Matrix (SSM) associated 
information, etc. in this window. 



Use NovoExpress (Opteon) Software 
 
 

NovoExpress (Opteon) Software Guide 108 

 

The Reference Spectra window consists of functions and information for 
Reference Control specimen, Unstained Control sample, Single Stained Control 
sample and experiment sample. For demonstration purpose, the Reference 
Spectra window of Reference Control Specimen is used as example to show 
and describe each function. For other control sample or experiment sample, 
certain functions are not available and will be noted in associated description 
below.  

To access Reference Spectra window of selected specimen or sample, use 
one of the methods below. 

• Click to select the target specimen or sample in Experiment Manager. If 
Reference Control Specimen, Unstained Control sample, or Single Stained 
Control sample is selected, click Active Reference Control Specimen > 
Reference Spectra from the Unmix tab of software main window. If 
experiment sample is selected, click Active Sample > Reference Spectra from 
the Unmix tab of software main window. 

 

• Double click Reference Spectra node of associated specimen or sample from 
the Experiment Manager. 
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Following options are available in Reference Spectra window for any specimen or 
sample no matter whether user selects Spectral Unmix or Compensation.  
• Unmix Type:  Displays the unmix type.  
• Height: Check to use Height parameter for analysis.  
• Area: Check to use Area parameter for analysis.  

 

Reference Spectra for Reference Control for Spectral Unmix 

Following options are available only when Spectral Unmix is selected. 
• Only display the fluorochrome used: When checked, only the fluorochrome 

checked in Fluorochrome Setting panel will be displayed in Spectral Plot, 
Spectral Data, Similarity Index, Spillover Spreading Matrix (SSM), and 
Spillover Matrix after Unmixing panel. This option will not be available if all 
fluorochromes are checked in Fluorochrome Setting window.  

• Hide Auto Fluorescence: When checked, the auto fluorescence information 
will not be displayed in Spectral Plot, Spectral Data, Similarity Index, Spillover 
Matrix after Unmixing panel of this window. 

• Spectral Source: This panel will be available only if the duplicated single 
stained control sample or spectra exists. User can click Single Stained sub-tab 
to view the spectra information for all defined single stained control samples, 
including Source, Name, Spectra for Unmixing, Fluorochrome, Display Name, 
Marker, Control Type, Emission Channel, Reference Spectra, Acquisition 
Time, Gain, Notes, Similarity Index. Note the Name column displays the 
sample name, and Spectra for Unmixing column displays the spectra info 
software used to unmix the associated control sample. By default, the 
software will use the spectra acquired from data collection for associated 
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control samples. User can select different spectra from its drop-down menu. 
The Similarity Index column displays the calculated similarity index value 
between the checked sample and present sample. This value automatically 
updates when user checks different samples. 

 

NOTE When Spectral Source tab is displayed, if there are more than one spectra 
associated with one fluorochrome, only one spectra can be checked and will be 
used for spectrum unmixing. The information in other tabs of the Reference 
Spectra window (e.g., Spectral Plot) will be automatically updated accordingly.  

NOTE When Spectral Source tab is displayed, user can only edit Spectra for Unmixing 
column and check/uncheck the check box in front of each spectra of 
corresponding sample.  

• Spectral Plot: This panel is available only when the duplicated single stained 
control sample or spectra exists. When clicked, user can view spectral plot for 
selected fluorochrome of associated sample or specimen. When right clicking 
the plot, user can select to display the fluorochrome name on top of the plot 
by checking Show Parameter Name, or display the plot legend by checking 
Show Legend, or check/uncheck the designated fluorochrome to have the 
associated spectra to be displayed/not displayed.  
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Following additional functions are available in Spectral Plot panel. 
 Add to Library: This option is available only for Reference Control sample 

or specimen. When clicked, the displayed Reference Spectra will be added 
into the Reference Spectra Library. Please refer to Add Reference Spectra 
to Library in this guide for more details. 

 Import from Library: When clicked, following window will be prompted. 
User can import the selected Reference Spectra from the Reference 
Spectra library to the target Reference Control sample or specimen. 
Please refer to Import Reference Spectra from Library in this guide for 
more details. 
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 Export: Click to export the displayed spectral plot in format of PNG, JPEG, 
Bitmap, GIF, TIFF, or Enhanced Metafile. 

• Spectral Data: When clicked, user can view the normalized MFI value of each 
channel for Reference Spectra of selected sample (or specimen). The value for 
associated emission channel is displayed in blue color. User can also click 
Export in the bottom of this panel to export the displayed spectral data in 
format of CSV. For Reference Control sample or specimen, the Import from 
Library option will be available for user to import the selected Reference 
Spectra from the Reference Spectra library. Please refer to Import Reference 
Spectra from Library in this guide for more details. 

    

• Similarity Index: When clicked, user can view the Similarity Index value 
between each fluorochromes. The Complexity Index value of all 
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fluorochromes is displayed in the lower left corner of this window. User can 
also click Export in the bottom of this window to export the displayed 
Similarity Index data in format of CSV. 

 
 

NOTE Similarity Index measures the fluorochrome pair uniqueness on a scale from 0 to 
1. Values close to 0 indicate that the full spectrum signatures of the two 
fluorochromes are very different from each other, and values close to 1 indicate 
that the signatures are very similar to each other. 

 
 

NOTE Complexity Index measures the uniqueness of all fluorochromes in a full spectrum 
cytometry panel. In general, the lower the value, the easier it will be to work with the 
fluorochromes in the panel as the overall spread in the panel will be low. The higher 
the value, the more challenging it will be to work with the fluorochromes in the 
panel as the overall spillover spread is higher. This value in general may increase 
with panel size. 

• Spillover Spreading Matrix (SSM): SSM is a measure of the performance of 
an instrument for a given panel. Click to display the Spillover Spreading Matrix 
(SSM) values of associated fluorochromes. SSM values are calculated based 
on formula below. 
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𝑆𝑆𝑆𝑆(X → Y) = �
Δ(𝜎𝜎𝑌𝑌2) 

Δ𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑋𝑋
= �

(𝜎𝜎𝑌𝑌𝑃𝑃)2 − (𝜎𝜎𝑌𝑌𝑁𝑁)2 
𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑋𝑋𝑃𝑃 −𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑋𝑋𝑁𝑁

 

where 𝑆𝑆𝑆𝑆(X → Y) is the spillover spreading value from fluorochrome X to Y. 𝜎𝜎𝑌𝑌 
is the difference between 84th percentile and 50th percentile of population. 𝑃𝑃 
represents the positive population of single stained X, 𝑁𝑁 represents the 
negative population of single stained X or unstained.  
User can click Export at the bottom of this panel to export the matrix in format 
of CSV. 

 
 
 

NOTE SSM panel is only available for Reference Control Specimen and Single Stained 
Control Sample when user selects either Spectral Unmixing or Compensation to 
analyze the data. 

• Spillover Matrix after Unmixing: Click to view and edit the Spillover Matrix 
value after Spectral Unmixing. User can click Export in the bottom of this panel 
to export the displayed information in format of CSV. To edit the Spillover 
Matrix, double click the cell and enter the new value. To clear all the edited 
Spillover Matrix, click Clear. To restore the Spillover Matrix to the one that is 
last saved, click Restore.  
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NOTE Spillover Matrix is a matrix where each row contains value of spillover of a 
fluorochrome into the others. In an example of calculating spillover, the spillover of 
FITC into the PE using median or mean height measurements is shown below. The 
values below are measured from the single stained FITC sample. 

Spillover of FITC into PE =
(𝑋𝑋𝑃𝑃𝑃𝑃,𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 − 𝑋𝑋𝑃𝑃𝑃𝑃 ,𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛)

(𝑋𝑋𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹,𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 − 𝑋𝑋𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹,𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛)
 

where 𝑋𝑋𝑃𝑃𝑃𝑃 ,𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 is the median or mean in the PE-H of the positive FITC population, 
and so on. 

 
 

Reference Spectra for Reference Control for Compensation 

Following options are available only when Compensation is selected. 
• Matrix Source: This tab is only available when a duplicated single stained 

control sample exists. User can view the information for all defined single 
stained control samples, including Source, Name, Matrix for Compensation, 
Fluorochrome, Display Name, Marker, Control Type, Virtual Filter, Acquisition 
Time, Gain, Notes. Note the Name column displays the sample name, and 
Matrix for Compensation column displays the matrix info the software used 
to compensate the associated control sample. By default, the software will 
use the matrix acquired from data collection for the associated control 
sample. User can select a different matrix from its drop-down menu.  
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NOTE When Matrix Source tab is displayed, if there are more than one compensation 
matrix associated with one fluorochrome, only one matrix can be checked and will 
be used for data compensation. The information in other tabs of the Reference 
Spectra window (e.g., Compensation Matrix) will be automatically updated 
accordingly.  

 
 

NOTE When Matrix Source tab is displayed, user can only edit Matrix for Compensation 
column and check/uncheck the check box in front of each matrix of corresponding 
sample.  

• Compensation Matrix: Click to display the compensation matrix coefficients 
of associated fluorochromes.  
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NOTE Compensation Matrix is used to directly calculate the compensated fluorescent 
intensity of each fluorochrome through sum of associated negative of column 
percentage multiplied by measured fluorescent intensity value from associated 
Virtual Filter(s). It is inversely related to the Spillover Matrix. 

 
 

Following additional functions are available in Compensation Matrix panel. 
 Active Sample: Allows user to view and select the active sample from the 

drop-down menu. The plots in Unmixed Workspace will be automatically 
updated based on user selection of the active sample. This option is 
available only for Reference Control Specimen. 

 Auto Calculate:  When checked, the software will automatically re-do the 
auto compensation if there is any change to the Spillover Matrix 
coefficients.   

 Preview: When checked, the plots in Unmixed Workspace will be 
continually updated in real time without exiting out of the current window 
as adjustments are made to the compensation matrix. 

 Export: Click to export the compensation matrix to CSV file. 
 Clear: Click to reset the compensation matrix. The compensation matrix 

coefficients will be reset to zero. 
 Restore: Click to restore the compensation matrix to the last saved one. 
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• Spillover Matrix: Click to display the Spillover Matrix coefficients of associated 
fluorochromes.  

 

Following additional functions are available in Spillover Matrix panel. 
 Active Sample: Allows user to view and select the active sample from the 

drop-down menu. The plots in Unmixed Workspace will be automatically 
updated based on user selection of the active sample. This option is 
available only for Reference Control Specimen. 

 Auto Calculate:  When checked, the software will automatically re-do the 
auto compensation if there is any change to the Spillover Matrix 
coefficients. By default, this option is checked. User can uncheck it to 
enter the manual calculation mode. In manual calculation mode, a slide 
bar will appear allowing user to quickly modify the coefficient for the 
selected cell. Alternatively, user can also double click individual cell in the 
matrix to edit the value directly. Please note user cannot edit the matrix 
value when Auto Calculate is checked.   

 Preview: When checked, the plots in Unmixed Workspace will be 
continually updated in real time without exiting current window as 
adjustments are made to the spillover matrix. 

 Export: Click to export the Spillover Matrix to CSV file. 
 Clear: Click to reset the Spillover Matrix. The Spillover Matrix coefficients 

will be reset to zero. 
 Restore: Click to restore the Spillover Matrix to the last saved one. 
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Option Settings 

When user clicks Setting > Options > Option Settings from the software Menu 
Bar, the Options window will be prompted. User can define each setting in 
General, Experiment, Analysis, Absolute Count, Statistical Table, Report, and 
Security sub-window.  
• General:  Allows user to define general settings. This sub-window will be 

displayed by default when user clicks Option Settings from the software menu 
bar.  

   

 Use traditional icons: Allows user to select to display all software icons in 
traditional style. By default, this option is unchecked. When checked, 
following window will be promoted. 
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After user clicks Yes, the software will automatically restart, and the 
traditional icons will be applied after user logs back into the software as 
shown below. 

 

 Automatically login with User:  
If this box is checked, the current user will automatically be logged in 
when the software starts and the login window will not appear. 

 Display Language: Indicates the language software use to display.  
 Maximum number of events for display during acquisition:  

Sets a limit to the number of events displayed on plots during sample 
acquisition. For example, if this is set to 20,000 events, only the last 20,000 
events collected will be displayed. The maximum setting is 50,000 events. 

 Ctrl + C to copy selected table content with header, Shift + C without 
header:  
When selected, statistical data copied from either the Statistical Table or 
the table below the plots will include a header when copied using Ctrl + C 
and will not include a header when selected using Shift + C. 

 Copy plot with border:  
When selected, plots copied will include a dotted line border. 

 Only one NovoExpress software application is allowed to run at one 
time: 
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When selected, only one instance of NovoExpress (Opteon) is allowed to 
run at a time. An error message will be displayed when user tries to run a 
second instance of NovoExpress (Opteon). 

 Synchronize plot scale between plots of same sample: 
When selected, the axis range and scale of same parameter on different 
plots of same sample will be automatically synchronized when user 
change axis range or scale.  
User can also click Synchronize Plot Scale button  on workspace 
toolbar to quick switch this setting. Refer to Workspace Toolbar for more 
information. 

 Conduct Extensive Clean when entering sleep mode or shutting down 
instrument  
When selected, the instrument will automatically perform the Extensive 
Clean procedure during instrument shut down or when instrument enters 
sleep mode. The total time required for instrument to shut down or enter 
the sleep mode is around 30 min. This option is available only when 
instrument is properly connected and powered on. Please contact Agilent 
technical support for further questions on this procedure.  

 Automatically check for software updates: 
When selected, the software will automatically check for any software 
updates when the workstation is connected to internet.  

 

• Experiment: Allows user to define experiment related settings. This window 
displays additional settings when NovoSampler S is connected.    
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When NovoSampler S is not connected 

 
When NovoSampler S is connected 

Following functions are included in Experiment panel. 
 User data root folder:  

Sets the default folder for saving the experiment file.  
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 Default prefix of sample name:  
Sets the prefix for the name of the experiment sample.  

 Default prefix of specimen name:  
Sets the prefix for the name of the experiment specimen. 

 Automatically save experiment file in default experiment file folder with 
default name for new experiment: 
This setting determines how to save a current experiment file when a new 
experiment is started.  
If selected, the current file is automatically saved when a new experiment 
is started. The file is saved at the default experiment file folder with the 
name based on the current time in the format of YYMMDD_hhmm.ncf. 
If not selected, a Save As window appears when a new experiment is 
started. The user then has the option to set a name and location to save 
the current experiment file.  

 Automatically export samples to FCS/CSV files after data acquisition is 
completed: 
If selected, the software will automatically generate and export an FCS or 
CSV file after data acquisition is completed. Click Export Settings to open 
the Export Events window. Export Settings, including file format (i.e., FCS 
3.0, FCS 3.1, or CSV), can be defined in this window. Please refer to Export 
Data in this guide for more details. 

  

 Always remind to check plate type for first run when using 
NovoSampler: This option is available only when NovoSampler S is 



Use NovoExpress (Opteon) Software 
 
 

NovoExpress (Opteon) Software Guide 124 

connected. With this setting checked, a window will be prompted to 
remind user to check if the correct plate type is selected before starting 
the experiment. It is highly recommended to enable this setting to remind 
user to check and make sure the correct plate type is selected for the 
experiment to avoid collision of the sample injection probe. 

 

 Read plate barcode when running experiment: This option is available 
only when NovoSampler S is connected. If this option is selected, the 
software will automatically read the barcode attached to the plate. Please 
refer to Read Plate Barcode in NovoSampler S Operator's Guide for more 
details. 

 Keep time gap fixed when appending sample events for Calcium Flux 
Assay: 
If this option is selected, the software will keep the time gap fixed when 
appending sample events for some specific assay (e.g., calcium flux 
assay). 

• Analysis: Allows user to define analysis related settings. 
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Following functions are included in Analysis panel. 
 Use Height or Area parameter by default:  

Allows user to select to use Height or Area for data analysis by default. 
This setting when checked will automatically apply to New Reference 
Control Specimen window, Reference Spectra window, Fluorochrome Bi-
Variate Plot window, and all plots newly created in Raw or Unmixed 
Workspace.   

 Plot Default Property:  Allows user to set the default plot properties when 
creating a new plot. 
o Histogram plot filling type:  

Sets the filling type for the histogram plots. Options include None, 
Filled, and Tinted.  

o Smooth histogram plot:  
If selected, this option smooths data on histogram plots. 

o Levels of contour plot:  
Sets the contour plot level (2%, 5%, and 10%). 

o Show outlier for contour plot: 
If selected, outlier events are shown as dots on contour plots. 

o Spectrum plot style: 
Select to display the spectrum density plot and spectrum dot plot in 
either original or smoothed style. 

o Smooth density plot: 
If selected, density plots are smoothed. 

o Use pseudocolor for density plot:  
If selected, density plots are displayed in pseudocolor. 

o Showing fitting results for cell cycle analysis:  
If selected, the fitting results for the cell cycle analysis are displayed 
on the plot. 

o Show legend for overlay plots:  
If selected, plots with overlays include a legend. 

o Format: 
Click Format… button to open the Plot Format window to define plot 
default format. Click the Restore Defaults button in the window to 
restore factory default plot format. Refer to Plot Format in this guide 
for more details about plot format. 
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o Normalize histogram overlays:  
If selected, the histogram overlays are normalized to a 100% scale.  

o Default X and Y axis scale for fluorescent parameters: 
Allows user to select Biexponential, Log or Linear to be the default 
scale from the associated drop-down menu. By default, software will 
select Biexponential here. When a new Dot Plot, Density Plot, 
Histogram Plot or Contour Plot is created, the selected scale will be 
automatically applied. This setting will not apply to any previously 
created plots. 

 Display Options: Allows user to set plot display related options. 
o Show color for new gates:  

If selected, new gates are displayed with default color. If not selected, 
new gates are in black. 

o Show gate name in gate label: 
If selected, gate name is displayed in gate label on the plot. 

o Decimal places of mean and median values:  
Sets the number of digits displayed after the decimal point when 
computing mean and median values. 

o Show population percentile in gate label: 
If selected, gate label is displayed with the percentage of the 
population within the gate. 

o Width of spectrum plot:  
Set the plot width for spectrum density plot and spectrum dot plot. 

o Plot Title Options:  
If clicked, a drop-down menu will show as below. User can select to 
display plot title and what to be included in the plot title (e.g., Sampler 
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Name, Well ID (if NovoSampler S is connected), Specimen Name, 
Gating Name, Gating Hierarchy) on workspace plots. 

 

o Plot provides warning if XXX events are off-scale:  
If selected, the number or percentage of off-scale events will be 
displayed in created dot, density, histogram and contour plot after the 
data acquisition. By default, this function is enabled. User can click 
XXX area to open Events Setting window to define the off-scale event 
settings. By default, 5% off-scale events are selected in this window. 
User can check the radio button in front of events or %events and 
enter the proper number to define the off-scale settings. Once defined, 
after the data collection, when there is any off-scale events in either X 
or Y axis, the upper right corner of the associated plot will display “!”, 
user can hover the mouse onto it, and view the details of the off-scale 
event information. 

  

o The Plot and the Status Bar show warning messages if XXX events 
are saturated:  
If selected, user will see the number or percentage of saturated events 
displayed in created dot, density, histogram and contour plot after the 
data acquisition, and a warning message displayed in the software 
status bar during data acquisition. By default, this function is enabled. 
User can click XXX area to open Events Setting window to define the 
saturated event settings. By default, 5% saturated events are selected 
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in this window. User can check the radio button in front of events or 
%events and enter the proper number to define the saturated event 
settings. Once defined, after the data collection, when there are any 
saturated events in either X or Y axis, the upper right corner of the 
associated plot will display “!”, user can hover the mouse onto it, and 
view the details of the saturated event information. 

 

• Absolute Count: Allows user to define absolute count related settings. 

 

Following functions are included in Absolute Count panel. 
 Dilution Factor: 

Sets the default dilution factor for new samples. The Dilution Factor is a 
conversion coefficient used to calculate the absolute counting results for 
the original sample. For instance, if the original sample is diluted 10 times 
and is run on instrument, enter 1:10 in the Dilution Factor. NovoExpress 
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(Opteon) software will show the absolute counting results for the original 
sample by multiplying the concentration of the sample run on instrument 
by 10.  

 Absolute Count Unit:  
Sets the default absolute count unit for new samples. The Absolute Count 
Unit parameter is used to set the unit for the absolute counting. User can 
select one of the units (i.e., No./µL, No./mL, or No./L) to present absolute 
count result for number of interested particles per microliter, per milliliter, 
or per liter.  
Further information on absolute count calculations is described in 
Calculation of Statistics in this guide. 

• Statistical Table: Allows user to re-name the associated column header (i.e., 
Group name, Specimen name, Specimen ID, Plate ID, Plate Barcode, Plate 
Description, Well ID, Sample name, Sample ID, Operator Name, Run time, 
Unmix method, Gate name) in the statistical table. If Default Visibility is 
checked, the associated column will appear in the statistical table by default. 
Some options (i.e., Plate ID, Plate Barcode, Plate Description, Well ID) are 
only available when NovoSampler S is connected. 

  
When NovoSampler S is not connected 
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When NovoSampler S is connected 

• Report: Allows user to define report related settings. This window displays 
additional setting (i.e., Plate Information) when NovoSampler S is connected. 

 
When NovoSampler S is not connected 
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When NovoSampler S is connected 

Following functions are included in Report panel. 
 Plot Options: The settings in this panel are used for customizing plots 

inside new report. They are applied to both auto and manual report mode. 
o Show Gate Name in Gate Label: If selected, gate name is displayed in 

gate label on the plot. 
o Show Population Percentile in Gate Label: If selected, gate label is 

displayed with the percentage of the population within the gate. 
o Plot Title Options: If clicked, a drop-down menu will show as below. 

User can select to display plot title and what to be included in the plot 
title (e.g., Sampler Name, Well ID (if NovoSampler S is connected), 
Specimen Name, Gating Name, Gating Hierarchy) on report plots. 
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 Auto Report Mode Options: The settings in this panel are used for 
customizing automatically created report only. 
o Number of Plots per Row: Sets how many plots are shown in one row. 
o Orientation: Select to display the report in Portrait or Landscape 

orientation. 
o Plot Statistics: If selected, shows gate statistics of plot. 
o Sample Statistics: If selected, shows gate statistics of sample in the 

report and the associated Settings option will be available for user. 
User can click it and select to include gate hierarchy in the report. 

 

o Raw Plots: If selected, shows all the plots from Raw Workspace in the 
report. 

o Fluorochrome Setting: If selected, shows fluorochrome setting 
information of sample in the report and the associated Settings 
option will be available for user. User can click it and select to include 
fluorochrome parameter, emission channel, Reference Spectra, 
fluorochrome name, display name, and marker information in the 
report. 

 

o Unmixed Plots: If selected, shows all plots from Unmixed Workspace 
in the report. 

o Reference Spectra: If selected, shows Reference Spectra information 
of sample in the report and the associated Settings option will be 
available for user. User can click it and select to display in the report 
all Reference Spectra in one plot by checking All in One Plot or display 
one Reference Spectra in one plot by checking One by One Plot, or 
display Reference Spectra Height (or Area) plot by checking Height or 
Area. 
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o Plots Align by Workspace: If selected, display the plots in Raw 
Workspace first, then the plots in Unmixed Workspace. If not 
selected, display the plots in the order of sample defined in 
Experiment Manager.  

o Spillover Matrix After Unmixing: If selected, shows Spillover Matrix 
information of sample in the report and the associated Settings 
option will be available for user. User can click it and select to display 
height Spillover Matrix information by checking Height Spillover 
Matrix after Unmixing, or display area Spillover Matrix information by 
checking Area Spillover Matrix after Unmixing in the report. This 
information will only be included in the report when user selects 
Spectral Unmixing to deconvolute the data. 

 

o Photodetector Gain: If selected, shows photodetector gain 
information in the report.  

o Compensation:  If selected, shows compensation information in  
report and the associated Settings option will be available for user. 
User can click it and select to display Height parameter-based 
Spillover Matrix information by checking Height Spillover Matrix, or 
display Area parameter-based Spillover Matrix information by 
checking Area Spillover Matrix in the report. This information will only 
be included in the report when user selects Compensation to analyze 
the data. 

 

o Plate Information: If selected, shows plate information. This option is 
available only when NovoSampler S is connected. 

o Insert Page Break Before Each Sample: Only available for specimen 
report. If selected, a page break will be inserted before each sample. 

o Show Statistics Columns: Selects statistical items to display. 
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• Other: Allows user to define the distance filter and laser power settings for 
new samples. Only user logged in with associated privilege can edit this panel. 

  

 Distance Filter Setting: Allows user to define the distance filter related 
setting for new samples. Only user logged in with privilege of Adjust 
Distance Filter Setting can edit this setting. By default, 6 µs is selected as 
the default value. User can set it in the range of 0-12 µs. 

 Laser Power Setting for New Samples: Allows user to define the laser 
power setting for new samples. Only user logged in with privilege of 
Adjust Laser Power Setting can edit this setting. 
To set the laser power, user can either directly enter the power percentage 
(i.e., 20%-100%) or select one from drop down menu of the associated 
laser. By default, 100 (i.e., 100% of laser power) is selected. 
When Apply Changes to All Lasers option is checked, any changes to the 
power setting of a laser will be automatically applied to other remaining 
lasers. 
 



Use NovoExpress (Opteon) Software 
 
 

NovoExpress (Opteon) Software Guide 135 

NOTE When user creates a new sample from template, the laser power will be 
automatically set to be same as the one from the template. Otherwise, the laser 
setting defined in this panel will be automatically applied to any newly created 
sample (s). 

• Security: Allows user to define security related settings(i.e., customizing login 
and password options for all user account). Only user logged in as 
Administrator can edit this panel. 

 

Following functions are included in Security panel. 
 Lock User Account After: when checked, user can enter the number of 

allowed failed login attempts in the box below this area. Once enabled, if 
user entered incorrect password during account login or unlock after more 
than the selected number of attempts are tried, the account will be locked 
out and following window will be prompted as shown in figure below. User 
needs to click OK and log in as Administrator to unlock this account.   
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 Lock Out Session After: when checked, user can enter the number of 
minutes of idle in the box below this area. Once enabled, if there is no 
operation of software from user after selected number of minuets, a 
window as shown below will be prompted indicating the software is 
locked out. User needs to enter the correct password again and click Log 
In to continue operation of the software.   

 

 Password Expires After: when checked, user can enter the total and 
remaining number of days current password remains valid in the box 
below this area. Once enabled, if user does not change the password after 
the selected total number of days, following window will be prompted. 
User needs to click OK, change the password and log in with the new 
password before continue operating the software. 
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If user does not change the password after the selected remaining 
number of days, following window will be prompted to remind user to 
change the password. User can click Yes and change the password in the 
prompted window or click No to continue using the software.  

 

 

 Minimum Password Length: when checked, user can enter the minimum 
number of characters (4 – 32 characters) required for a valid password. 
Once enabled, if user enter any password that contains less characters 
than the one defined in this area, following window will be prompted. User 
needs to click OK to go back to the previous window and revise the 
password. 
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 Forbid to Reuse Password: Remember Last: when checked, user can 
enter the number of password software can remember (i.e., passwords 
user cannot reuse). Once enabled, if user enters a password that is same 
as any password software remembered, and prompt window below. For 
example, if user enter 6 in this area, then the new password user enters 
cannot be same as any one of these 6 remembered passwords. User 
needs to click OK to go back to the previous window and revise the 
password. 

 

 Enforce Complex Password: when checked, a valid password user 
entered must contain characters from three of the following categories. 
Once enabled, any password does not meet the requirement will be invalid 
and following window will be prompted. User needs to click OK to go back 
to the previous window and revise the password. 
o Uppercase letters of European Languages (A to Z with diacritic marks, 

Greek and Cyrillic characters) 
o Lowercase letters of European Languages (a to z, sharp-s, with 

diacritic marks, Greek and Cyrillic characters) 
o Base 10 digits (0-9) 
o Non-alphanumeric characters 
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 Change Password After First-Time Login or Password Reset: when 
checked and enabled, following window will be prompted after user logs 
into the software for the first time or resets the password. User needs to 
click OK and change the password in the next prompted window as shown 
below.  

 

 

Fluorochrome Library 

When user clicks Setting > Library > Fluorochrome from the software Menu Bar, 
the Fluorochrome Library window will be prompted. NovoExpress (Opteon) 
software includes a broad selection of fluorochromes available in the 
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Fluorochrome Library already (software default library). User can view, add and 
edit fluorochromes in the library in this window.  

 

  

Following functions are included in Fluorochrome Library window. 
• Instrument: Displays the current instrument model (i.e., NovoCyte Opteon). 
• Optical Configuration: Allows user to view and select the optical configuration 

(e.g., UVBYR). The list of associated fluorochromes will be automatically 
updated accordingly. 

• All Fluorochromes: This panel lists all available fluorochromes stored in the 
library. Each fluorochrome is listed with information of fluorochrome name, 
display name, excitation laser, emission wavelength. To quickly locate the 
desired fluorochrome, user can enter the keyword in the search box, and the 
list below will be automatically updated. 
Following functions are also available in this panel. 
 New: When clicked, following window will be prompted. User can add new 

fluorochrome into the library by entering the fluorochrome name, display 
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name, primary excitation laser, secondary excitation laser, tertiary 
excitation laser, emission wavelength information, and clicking Add in the 
prompted window. 

 

 Edit: Used to edit a selected fluorochrome in the library. First, click a 
fluorochrome to be edited in the list. The Edit button will then be enabled. 
Click the Edit button and following window will be prompted. User can edit 
the selected fluorochrome information in the prompted window, click OK 
to complete the edit. Note only the Display Name can be edited if the 
selected fluorochrome is  in the software default library. 

 

 Delete: Click to delete the selected fluorochrome from the library. Only 
user defined fluorochromes can be deleted. Fluorochrome in the software 
default library cannot be deleted.  

 Reset Selected Fluorochromes to Default: Click to reset the selected 
fluorochrome back to software default library settings. 

 Add to Selected Group: Click to add the selected fluorochrome to 
highlighted group within Fluorochrome Groups panel on the right. 
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• Fluorochrome Groups: This panel lists all available fluorochrome groups 
stored in the library. By default, the fluorochrome in the software default library 
are categorized into default fluorochrome groups based on the primary 
excitation lasers and the characteristics of the fluorochrome. User can add 
new group to the list or edit the groups already defined. Each group is listed 
with information of group name and group description. Following functions 
are available in this panel. 
 New: When clicked, following window will be prompted. User can add new 

fluorochrome group into the library by entering the group name and group 
description and clicking Add in the prompted window. 

 

 Edit: When clicked, following window will be prompted. User can edit the 
selected fluorochrome group information in the prompted window, click 
OK to complete. Note only the Group Description can be edited if the 
selected fluorochrome group is in the software default fluorochrome 
library. 

 

 Delete: Click to delete the selected fluorochrome group. Note the software 
default fluorochrome group cannot be deleted. 

• Fluorochromes in Group XXX: This panel lists all available fluorochromes in 
the selected group in the Fluorochrome Groups panel. Each fluorochrome is 
listed with information of fluorochrome name, display name, excitation laser, 
emission wavelength. User can click Remove to remove the selected 
fluorochrome from the selected group. 

• Import: Click and select fluorochrome file in the prompted window as shown 
below to import the desired fluorochromes into the library. 
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• Export: When clicked, user can select to export all fluorochrome groups, or all 
fluorochromes, or selected fluorochrome group to either XML file or CSV file 
through the associated drop-down menu. 

 

• Reset to Default Library: Restore the library back to software default settings. 
Any user defined fluorochrome and group will be automatically deleted. When 
clicked, following window will be prompted. User can click OK to confirm 
restoring all the settings or click Cancel to cancel the operation. 

 

Reference Spectra Library 

The Reference Spectra Library window allows user to view the Reference Spectra 
stored by software, add the Reference Spectra of Reference Control specimen, 
Unstained Control sample or Single Stained Control sample to the Reference 
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Spectra Library, and import the Reference Spectra from the Reference Spectra 
Library to Reference Control specimen, Unstained Control sample, Single Stained 
Control sample or experiment sample. 

To access this window, user can click Setting > Library > Reference Spectra from 
the software Menu Bar, the Reference Spectra Library window will be prompted. 
User can view and edit Reference Spectra information stored in the library in this 
window. The spectral plot (Height or Area versus channel wavelength) associated 
with selected fluorochrome is displayed in the bottom of this window. User can 
switch between Height and Area through right-clicking menu of the plot. 

 
 

NOTE The Reference Spectra Library is empty under factory initial setting. User needs to 
add the Reference Spectra to the library manually first. Refer to Add Reference 
Spectra to Library in this guide for instructions. 

 

 

  

Following additional functions are included in Reference Spectra Library window. 
• Single Stained: Click to display the Reference Spectra information of Single 

Stained Control sample stored in the library. The information of Name, 
Fluorochrome, Acquisition Time, Laser Config, SN, Display Name, Marker, 
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Control Type, Emission Channel, Reference Spectra, Creation Time, Gain, 
and Notes are listed in tabular format, and the spectra plot of the selected 
fluorochrome will be displayed under the list.  
User can right click the table header to select the information to be displayed.  

 

• Unstained: Click to display the Reference Spectra information of Unstained 
Control sample stored in the library. The information of Name, Acquisition 
Time, Laser Config, SN, Auto Fluorescence, Control Type, Spectra of Main, 
Creation Time, Gain, and Notes are listed in tabular format, and the spectra 
plot of the selected fluorochrome will be displayed under the list.  
User can right click the table header to select the information to be displayed. 
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• Display Standard Reference Spectra only: Check to display only the standard 
Reference Spectra in table below. This option is not available in Unstained 
panel. Note any standard Reference Spectra is marked with * in the front of 
associated fluorochrome. 

 
 

NOTE When multiple Reference Spectra from the same fluorochrome with the same 
marker and control type exist in the Reference Control Library, user can select one 
and define it as Standard Reference Spectra. This provides user with convenience 
of identifying the desired Reference Spectra.  

 

To set standard Reference Spectra, user can right click the row header or the * 
column associated with the selected fluorochrome, click Set as Standard. 
Clicking it again will cancel setting it as standard Reference Spectra. Note only 
one Reference Spectra from the same fluorochrome, marker and control type 
can be defined as standard Reference Spectra.   

 

• Import: Click to import the selected Reference Spectra (ncrs file) into the 
library. 
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NOTE User can only import the reference spectra exported from the library before. All 
exported Reference Spectra are stored as ncrs file. 

 
 

 

• Export: When clicked, user can select to export all Reference Spectra, or part 
of Reference Spectra to a NCRS file in the associated drop-down menu. 

 

To export all Reference Spectra, click All Reference Spectra, select the target 
folder, and click Save. By default, the Reference Spectra will be saved as 
Reference Spectra_YYMMDDHHmm.ncrs. For example, a Reference 
Spectra_2404301035.ncrs file indicates that this file was generated at 10:35 
on April 30, 2024.  

To export part of Reference Spectra, click Part of Reference Spectra, 
additional checkbox column will display in Reference Spectra Library window 
as shown below. User can click OK to confirm and close the prompted 
window, check the checkbox in front of selected Reference Spectra. Click 
Export > Checked Reference Spectra, select the target folder, and click Save. 
By default, the Reference Spectra will be saved as Reference 
Spectra_NovoCyte Opteon_UVBYR_YYMMDDHHmm.ncrs. For example, a 
Reference Spectra_NovoCyte Opteon_UVBYR_2404301035.ncrs file 
indicates that this file was generated on NovoCyte Opteon with optical 
configuration of UVBYR at 10:35 on April 30, 2024. 
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• Delete: Click to delete the selected Reference Spectra from the library. 

Add Reference Spectra to Library  

User can add the Reference Spectra of Reference Control specimen, Unstained 
Control sample or Single Stained Control sample to the Reference Spectra Library 
by following the procedures below. 

 
 

NOTE User cannot add the Reference Spectra of experiment sample to the library. 
 
 

1 Double click Reference Spectra node of an associated Reference Control 
specimen or sample from the Experiment Manager. In the prompted window, 
click Add to Library. 

 
 

NOTE Reference Control Specimen is displayed with icon of in Experiment Manager 
panel. Any sample(s) displayed under the Reference Control Specimen node is 
Reference Control sample (s). 
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Alternatively, user can right click Reference Spectra node of associated 
specimen or sample in Experiment Manager panel and select Add to 
Reference Spectra Library. 
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2 When adding Reference Spectra of Reference Control Specimen, following 
Add to Reference Spectra Library window will be prompted.  

 

This window consists of two sub-panels, i.e., Single Stained and Unstained 
sub-panels. User can click either sub-panel and check the checkbox in front of 
the desired Reference Spectra and click OK to add the spectra into the library. 
Following message will be prompted indicating the spectra is successfully 
added to the library. 

  

Under the situation when the selected Reference Spectra already exist in the 
library, following message will be prompted.  
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User can click Yes to overwrite the existing Reference Spectra or click No to 
cancel the operation. If Repeat the operation for all subsequent identical 
cases is checked, software will apply user’s selection (Yes or No) in this 
window to all other Reference Spectra. 
User can also view the Reference Spectra information of Single Stained 
Control sample or Unstained Control sample in associated sub-panel in the 
tabular format and corresponding spectra density plot below. The information 
listed in Single Stained sub-panel includes Fluorochrome, Acquisition Time, 
Laser Config, SN, Source, Display Name, Marker, Control Type, Emission 
Channel, Reference Spectra, Gain, and Notes. The information listed in 
Unstained sub-panel includes Name, Acquisition Time, Laser Config, SN, 
Source, Auto Fluorescence, Control Type, Spectra of Main, Gain, and Notes. 
User can right click the table header to select the information to be displayed. 

 
User can also enter the keyword in the search box on top of each sub-panel to 
quickly locate the desired Reference Spectra. The table below will 
automatically be updated based on the filtering result. 
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When Display Checked Only is checked, only the checked Reference Spectra 
will be listed in the table below. 

 
 

3 When adding Reference Spectra of individual Single Stained Control or 
Unstained Control Sample to Library, the Add to Reference Spectra Library 
window will not be prompted. Instead, following message will be prompted 
indicating the spectra is successfully added to the library. 

 

Under the situation when the selected Reference Spectra already exist in the 
library, following message will be prompted.  

 

User can click Yes to overwrite the existing Reference Spectra or click No to 
cancel the operation. If Repeat the operation for all subsequent identical 
cases is checked, software will apply user’s selection (Yes or No) in this 
window for future operation, and will not prompt this message window. 

Import Reference Spectra from Library  

In the case of importing the Reference Spectra from the Reference Spectra Library 
to Reference Control specimen, Unstained Control sample, Single Stained Control 
sample or experiment sample is needed, following methods can be used.  
• Double click Reference Spectra node of associated specimen or sample from 

the Experiment Manager panel. In prompted window, select Spectral Plot or 
Spectral Data tab, click Import from Library. 
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• Right click Reference Spectra node in Experiment Manager panel. For 
Reference Control specimen or Reference Control sample, select Import 
Reference Spectra from Library. For experiment sample, select Import > 
Import Reference Spectra from Library. 
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When user clicks Import Reference Spectra from Library, following window will be 
prompted.  

 

Following functions or information are included in Import Reference Spectra from 
Library window. 
• Only display Reference Spectra with the same Gain setting as XXX: When 

checked, only the Reference Spectra in library with the same gain as the 
selected specimen (or sample) will be displayed and available for user 
selection. 

• Only display Reference Spectra of the fluorochrome in XXX: When checked, 
only the Reference Spectra in library from the fluorochrome contained in the 
Reference Control specimen (or experiment sample) will be displayed and 
available for user selection. This option is not available when importing the 
Reference Spectra to Unstained Control sample. 
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• Reference Spectra in Library: This panel will display the Reference Spectra in 
library based on user selection of Only display Reference Spectra with the 
same Gain setting, Only display Reference Spectra of the fluorochrome. This 
panel consists of two sub-panels (i.e., Single Stained and Unstained) when 
importing the Reference Spectra to Reference Control specimen or experiment 
sample. The associated spectra information is displayed in tabular format 
which may vary depending on which sub-panel user selects. Please refer to 
table below for detailed description of each function. 

 

Functions/Terminology Description 

 
Click to view the Reference Spectra information of Single 
Stained Control sample stored in the library in the table 
below, including Fluorochrome, Acquisition Time, Laser 
Config, SN, Display Name, Marker, Control Type, Emission 
Channel, Reference Spectra, Creation Time, Gain, and 
Notes. User can right click the table header to select the 
information to be displayed. This sub-panel is not available 
when importing the Reference Spectra from the library to 
Unstained Control sample. 

  
Click to view the Reference Spectra information of Unstained 
Control sample stored in the library in the table below, 
including Name, Acquisition Time, Laser Config, SN, Auto 
Fluorescence, Control Type, Spectra of Main, Creation Time, 
Gain, and Notes. User can right click the table header to 
select the information to be displayed. This sub-panel is not 
available when importing the Reference Spectra from the 
library to Single Stained Control sample. 

 
When user enters the keyword of the spectra, the table below 
will be automatically updated to display the search result.  

 
Check to display only the standard Reference Spectra in table 
below. This option is not available when Unstained tab is 
selected. 

 
Click to add selected spectra to Reference Control specimen 
or sample panel on the right side. Newly added spectra will be 
displayed in blue font. 

 

• Reference Spectra in XXX: The right side of Import Reference Spectra from 
Library window lists current Reference Spectra associated with selected 
specimen or sample. This panel is displayed in the same structure layout as 
Reference Spectra in Library panel. Please refer to table below for description 
of each function and parameter included in this panel. 

 

Functions/Terminology Description 

 
Click to view the Reference Spectra information of Single 
Stained Control sample in the table below, including 
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Fluorochrome, Acquisition Time, Laser Config, Source, 
Display Name, Marker, Control Type, Emission Channel, 
Reference Spectra, Gain, and Notes. User can right click the 
table header to select the information to be displayed. This 
sub-panel is available only when importing the Reference 
Spectra from the library to Reference Control specimen or 
Single Stained Control sample. 

  
Click to view the Reference Spectra information of Unstained 
Control sample in the table below, including Name, 
Acquisition Time, Laser Config, Source, Auto Fluorescence, 
Control Type, Spectra of Main, Gain, and Notes. User can 
right click the table header to select the information to be 
displayed. This sub-panel is available only when importing the 
Reference Spectra from the library to Reference Control 
specimen or Unstained Control sample. 

 
Click to remove selected spectra from the library. 

The bottom side of this panel displays the spectral plot of all fluorochrome 
listed in table above when user clicks Single Stained tab, or spectral plot of 
autofluorescence of the unstained user selected when user clicks Unstained 
tab.  

When user clicks to select any fluorochrome from the list in Single Stained 
tab, the associated spectral plot will be bolded automatically. User can also 
click spectral plot of any fluorochrome and associated fluorochrome in the 
table above will be automatically highlighted. As an example shown below, the 
Pacific Blue is highlighted, and the associated spectral plot is bolded (in dark 
brown color).  
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After the Reference Spectra is imported from the library to the Reference Control 
specimen or sample, the Spectra Source tab will be automatically added to the 
Reference Spectra window. The table will display additional Source column 
indicating the source of associated Reference Spectra (e.g., Library, Sample). 
There are two sub-tabs associated with Spectra Source tab, namely Single 
Stained and Unstained. User can view and edit the Reference Spectra in each sub-
tab.  

 
 

NOTE Under the situation when one fluorochrome has both spectra from Reference 
Spectra Library and from sample, user can select either of them for conducting 
Spectral Unmixing, as shown below.  
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4  Sample Acquisition 

This chapter provides the information for sample acquisition function, including 
Cytometer Setting panel, Fluorochrome Setting panel, Sample Keywords, Work 
List and Cytometer Control panel. 

Cytometer Setting/Fluorochrome Setting  

The Cytometer Setting and Fluorochrome Setting panel is displayed in the same 
area in the software. Cytometer Setting panel is displayed by default. User can 
click Fluorochrome Setting to switch to Fluorochrome Setting panel (Refer to 
Fluorochrome Setting for more details).  

Cytometer Setting panel contains the Laser, Parameters, Stop Condition, Flow 
Rate, and Threshold controls. This panel displays the settings of the sample being 
acquired.  
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Laser Control 

There are five checkboxes on the top of the Cytometer Setting panel which allows 
user to select the laser needed for running the experiment.   

 

By default, all the lasers are checked, and all corresponding fluorescence channels 
will be enabled and displayed in the table below. When user unchecks any laser, 
the corresponding fluorescence channels will be automatically disabled (i.e., 
associated Gain, A and H column will be greyed out). The instrument will not 
collect any fluorescence data from unchecked laser. 
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NOTE User cannot edit all or part of laser settings if any of the following is true. 

• When user logs into the software without the privilege of Configure Lasers. 

• When the instrument is in the process of collecting data. 

• When the opened experiment file contains data already acquired. 

• When the instrument is collecting data for one or more Reference Control 
samples, the laser control setting for all the Reference Control samples are not 
available. 

• When any of the threshold setting is set on a fluorescence signal, the 
associated laser cannot be unchecked. 

• When any fluorochrome is added to the Fluorochrome Setting window, the 
associated laser cannot be unchecked.     

Parameters Settings 

The parameters settings specify which parameters are collected during sample 
acquisition. User can view all the parameters that the instrument is capable of 
collecting, select the Height (H) and/or Area (A) parameter to be collected, and 
define the photodetector gain value associated with each channel.  

  

Parameter  

This column displays all the available channels instrument will collect data from. 
User cannot edit this column.  

Gain  

This column displays the photodetector gain values associated with each channel. 
The default gain values are automatically displayed when instrument is properly 
connected and powered up.  
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There are three ways to adjust photodetector gain of selected channel(s). 
 
 

NOTE The photodetector gain adjustment range is 1-1,000 for FSC, and 1-3,000 for BSSC, 
VSSC and all fluorescence channels. 

 
 

NOTE Any change to the photodetector gain of any fluorescence channel of a Reference 
Control sample will be automatically applied to the other Reference Control 
samples in the same Reference Control Specimen. 

 
 

NOTE When data acquisition of at least one of the Reference Control samples completes, 
the photodetector gain of the other fluorescence channels in the same Reference 
Control Specimen cannot be changed. 

 
 

• To adjust photodetector gain of one channel, double click the gain value of 
associated channel, the photodetector gain adjustment tool will show as 
below: 

 

Drag the slider bar or directly enter the target gain value to change the 
photodetector gain. Click the Reset link button to reset back to factory default 
value. If currently logged in user account which does not have Photodetector 
Gain Adjustment privilege, only Reset button will be available. To grant 
Photodetector Gain Adjustment privilege, refer to Access Privilege in this 
guide for more details. 

Every channel has its default photodetector gain setting. An underlined 
photodetector gain value as shown above indicates the photodetector gain 
has been modified from the factory default value. A non-underlined 
photodetector gain indicates that it is the factory default setting.  
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NOTE User can right click the Gain column header and select the Reset All to reset all the 
photodetector gains to the factory default value.  

  
 
 

NOTE The photodetector gain can be changed during sample acquisition. When changing 
photodetector gain during acquisition, the plot will only display events after the gain 
adjustment. Please note the events are not deleted and will be shown on the plots 
when the acquisition is completed. If events acquired before photodetector gain 
adjustment are not needed, click the Restart button to restart the acquisition. Refer 
to Experiment Control in this guide for details. You can also delete the events 
acquired before photodetector gain adjustment after the acquisition is completed 
by using the Delete Events function (refer to Sample in this guide). 

 

• To batch adjust the gain of selected channel(s), user can right click the Gain 
column header and click Batch Set Gain.  

 

In prompted window, select the specific laser (e.g., UV), check Select All XX 
Channels to select all corresponding channels, or check the checkbox in front 
of designated channel, enter the new gain value or click the arrow next to the 
value to increase or decrease the gain value. 
Alternatively, user can check the channels for selected laser, enter the proper 
gain value in Adjust Gains for the Selected XX Channels area, or enter the MFI 
percentage in Adjust MFI for the Selected XX Channels % area, click   to 
increase the gain by entered absolute value or percentile value or click   to 
decrease the gain by entered absolute value or percentile value.  
The displayed gain values in the Parameter panel will be automatically 
updated after above adjustment. 
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User can also click Reset All to reset all gain values to the default ones or click 
Reset Select to reset the gain value of selected channel in this window to the 
default ones. 

 
 
 

NOTE This function is available only when instrument is properly connected and powered 
on, and Photodetector Gain Adjustment privilege is enabled for current user 
account.  

 
 

• To quickly adjust the gain for all the channels of designated laser(s), select All 
or designated laser from drop-down menu of Laser which is located in the 
bottom of the parameter list and enter the gain value in Adjust Gain area, click 

 to increase the gain by entered value or click  to decrease the gain by 
entered value for selected laser(s). 

 
 
 

NOTE This function is available only when Photodetector Gain Adjustment privilege is 
enabled for current user account and when instrument is powered on and properly 
connected.  
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NOTE When NovoExpress (Opteon) is restarted or new blank experiment file is created, 
the photodetector gains will be reset to default value too.  

H and A   

These two columns display all the H (height) or A (area) options for associated 
channels. Instrument will collect data from only the checked H (height) or A (area).  

The H (height) of all channels is automatically checked by default and user cannot 
uncheck it.  

The A (area) associated with FSC, BSSC and SSC can be checked or unchecked 
individually by user. When user checks any A (area) associated with a fluorescent 
channel, A (area) checkboxes of all listed fluorescent channels will be 
automatically checked.   

 

NOTE The selection of parameters (Gain, Area and Height) can no longer be modified 
once sample acquisition has started.  

Stop Condition Settings 

The Stop Condition Settings are used to stop sample acquisition after a specific 
set of conditions has been met. The conditions may include number of events 
collected, collection time, and/or collection volume. To enable a condition, check 
the box next to the condition. 

 

• Events: Used to specify the number of events to acquire. Acquisition stops 
when the set number of events has been collected. When the drop-down menu 
is set to Ungated, the acquisition stops after the total number of events 
reaches the set value. If the drop-down menu is set to a gate, the acquisition 
stops after the number of events in the gate reaches the set value. The 
number of events collected can range between 1~30,000,000.  

• Time: Used to stop sample acquisition after a set sample collection time. The 
collection time can be set between 0 and 60 minutes and 0 to 59 seconds. 

• Volume: Used to stop sample acquisition after a set sample volume has been 
analyzed. The sample volume can be set between 5 and 5000 µL. 

Multiple stop conditions can be concurrently set. When multiple stop conditions 
are set, the sample acquisition stops after the first stop condition is met. If no stop 
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conditions are set, the sample acquisition stops after one of the system’s 
maximum limits for events, time, and volume as described is reached.  

 
 

NOTE After sample acquisition has started, stop conditions based on number of events 
can be modified but stop conditions based on time and volume cannot be changed. 

 
 

NOTE The number of events displayed in a plot during sample acquisition can be set in 
Settings. Refer to Setting in this guide for more details. The maximum number of 
events displayed is 50,000 events. 

 
 

NOTE File size can be excessively large if you acquire a large number of events, i.e., 
1,000,000 events. Therefore, it is always important to consider disabling 
unnecessary parameters (Refer to Parameters Settings in this guide) before 
acquisition in order to reduce the file size. If events have already been acquired or 
collected, you can delete events (Refer to Sample in this guide) to discard parts of 
unnecessary events in the sample. 

 
 

Flow Rate Settings 

There are three standard settings for flow rate including Slow (14 µL/min), 
Medium (35 µL/min), and Fast (66 µL/min). In addition, custom flow rates can be 
set using the slider bar. Sample flow rates can range between 5~120µL/min. The 
bottom of the panel includes information on the current sample’s flow rate and the 
corresponding core diameter. 

  

Threshold Settings 

The threshold settings determine which events are recorded during sample 
acquisition. Only events that exceed the set threshold values are recorded. 
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To set the threshold: 

For sample acquisition, the primary threshold can be set on either FSC or SSC 
height, or a fluorescence signal height. If desired, a secondary threshold can also 
be set on the height of a second parameter. The Storage Gate is used to filter out 
events outside the gate. All events exceeding the primary and secondary threshold 
will be recorded when Storage Gate is set to Ungated. Threshold values can range 
from 10 to 500,000,000. 

To adjust threshold value on plot from Raw Workspace, first click the Adjust on 
Plot link button in the Threshold window or the Adjust Threshold tool  in the 
workspace toolbar. Then move the cursor to the target position on a plot with 
either primary, secondary or both thresholds set as displayed axis parameter. As 
shown below, the right edge of the dark gray area is the current threshold value 
and the right edge of the light gray area is the target threshold value to be set. Left-
clicking the cursor sets the threshold value to the new value which is shown on the 
lower left corner.  

 
 

NOTE Threshold channels cannot be changed after data acquisition begins. Threshold 
values and Storage Gate can be changed during acquisition, but the events already 
acquired will not be processed. When changing threshold values during acquisition, 
the plot will only show events after threshold adjustment. Please note the events 
are not deleted and will be shown when the acquisition is completed. If previous 
events are not wanted, click the Restart button to restart the acquisition. Refer to 
Experiment Control in this guide for more details. You can also delete the previous 
events after the acquisition is completed by using the Delete Events function (refer 
to Sample in this guide). 
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Fluorochrome Setting 

The Fluorochrome Setting panel allows user to view and edit the information of 
the selected fluorochromes for current sample. User can click Fluorochrome 
Setting from Cytometer Setting panel, or double click Fluorochrome Setting node 
from Experiment Manager to access this panel.  

This panel will display different information when user selects spectral unmixing or 
compensation to analyze data. 

 
Fluorochrome Setting Panel when Unmixing is selected. 
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Fluorochrome Setting Panel when Compensation is selected. 

Following functions or information are included in Fluorochrome Setting window. 
• Unstained Control:  Allows user to select the Unstained Control in the 

associated drop-down menu. The auto fluorescence signal associated with 
selected Unstained Control will be listed below and Reference Spectra will be 
displayed next to the drop-down menu. Any checked auto fluorescence signal 
will be used for unmixing. This option is available only when user selects 
unmixing to analyze data. 

• Parameter:  Shows the parameter name of the associated fluorochrome. If the 
display name exists, the software will automatically use the marker name 
combined with display name as parameter name. If the display name does not 
exist, the software will name the parameter as marker name plus 
fluorochrome name. For example, if the marker name is CD25, and the 
Fluorochrome name is BV421, then the parameter is named as CD25 BV421. 
User cannot edit this area. 

• Emission Channel:  Shows the excitation laser type and emission wavelength 
of the selected fluorochrome. For example, V424 means the excitation laser is 
405 nm (violet) and emission wavelength is 424 nm. User cannot edit this area 
if associated reference spectrum has been defined by software. This 
information is displayed only when user selects unmixing to analyze data. 

• Reference Spectra:  Shows the available Reference Spectra plot of the 
selected fluorochrome. User cannot edit this area. This information is 
displayed only when user selects unmixing to analyze data. 
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• Fluorochrome:  Shows the name of the selected fluorochrome. User cannot 
edit this area. 

• Display Name:  Shows the display name of the selected fluorochrome. User 
can double click the cell to edit the name.  

• Marker:  Shows the marker name of the selected fluorochrome. User can 
double click the cell to edit it. 

• Virtual Filter:  Shows the information of Virtual Filter associated with selected 
fluorochrome. User can click the cell to select the Virtual Filter. This 
information is displayed only when user selects compensation to analyze 
data. 

• Edit:  Allows user to edit the fluorochrome settings for current sample. When 
clicked, following window will be prompted. This function is not available when 
Reference Control sample (i.e., Unstained or Single Stained control sample) is 
selected as active sample. 

 

  

Following functions or information are included in Edit Fluorochrome window. 
 Instrument:  Displays the instrument information of currently connected 

instrument if no sample data have been collected or displays the 
information of the instrument which was used to acquire the data. User 
cannot edit this part.  

 Optical Configuration:  Displays the optical configuration of currently 
connected instrument if no sample data have been collected or displays 
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the optical configuration of the instrument which was used to acquire the 
data. User cannot edit this part. 

 Fluorochrome Groups:  This panel displays all available fluorochrome 
groups currently defined in Fluorochromes Library. When user click Add, 
all fluorochromes associated with selected group will be added into 
Selected Fluorochromes panel located on the right side of Edit 
Fluorochrome window. 

 Fluorochrome in Group XXX:  Displays all fluorochromes included in the 
group user selected in Fluorochrome Groups panel. When user click Add, 
the selected fluorochrome(s) will be added into Selected Fluorochromes 
panel located on the right side of Edit Fluorochrome window. 

 Selected Fluorochromes:  Click this tab to display current fluorochromes 
associated with selected sample. User can click Delete to delete the 
selected fluorochrome. User cannot edit the Parameter and Fluorochrome 
column. When there is no Reference Spectra associated with selected 
fluorochrome, the Emission Channel information of associated 
fluorochrome can be edited by double clicking the cell and entering the 
new value. Otherwise, the Emission Channel information cannot be edited. 
The Display Name and Marker information of all displayed fluorochromes 
can be edited by double clicking the cell and entering the new value. 

 Unstained Control:  This tab is only available when unmixing is selected 
for data analysis. When clicked, it will display autofluorescence 
information associated with Unstained Control sample. User can click 
Delete to delete the selected fluorochrome.  
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 Reset:  Click to reset all the settings to default. 
• Apply:  Click to apply any changes to the Fluorochrome Setting panel and the 

unmixing result will be automatically updated. This function is only available 
when there are any changes to the information in Fluorochrome Setting 
window.   

Sample Keywords 

Before starting the experiment or after the sample acquisition, user can create, edit 
and export keywords of selected sample(s).  

Edit Keywords Window 

Most keywords associated functions can be accessed through Edit Keywords 
window as shown below.  

  

To open the Edit Keywords window, use one of the following methods: 
• From Experiment Manager panel: Select experiment file, group(s), 

specimen(s), or sample(s). Right click the selected item(s) and click Edit 
Keywords in the right click menu. 

 
 

NOTE To select more than one group, specimen or sample, press Ctrl or Shift key while 
clicking each item. 
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• From Work List window: Click Home > Experiment > Work List to open the 
Work List window. Open the Edit Keywords window with one of the methods 
below: 
 Click  from the toolbar. Keywords associated with all samples will be 

listed in prompted Edit Keywords window. 

  

 Highlight the row(s) associated with selected sample(s). Right click and 
select Edit Keywords from the right-click menu. Keywords associated with 
the selected sample (s) will be listed in prompted Edit Keywords window. 



Sample Acquisition 
 
 

NovoExpress (Opteon) Software Guide 174 

  

• From Plate Manager panel: Right click the selected well(s) and click Edit 
Keywords. This function is available only when NovoSampler S is connected. 

 
 

NOTE To select more than one well, press Ctrl or Shift key while clicking each well in the 
Well Map. 
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Edit Keywords window includes the following toolbars. 

 

Icon Description 

 
Save: Save the changes to the current keywords list. This function is disabled (i.e., 
greyed out) when there is no change to the current list. 

 
Create Keywords: When clicked, following window will be prompted. User can create 
new keywords or add existing keywords from Keyword Library to the samples. Please 
refer to Create Keywords in this guide for details. 
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Statistical Keywords: When clicked, following window will be prompted. User can add 
selected statistics from statistical table as a new keyword in Edit Keywords window. 
Please refer to Add Statistics as Keywords in this guide for details. 
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Read Keywords: When clicked, following window will be prompted. User can read and 
add selected FCS Standard Keywords or User-Defined Keywords into Edit Keywords 
window. Please refer to Read Keywords from Sample in this guide for more details. 

  

 
Delete Keywords: When clicked, the selected  keyword column in Edit Keywords 
window will be deleted. 

 
Export CSV File: When clicked, following window will be prompted. User can export the 
keywords to a CSV file. In the prompted window as shown below, select the target 
folder and edit the file name, and click Save to export the keywords listed in Edit 
Keywords window as a CSV file in designated folder. By default, the exported CSV file 
will be saved in the folder where the experiment file is stored (e.g., D:\NovoExpress 
(Opteon) Data) in format of Experiment File Name_Keywords_YYMMDD.CSV. 
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Create Keywords 

User can create new keywords or add existing keywords from Keyword Library to 
the samples in Edit Keywords window. To do this, click   from the toolbar in Edit 
Keywords window to open the Create Keywords window as shown below. 

 

This window consists of two panels.  
• The top panel is the Keywords Library which lists all keywords available in the 

Keywords Library. Keywords Library serves as a convenient way to save the 
commonly used keywords to be able to add to samples quickly.  
To add keyword(s) from the Keywords Library to the selected samples, select 
the checkbox in front of one or more keywords from the list, click Add to 
Samples. The selected keyword(s) will show up as column(s) in the Edit 
Keywords window.  
User can also add specific keyword(s) to the Keywords Library or remove 
specific keyword(s) from the Keywords Library. To add keyword(s) to 
Keywords Library, please refer to the method described below.  
To remove keywords, select the checkbox in front of one or more keywords 
from the list in Keywords Library, and click Remove.  
Click OK in the bottom will close the Create Keywords window.  
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NOTE If the selected keyword already exists in Edit Keywords window, when user clicks 
Add to Samples, following window will be prompted indicating the selected 
keywords cannot be added.  

 
  

• The bottom panel allows user to create new keywords in the selected format 
and add to Edit Keywords window or Keyword Library. To do this, enter the 
newly defined keyword in New Keywords field, enter associated notes in 
Notes field if needed, select the prefix of the new keyword, click Add to 
Samples to add the new keyword to Edit Keywords window, or click Add to 
Keywords Library to add the new keyword to the Keyword Library. By default, 
the newly created keyword does not come with a prefix (i.e., No Prefix option 
in Prefix field is automatically selected). User can add prefix of @ or # to the 
new keyword by selecting the associated option in Prefix field. After creating 
the new keyword, user can click OK in the bottom to close the Create 
Keywords window.  
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NOTE If the new keyword already exists in Edit Keywords window, when user clicks Add 
to Samples, following window will be prompted indicating the key word cannot be 
added.  

 
 
 

NOTE If the new keyword already exists in Keywords Library, when user clicks Add to 
Keywords Library, following window will be prompted indicating the keyword 
cannot be added. 

 
  

Add Statistics as Keywords 

User can add statistics from Statistical Table as new keywords in Edit Keywords 
window. To do this, click   from the toolbar in Edit Keywords window to open 
the Statistical Keywords window as shown below. 
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Select the checkbox in front of one or more statistics from the list, click Apply to 
add the selected statistics as new keyword(s) to Edit Keywords window. 

 
 

NOTE If there is no default type statistical table created for the selected experiment file, no 
statistics will be displayed in this window. 

 
 

NOTE If there is more than one default type statistical table created for selected experiment 
file, the associated statistics will be displayed in groups respectively in this window. 

 
 

NOTE If the name of statistics is different from associated keyword name, the keyword 
name will be displayed in Edit Keywords window when user clicks Apply. If there is 
no keyword name associated with corresponding statistics, the name of statistics 
will be displayed in Edit Keywords window when user clicks Apply. 
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NOTE If more than one statistical parameters with the same name are selected, when 
user clicks Apply, following window will be prompted. User needs to click OK to 
cancel the operation, rename the statistics before clicking Apply again. 

 
  
 

NOTE If the name of statistics already exists in Edit Keywords window, when user 
clicks Apply, following window will be prompted indicating the keyword cannot 
be added.  

 
  
 

Read Keywords from Sample 

User can read FCS Standard Keywords or User-Defined Keywords from selected 
samples in Edit Keywords window. To do this, click   from the toolbar in Edit 
Keywords window to open the Read Keywords window as shown below. 
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Select FCS Standard Keywords or User-Defined Keywords to display the 
corresponding keywords from the selected sample. Check the checkbox in front of 
selected keyword(s), click OK. The selected keyword(s) will be added to the Edit 
Keywords window. 

Rename and Edit Keywords  

User can rename Statistical Keywords and User-Defined Keywords in Edit 
Keywords window. To do this, right click the keyword name, click Rename, enter 
the new name, click OK.  
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User can also edit the value of User-Defined Keywords in Edit Keywords window 
by double clicking the associated cell and entering the new value. 

 
 

NOTE The User-Defined Keywords can also be edited in Work List. Please refer to Edit 
Keywords in Work List in this guide for more details.  

 
 

Work List 

Before starting the experiment, the Work List can be used to set up the sample list. 
The Work List allows users to create new specimens and samples, import 
specimens or samples from a template, duplicate specimens or samples, and 
copy and paste sample information. Alternatively, user can perform above 
operation through Experiment Manager (Refer to Experiment Manager in this 
guide for). 

The Work List displays all created specimens and associated samples. User can 
view the specimen name, specimen ID, template, sample type, sample name, laser 
config, acquisition parameters, stop conditions, threshold settings, compensation 
settings, and analysis and report information, etc. 
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When NovoSampler S is not connected 

When NovoSampler S is connected, there are three additional icons  
shown on the menu bar. The created Work List will also include the Plate ID and 
Well ID columns. The other functions remain the same.  

  
When NovoSampler S is connected 

Icon  Description  

 
Apply Modification: Click this button to save the changes made to the Work List. After 
applying the modification, the Experiment Manager panel updates to reflect the changes. 

 
Import Sample from Template: Click this button to import a new sample to the work list 
with selected template.  User needs to select the template file to open. The template of the 
first sample in the file gets imported to the Work List. 

 
Import Specimen from Template: Click this button to import a new specimen to the work 
list with selected template. User needs to select the template file to open. The template of 
the first specimen in the file gets imported to the Work List. 

 
Duplicate as Sample: Click this button to duplicate selected sample as new sample and 
add to the Work List. Refer to Create a Duplicate Specimen or Sample in this guide for more 
details. 

 
Duplicate as Specimen: Click this button to duplicate selected specimen as new specimen 
and add to the Work List. Refer to Create a Duplicate Specimen or Sample in this guide for 
more details. 

 
 

Well ID Setting Direction: This function is only available when NovoSampler S is used. 
When new samples are created in the Work List, the Well ID will be assigned sequentially. 
Use the Well ID Setting Direction button  in the Work List window to set whether new 
samples are created in a row-by-row sequence or a column-by-column sequence for a plate. 

 
 

Automatic Setting Well ID: This function is only available when NovoSampler S is used. 
When selected, a blue outline will show on the icon. When Well ID of a sample is modified 
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manually, the NovoExpress (Opteon) Software will automatically assign new Well ID for 
blank samples below that sample in an order set in the Well ID Setting Direction based on 
the plate type information. 

 
 

Plate View: This function is only available when NovoSampler S is used. Click this icon 
opens the Plate View window. Plate View window is read only and is used to view the 
sample information for each well on a plate view.  
The Plate drop-down menu lists the Plate ID for all the created plates. Select a Plate ID 
from the drop-down menu and view the sample information for this plate. Check the Show 
Specimen Name checkbox to enable the specimen name associated with each well to be 
shown. Check the Display sample has data checkbox to also show samples which have 
collected data. 

 

  
Edit Fluorochromes: Click to open Fluorochrome Setting window. This option is available 
only when experiment sample is selected. Please refer to Fluorochrome Setting in this guide 
for more details. 

 
Edit Keywords: Click to open Edit Keywords window. Please refer to Edit Keywords Window 
in this guide for more details. 

 
Hide Samples Containing Events: Click to hide the samples that contain events. 

 
Hide Photodetector Gain: Click to hide the photodetector gain value in parameters 
columns. 

 
Display Column: Click to select to display or hide the Keywords, Fluorochromes 
Parameters, Enabled Channel Parameters column. 

 
 
 

NOTE The Plate ID and Well ID in the Work List can be modified to assign Plate ID and 
Well ID for the samples. 
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NOTE When collecting repeats from a sample well is desired, multiple samples can be 
assigned to the same Well ID. 

Open the Work List 

The Work List can be opened using two methods: 
• From the Experiment Manager or Plate Manager panel, click the Work List 

icon at the top of the window. 

 

• From the Home tab in the Menu Bar, click on the Work List icon  in the 
Experiment group. 

Work List Management 

Insert a New Specimen or Sample 

To create a new specimen or sample, highlight to select a sample row and right 
click. Click Insert Specimen to create a new specimen or click Insert Sample to 
create a new sample. The new sample will be placed in the selected row and under 
the corresponding specimen for that row.  
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Copy and Insert the Copied Specimen or Sample 

Pertaining to copying and inserting of specimens or samples: 
1 To select the specimens or samples for copying, click and drag in the first 

column of the Work List. The selected rows become highlighted.  
2 To copy the selected specimens or samples, right click and select Copy or use 

the keyboard shortcut Ctrl C. A dash line borders the copied rows. 
3 To insert the copied samples, right click and select Insert Copied Samples. 

The samples are inserted at the selected location. Select Insert Copied 
Specimens or use the keyboard shortcut Ctrl + V to insert the specimens at 
the selected location. 
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Delete Specimen or Sample 

Pertaining to deleting of specimens or samples: 
1 To select the specimens or samples for deleting, click and drag in the first 

column of the Work List. The selected rows become highlighted. 
2 To delete the selected specimens or samples, right click and select Delete or 

press the Delete key on the keyboard. 

Import a Specimen or Sample from a Template 
• To import a specimen from a template: 

In the Work List window, click on the Import Specimen from Template icon 
 , from the toolbar at the top of the window and select the template file to 

open. The template of the first specimen in the file gets imported to the Work 
List.  

• To import a sample from a template: 

In the Work List window, click on the Import Sample from Template icon  , 
from the toolbar at the top of the window and select the template file to open. 
The template of the first sample in the file gets imported to the Work List.  
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NOTE When importing or exporting sample template or specimen template, only the User-
Defined Keywords will be automatically included. 

 
 

Create a Duplicate Specimen or Sample 

To duplicate a specimen or sample: 
1 To select the specimens or samples for duplicating, click and drag in the first 

column of the Work List. The selected rows become highlighted. 

2 After selecting the samples, click the Duplicate as Sample icon  , to 
duplicate the samples and add them under the last specimen of the Work List. 

Or, after selecting the specimens, click the Duplicate as Specimen icon  , to 
duplicate the specimens and create them as new specimens. 

Edit a Work List Cell 

Edit Specimen, Specimen ID and Sample Names 

To modify a specimen, specimen ID or sample cell, double-click on the cell in the 
Work List. Enter the new value and press Enter key. 

 

When a sample name is entered into an empty specimen, a new sample is created 
after Enter key is pressed. 

When a specimen, specimen ID, or template is entered into in an empty row, a new 
specimen is created after the edit is done. 

Edit Fluorochrome Parameters 

To modify a fluorochrome parameter for experiment sample, double click on the 
cell of selected fluorochrome in the Work List. In the prompted menu, enter the 
new value for Display Name, Marker and press Enter key.  

The Emission Channel value cannot be edited when it has Reference Spectra. The 
fluorochrome parameter for Reference Control sample cannot be edited.  

User can also check or uncheck the checkbox to select whether to include 
associated fluorochrome into the spectral unmixing calculation.  
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Unmixing with Auto Fluorescence 

When user selects to display Fluorochromes Parameters in the Work List, the 
cells associated with auto fluorescence will be displayed with checkbox. These 
checkboxes are checked by default and associated auto fluorescence will be 
automatically included into the spectral unmixing calculation. User can uncheck 
the checkbox(es) to exclude the associated auto fluorescence from the spectral 
unmixing calculation. 

Edit Template 

To modify a template for regular sample, double-click on the Template cell in the 
Work List. After a new template is selected, the template is applied into the current 
specimen. Refer to Templates in this guide for additional details. The template for 
Reference Control specimen cannot be edited. 
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To edit template in an empty row, the template’s first specimen would be imported 
into Work List after the edit is done. 

Edit Acquisition Parameters 

To modify the acquisition parameters, double-click on the channel cell to enter edit 
mode. In this mode, the height and area measurements can be enabled or 
disabled. 

 

Edit Stop Conditions, Sample Flow Rates, and Threshold Settings 

To set the sample stop conditions for newly created sample, double-click the stop 
condition cell to enter edit mode. 
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To set the sample flow rate for new sample, double-click the flow rate cell to enter 
edit mode. 

 

To set the sample threshold for new sample, double-click the threshold cell to 
enter edit mode. 

 
 
 

Edit Keywords in Work List 

User can only view and edit the User-Defined Keywords in Work List.  

To edit a User-Defined Keyword, double click the associated cell and enter the 
new value. Statistical Keywords and FCS Standard Keywords will not be visible 
from Work List. 

Copy and Paste Cells 

Pertaining to copying and pasting cells between samples: 
1 To select the cells for copying, click and drag in the Work List. The selected 

cells become highlighted. 
2 To copy the selected cells, right-click and select Copy or use the keyboard 

shortcut Ctrl C. A dashed line borders the copied cells. 
3 To paste the selected cells, select the target cells and right click and select 

Paste or use the keyboard shortcut Ctrl V. The target cells location must have 
matching columns. After pasting, a green background in the cells indicates 
that the pasting was successful. 
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NOTE You can copy sample names in a column from a spreadsheet program like 
Microsoft Excel, then select sample cells of multiple rows in Work List and press 
Ctrl V to paste them into Work List. 

 
 

Cytometer Control 

The Cytometer Control panel contains the Active Sample Information and the 
Experiment Control panel. The Experiment Control panel displays additional 
buttons when NovoSampler S is connected. 
• When NovoSampler S is not connected 

 

• When NovoSampler S is connected 
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Active Sample Information 

In the Experiment Manager panel, the active sample is indicated by the white 
arrow. The active sample can be switched by double-clicking on a new sample or 
by using the keyboard shortcuts Ctrl + and Ctrl – to switch to the next and 
previous sample, respectively.  

In the Active Sample Information panel, the number of events collected, the 
average events collected per second, the collected volume, and the collection time 
are displayed. During sample acquisition, this information is updated in real-time. 

 

The current sample information box at the bottom of the panel displays the 
sample name of the current sample. When NovoSampler S is connected, the 
sample Well ID is also displayed. To rename the sample or change Well ID from 
this box, double-click the name to enter edit mode. The specimen name cannot be 
edited from this box. 

  

Experiment Control 

The Experiment Control panel displays different functions depending on whether 
the instrument is connected to NovoSampler S. 
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When NovoSampler S is not connected 

The Experiment Control panel includes the Next Sample and the Run buttons. 
• Next Sample 

The Next Sample button can be used to switch the active sample to the next 
sample in the Experiment Manager panel. If the active sample is the last 
sample in the Experiment Manager, clicking the Next Sample button creates a 
new sample. The new sample has the same template as the previous sample 
with the same Cytometer Setting, Fluorochrome Setting, Reference Spectra, 
Report and Analysis. 

 

To create a new sample without the template settings, click on the arrow on 
the right side of the Next Sample button and select Without Template. The 
new sample contains the same Cytometer Settings as the previous samples, 
but Fluorochrome Setting, Reference Spectra, Report and Analysis settings 
are not transferred. 

 

• Run 

The Run button is used to begin sample acquisition. 

If the active sample does not contain event data, the Run button appears with 
a solid triangle. Click the Run button to begin sample acquisition. 

 

If the active sample already contains event data, the Run button appears with 
a striped triangle. 
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Clicking the Run button causes a dialog window to appear. Click Append to 
add additional events to the existing events. Click Overwrite to delete the 
existing events and collect new events. If the “Keep fixed time gap when 
appending sample events for Calcium Flux Assay” function is enabled in the 
Experiment Setting window, the checkbox in front of the “Keep time gap fixed 
for Calcium Flux Assay” will be automatically selected. 

 

• Restart 

The Restart button is used to restart sample acquisition while sample 
acquisition is in process and the previously acquired events are desired to be 
deleted. Restart button is particularly useful when user wants to adjust the 
photodetector gain or threshold first to a proper value and then collect the 
data. 

When Restart is clicked, the previously acquired events will be deleted and the 
acquisition status including sampling volume and sampling time will be reset 
to zero. Then the sample acquisition will restart until one of the defined stop 
conditions is met. The Restart button is only visible after acquisition has 
started. 

 
 
 

NOTE The Run button is only available when the instrument status is Ready. The Run 
button is not available when the instrument is not connected, when the instrument 
is powered off, when there is an instrument error, or during the initialization, 
shutting down, and reagent maintenance sequences. 
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During sample acquisition, the Run button switches into a Stop button. Click 
the Stop button to manually stop the acquisition. 

 

• Rinse after sampling: check to enable SIP rinse function after each sample 
acquisition. 

• Absolute Count: check to enable sample collection in Absolute Count mode. 
 

• Recover Remaining Samples: check to enable recover remaining sample 
already aspirated into the sampling tubing but not used for acquisition back 
into the sample tube. The Sample Injection Probe (SIP) will move down after 
sample acquisition to return any remaining samples back to the sample tube 
(if tube holder is used) or plate well (if NovoSampler S is used). 

 
 

 Do not remove the sample tube, tube rack or microwell plate to prevent spill of the 
sample. Ensure the moving path of SIP is not blocked by any obstacles. 

 
 

When NovoSampler S is connected 

The Experiment Control panel includes the Next Sample, Run Single Well, Mix 
Sample and Run Plate buttons. 

 

• Next Sample:  Click this button to switch the active sample to the next sample 
in the Experiment Manager panel. If the active sample is the last sample in the 
Experiment Manager, clicking the Next Sample button creates a new sample. 
The new sample has the same template as the previous sample with the same 
Cytometer Setting, Fluorochrome Setting, Reference Spectra, Report and 
Analysis. 
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To create a new sample without the template settings, click on the arrow on 
the right side of the Next Sample button and select Without Template. The 
new sample contains the same Cytometer Setting as the previous samples, 
but Fluorochrome Setting, Reference Spectra, Report and Analysis settings 
are not transferred. 

 

• Run Single Well:  Click this button to run a single well in the plate. 
 
 

NOTE When Run Single Well is selected, the sample will not be mixed before sample 
acquisition. To mix the sample, click the Mix Sample button in the Cytometer 
Control panel. 

 
 
 

NOTE When Run Single Well is selected, the sample injection probe will automatically be 
rinsed after sample acquisition. This SIP rinse function will minimize the carryover 
between samples. 

 
 
 

• Mix Sample:  Click this button to mix the sample in the plate. 
• Run Plate: Click this button to run multiple wells in the plate. 

 
 

NOTE Before acquiring a sample, ensure the sample is the Active Sample and the Well ID 
is correct. In the Experiment Manager panel, double-click a sample node to set the 
sample to be the Active Sample. The active sample will be indicated by a red arrow 
on the left of the sample in the Experiment Manager panel. 

 
 
 

• Shutdown NovoCyte after plate run: When checked, NovoExpress (Opteon) 
can automatically shut down the instrument after plate run is completed. 
When the plate run is completed, NovoExpress (Opteon) will prompt a 60 
second count down message box to confirm whether or not to shut down the 
instrument. The dialog box is shown below. If no action taken after 60 
seconds, NovoExpress (Opteon) will shut down the instrument automatically. 
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NOTE Automatic shutdown function is only effective for Run Plate. Run Single Well will 
not trigger the shutdown process. 

 
 
 

NOTE User can also schedule automatic instrument power on or off at selected time and 
frequency by clicking Schedule Power On & Off from the Operation panel. Please 
refer to Instrument in this guide for more details about this function.   
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5 Data Analysis 

This chapter provides information for data analysis tools, including Plots, Gates, 
Statistics, Spectral Unmixing and Compensation, Cell Cycle Analysis, Cell 
Proliferation Analysis, Statistical Tables, Heat Maps. 

Plots 

The NovoExpress (Opteon) Software includes dot plots, density plots, contour 
plots, histograms, cell cycle plot, cell proliferation plot, spectrum density plot and 
fluorochrome bi-variate plot. 

 

Plot Type Icon Display 
Parameters 

Description Example 

Dot Plot  
 

Two-
parameter 

The intensities of two 
parameters are represented by 
the coordinates of the plot. 
Each point on the plot 
represents at least one event 
with the corresponding 
intensity values. 

  

Density 

 

Two-
parameter 

The intensities of two 
parameters are represented by 
the coordinates of the plot. The 
color of each point represents 
the density, or number of 
events, at the corresponding 
intensity values. 
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Contour 

 

Two-
parameter 

The intensities of two 
parameters are represented by 
the coordinates of the plot. 
Contour lines are drawn to 
represent the density 
distribution of the population. 

 

Histogram 

 

Single-
parameter 

The intensity of a parameter is 
represented along the 
horizontal axis, and the number 
of events at each intensity 
value is represented along the 
vertical axis. 

 

Cell Cycle 
Analysis 

 

Single-
parameter 

DNA content is represented 
along the horizontal axis, and 
the number of events at each 
value is represented along the 
vertical axis. The cell cycle 
fitting algorithm is used to 
separate the population into 
G1, S, and G2 phases of the cell 
cycle. Refer to Cell Cycle 
Analysis in this guide for more 
information. 

 

Cell 
Proliferation 
Analysis  

Single-
parameter 

Cell Proliferation Analysis can 
be used to analyze the samples 
containing cell proliferation 
information and show the 
fitting results. Refer to Cell 
Proliferation Analysis in this 
guide for more information. 

 

Spectrum 
Density Plot  

 

Single-
parameter 

The fluorescence channel(s) of 
selected laser is represented 
along the horizontal axis, and 
the Mean Fluorescence 
Intensity (MFI) value is 
represented along the vertical 
axis. This function is not 
available when Unmixed 
Workspace is selected. Refer 
to Spectrum Density (Dot) Plot 
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in this guide for more 
information. 

Spectrum Dot 
Plot  

Single-
parameter 

The fluorescence channel(s) of 
a selected laser is represented 
along the horizontal axis, and 
the Mean Fluorescence 
Intensity (MFI) value is 
represented along the vertical 
axis. This function is not 
available when the Unmixed 
Workspace is selected. Refer 
to Spectrum Density (Dot) Plot 
in this guide for more 
information. 

 

Fluorochrome 
Bi-variate Plot  

Two-
parameter 

Create a matrix of plots with 
selected fluorescence 
parameters plotted against 
each other. Refer to 
Fluorochrome Bi-Variate Plots 
in this guide for more 
information. 

 

Create a Plot 

In the NovoExpress (Opteon) Software, user can create Dot Plot, Density Plot, 
Histogram Plot, Contour Plot, Spectrum Density Plot, Spectrum Dot Plot in Raw 
Workspace, and create Dot Plot, Density Plot, Histogram Plot, Contour Plot, Cell 
Cycle Plot, Cell Proliferation Plot, Fluorochrome Bi-Variate Plot in Unmixed 
Workspace. Most plots can be created through the workspace toolbar, or the 
Experiment Manager, or the gate of existing plot. The Fluorochrome Bi-Variate 
Plot can only be created through the toolbar. In addition, plots can be duplicated in 
the Workspace, copied in the Experiment Manager, and imported from templates. 

Create a Plot through the Toolbar 

Use the plot buttons in the Workspace toolbars to create new plots. The button will 
create a new plot for the active sample. 
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Create a Plot through the Experiment Manager 

In the Experiment Manager panel, right-click on either the sample or the Analysis 
node under the sample. Select Create Plot and select the plot type.  

 

Create a Plot through a Gate of Existing Plot 

In the Workspace, new plots can be created using gates from previously created 
plots. New plots created through gates will only display events within the gate. 
There are multiple methods for creating a new plot through a gate: 
• Double-Clicking a Gate 

Double-clicking on a selected gate creates a new plot. The new plot has the 
same parameters and plot type as the plot containing the gate. The plot type 
and parameters can then be modified. 

• Selecting a Gate within the Workspace 
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Click on a gate within a plot to select the gate. The gate label is italicized to 
indicate that it is selected. Right-click on the gate and select Create Plot and 
select the plot type. The new plot will have the same parameters as the plot 
containing the gate. The plot parameters can then be modified. 

 

• Selecting a Gate using the Menu Bar 

In the Gate tab of the Menu Bar, a gate can be selected from the drop-down 
menu in the Current Selection group. Click the Create Plot icon in the Apply 
Gate group to select a plot type. 

• Selecting a Gate using the Experiment Manager or Gate Manager 

In the Experiment Manager or Gate Manager panel, right click on a gate 
heading. Select Create Plot and select a plot type. 

Create a Duplicate Plot 

Click a plot in the workspace to select it. To duplicate the selected plot, click the 
Duplicate icon in the Home tab of the Menu Bar or use the keyboard shortcut Ctrl 
D. The plot type and parameters of the new plot will match the previous plot, but 
the gates will not be replicated. 
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Copy and Past a Plot with the Experiment Manager 

When using this method, the parameters of a plot from one sample can be applied 
to plot the data of a different sample. In the Experiment Manager panel, locate the 
initial plot by expanding the Analysis node under the corresponding sample. Right-
click the plot to be copied and click Copy. Select the Analysis node under the 
sample where the plot will be pasted. Right-click on this Analysis node and click 
Paste. The new plot uses parameters from the copied plot to plot data from the 
new sample. This can also be accomplished by doing a click and drag on the plot 
to be copied and dropping it into the desired sample. 

   
 
 

NOTE If the Analysis node is copied, all of the plots for the sample are included. Pasting 
this to the Analysis node of a new sample replicates all of the plots. Any plots 
currently in the sample are replaced. 

 
 

NOTE Pasting to a specimen node pastes to all of the samples under the specimen. 
 

Import from a Template 

In the Experiment Manager panel, select the Analysis node under the sample 
where the plots are to be imported. Right-click on the Analysis node and click 
Import…. Select the template file to open. Upon selecting, the plots from the first 
sample in the template file are imported into the selected sample.  
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NOTE When importing or exporting sample template or specimen template, only the User-
Defined Keywords will be automatically included. 

Open and Close a Plot Window 

There are multiple methods for opening and closing a plot window. 

To open a plot window: 
• In the Experiment Manager panel, double-click on a plot node or right-click and 

select Open to open the plot. 
• In the Experiment Manager panel, double-click on a gate node or right-click 

and select Open to open the plot containing the gate. 
• In the Experiment Manager panel, right-click and select Open Plots on a 

sample to open all of the plots associated with the sample. 
• In the Experiment Manager panel, right-click and select Open Plots on a 

specimen to open all of the plots associated with the specimen. 
• In the Experiment Manager panel, right-click and select Open Plots on a group 

to open all of the plots associated with the group. 
 

To close a plot window: 
• Click the Minimize button in the top right corner of a plot window to close the 

plot. 
• In the Experiment Manager panel, right-click and select Close Plots on a plot 

to close the plot. 
• In the Experiment Manager panel, right-click and select Close Plots on a 

sample to close all of the plots associated with the sample. 
• In the Experiment Manager panel, right-click and select Close Plots on a 

specimen to close all of the plots associated with the specimen. 
• In the Experiment Manager panel, right-click and select Close Plots on a 

group to close all of the plots associated with the group. 
 
 

NOTE Click the Close button   in the top right corner of a plot window to delete the plot. 
 

Edit Plots 

Plot Gating 

To analyze subpopulations, plots can be set to only display events from within a 
specific gate. For this method, a gate from a previous plot will be applied to a 
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newer plot. The new plot can then be used to analyze the subpopulation or to 
further gate for more specific populations. 

If plots are gated, the gate will be displayed on the header of the plot as shown 
below. The header will display the sample name and the gate. In the example 
below, the sample name is blood and the gate is Lym. 

 

There are multiple methods for gating a plot. These methods include: 
• In the plot header, right-click to display a drop-down menu. In the drop-down 

menu, select the gate. If Ungated is selected, the plot is not gated and all 
events are displayed in the plot.  

 

• Right-click in the plot, select Gating and select the gate. If Ungated is selected, 
the plot is not gated and all events are displayed in the plot. 

• Click on the plot to be gated to select the plot. In the Plot tab of the Menu Bar, 
select the gate in the drop-down menu from the properties group. If Ungated is 
selected, the plot is not gated and all events are displayed in the plot. 

• Select a gate in the Gate tab of the Menu Bar, and click Gating, select the plot 
to be gated. If all following plots are selected, all the plots listed will be gated. 
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• Select a gate in the workspace and drag it into the title of the plot to be gated. 

Parameter Plot Settings 

As shown in the figure below, the plot parameters are labeled next to the axes. 
When user selects Spectral Unmix, Unmix- is automatically added to each plotted 
fluorescent parameter. When user selects Compensation, Comp-is automatically 
added to each plotted fluorescent parameter.  

           
 
 

NOTE User cannot select fluorochrome parameter (e.g., CD3 PerCP-Cy5.5) in Raw 
Workspace. User cannot select fluorescent channel parameter (e.g., UV380) as plot 
parameter in Unmixed Workspace. 

 
 

To change the plot parameters:  

Double click or right-click on the plot label and select the desired parameter. In the 
prompted drop-down menu, the scatter and fluorescent parameters are listed in 
height and area measurements. Additional parameters include Width, the width of 
the individual event signal, Time, the time of the individual event signal, and Count, 
the number of events at a specific parameter. 
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Set Plot Types 

There are two methods for setting or changing the plot type of a plot. 
• Within a plot, right-click and select Plot Type and select the desired type of 

plot. 
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• Click on the plot to be modified to select the plot. In the Plot tab of the Menu 
Bar, click on the Plot Type icon and select the desired type of plot from the 
drop-down menu. 

 
 

NOTE When the plot is switched from a two-parameter type (e.g., dot, density, or contour 
plot) to a single-parameter plot (e.g., histogram), all two-dimensional gates 
(rectangular, ellipse, polygon, and quadrant gates) are deleted. 

 

Rename Plots 

There are three methods for renaming a plot. 
• Click on the plot to be renamed to select the plot. In the Plot tab of the Menu 

Bar, edit the plot name in the Plot Name box. 
• In the Experiment Manager panel, right-click on the plot node and select 

Rename to enter a new name. 
• In the Experiment Manager panel, click the plot node, and type a new name 

directly. 

Delete Plots 

There are multiple methods for deleting a plot. 
• Click the Close button in the top right corner of the plot window to delete the 

plot. 
• In the Experiment Manager panel, right-click on the plot node and select 

Delete to delete the plot. 
• In the Experiment Manager panel, right-click on the sample node or Analysis 

node and select Delete Plots to delete all of the plots associated with the 
sample. 

Set the Coordinates of the Axis 

As shown in the figure below, the coordinates of an axis are labeled next to the 
axis. The axis multiplier is labeled within parentheses in the axis label. 
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Set the Coordinate Range 

By default, the coordinates for each parameter will be shown over a full range. 
During analysis, it may be necessary to reduce the display range to focus on a 
specific population. 

There are multiple methods for changing the coordinate range including zooming, 
the auto range tool, the move tool, and manually entering the coordinate range. 
Select these tools either from workspace toolbar  or plot right-click 
popup mini toolbar. 

  

• Pointer  : When the pointer is selected, maximum or minimum axis value can 
be directly adjusted on the plot. 

Move the cursor to the maximum or minimum position of the X or Y 
coordinate. The cursor will change to  for X coordinate or  for Y 
coordinate. Click and move the cursor to change the maximum or minimum 
value of the corresponding value. Double clicking the arrow will set the axis to 
Auto Range on the corresponding coordinate. 

• Zoom In  : This tool enlarges the display by narrowing the coordinate range.  

There are multiple methods to access this tool. This tool can be activated by 
clicking on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl 
+, or right-clicking on a plot and selecting Zoom In. 

To use the tool, click and drag in a plot over the area to be enlarged. A 
rectangle is drawn, and the range of the rectangle becomes the range of the 
zoomed in plot. 
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NOTE To zoom in only along one parameter, click and drag along the parameter’s 
coordinate label. This method zooms in on the selected parameter, while the 
second parameter’s coordinate range remains unchanged. 

 

• Zoom Out  : This tool compresses the display by widening the coordinate 
range.  

There are multiple methods to access this tool. This tool can be activated by 
clicking on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl 
-, or right-clicking on a plot and selecting Zoom Out. 

To use the tool, click within a plot. The range increases by 20% of the current 
range. Click repeatedly until the desired range is reached. 

 
 

NOTE To zoom out only along one parameter, click on the parameter’s coordinate label. 
This method zooms out on this parameter, while the second parameter’s 
coordinate range remains unchanged. 

 

• Auto Range/Full Range 

Auto Range  : This tool automatically sets the coordinate range based on 
the maximum and minimum values of the data set.  

Full Range  : This tool automatically sets the coordinate range to the 
maximum and minimum values possible for the parameter.  

There are multiple methods to access these tools. These tools can be 
activated by clicking on the icons in the Workspace toolbar, using the 
keyboard shortcuts Ctrl A for Auto Range and Ctrl F for Full Range, or right-
clicking on a plot and selecting Auto Range or Full Range. 

• Move  : This tool allows the user to pan the graph with the coordinate range 
automatically adjusting.  
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There are multiple methods to access this tool. This tool can be activated by 
clicking on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl 
M, or right-clicking on a plot and selecting Move. 

To use this tool, click and drag in a plot to move the display region. The 
coordinate range then automatically adjusts. 

 
 

NOTE To pan the plot only along one parameter, click and drag along the parameter’s 
coordinate label. This method causes the plot to pan along the selected parameter, 
while the second parameter’s coordinate range will remain the same. 

 
 

• Manually Setting the Coordinate Range through the Axis Setting Window 

To access the Axis Setting window, right-click on the coordinate label of a plot 
and select Setting.  

 

The Axis Setting window includes boxes to set the maximum and minimum 
value for both parameters. 
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• Manually Setting the Coordinate Range in the Plot tab of Menu Bar. 

 

Set the Coordinate Scale 

The available coordinate scaling types available in the NovoExpress (Opteon) 
Software include linear, logarithmic, and biexponential. In general, linear scaling is 
used for scatter channels, logarithmic scaling is used for the fluorescent channels, 
and biexponential scaling is used for fluorescent channels where Spillover 
Compensation has resulted in negative values. 

To set the coordinate scaling, right-click on the coordinate label and select the axis 
scaling. 
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The axis scaling can also be set through the Plot tab of the Menu Bar using the 
Scale drop-down menu for each axis. 

Display a Biexponential Plot 

Biexponential display uses biexponential scale to transform data, especially for 
those where cells become piled up in the first decade at the axis. This is displayed 
as fluorescence values <0 even for uncompensated data. Biexponential 
transformation incorporates linear scaling for low values together with log scaling 
for high values. Biexponential scaling gets rid of cells being piled up at axes 
origins, allowing visualization of cells with negative or dim fluorescence. The plots 
below are the result of different scales, left side is with logarithmic scale and right 
is with biexponential scale.  

 

• Below Zero Value of biexponential scale 

Biexponential transformation can be seen as combination of near linear and 
near logarithmic scales. It goes smoothly from near linear within the reflection 
point to the near logarithmic within range further away from the reflection 
point. The width of near linear transformation interval can be changed, which 
is calculated by the Below Zero Value of biexponential scale in NovoExpress 
(Opteon) software. 

Manually enter the Below Zero Value in Axis Setting dialog or click Reset 
button to let NovoExpress (Opteon) software calculate the value 
automatically. When resetting, software calculates the Below Zero Value 
according to the events data in current gating of plot. The minimum value of 
the axis will be automatically set by the linear minimum of biexponential scale, 
which is determined by the current Below Zero Value. 
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Another way to reset the Below Zero Value is to right-click on the coordinate 
label and select the Reset Below Zero Value menu item. 

 

To adjust the Below Zero Value directly on plot, move the cursor to a 
coordinate axis with biexponential scale, a triangular symbol will appear on the 
position of below zero value. Click and drag the triangular symbol to adjust the 
Below Zero Value, and the plot will reflect the change dynamically while 
dragging the triangular symbol. 
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Adjust the Size of Plots 

• Maximizing and restoring a plot window 

Plot windows can be maximized by clicking on the maximize button  , in the 
top right corner of the window or by double-clicking in the plot. To restore the 
plot after maximizing it, either click on the restore button (as shown below) or 
double-click in the plot. 

 

• Resizing all plot windows 

To resize all of the plot windows, use the zoom slider on the right side of the 
Status Bar (as shown below) or the Zoom tool in the View tab of the Menu 
Bar. 

 
 
 

NOTE Adjusting the size of the plot window does not affect the coordinate range of the 
plots. To adjust the coordinate ranges, Refer to Set the Coordinate Range in this 
guide. 

 

Copy or Save Plots 

Plots from the NovoExpress (Opteon) Software can be copied and saved. 
• To copy a plot to the clipboard 
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Right-click in a plot. Select Copy and select the format to copy the plot. Plots 
can also be copied using the Copy button in the Plot tab of the Menu Bar. 
Using the keyboard shortcut Ctrl C to copy the selected plot in bitmap format. 

 

• To save a plot 

Select a plot by clicking on it and click the Save as Image button  from the 
Plot tab of the Menu Bar. The image format can be selected in the Save 
Image window.  

Overlays 

Multiple overlays can be included in dot plots or histogram plots. When a plot is 
created, it only contains the data from one sample. Overlays can display the data 
from multiple samples and gates in one plot with different colors. Below show the 
example of the dot and histogram plots with overlays from different samples. 

 

• Add overlays by using the drag and drop method:  

Hold down the Ctrl key on the keyboard, use the mouse to drag a sample or 
multiple samples to a plot from the Experiment Manager, and the new 
overlays are added to the plot. The gate of new overlay is from the sample of 
the overlay, it always takes the same name as the gate of plot. It will be the All 
gate, if no gate with the name is found in the sample of the overlay. 

• Edit overlays:  
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Right-click a plot to access the shortcut menu, select Edit Overlays to 
generate the Edit Overlays dialog window as shown below. In the dialog, all 
overlays of the plot are listed. One can select an overlay, set the overlay’s 
sample, gate or color, and make a choice to show or hide the selected overlay 
on the plot. Adding new overlays or deleting overlays can also be done here. 
Click Add button to open the Add Overlay window, press Ctrl or Shift key while 
clicking the selected sample (s), click Add or Add & Close in this window to 
add selected sample (s) to the Edit Overlays window. Click Apply and OK to 
complete adding the new overlays to the current plot. 
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• Display Legend:  

When the overlays are added, the legend will automatically appear on the 
overlay. User can move the legend to any location inside the plot by left 
clicking and dragging the legend. To remove the legend from the plot, right-
click the legend and uncheck the Show legend in the menu. 
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Plot Formatting 

Each plot type has different formatting and settings options. This section 
describes the formatting options associated with each plot type. To format a plot, 
right click on a plot window and select corresponding format menu item. 

Dot Plot Formatting 

With dot plots, there is an option to only display the most recently collected events. 
This option allows the user to set a number or percentage of the most recently 
collected events to display. To open the Events Displayed window, right click on 
the dot plot and select Events Displayed…. 
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In the window, selecting Preview modifies the dot plot display as the user is 
changing the settings. Selecting Apply to all open plots applies the setting to all 
open dot plots. 

Density Plot Formatting 

With density plots, there is also an option to only display the most recently 
collected events. Please refer to Dot Plot Formatting for more details. Besides, 
following formatting options are available from the right click menu of density plot.   
• Smooth density plot: In this view, the density plot data are smoothed. To use 

this view, right-click on the density plot and select Smooth or select Smooth 
from the Plot tab of the Menu Bar. A comparison of a standard pseudocolor 
density plot (left) and a smooth pseudocolor density plot (right) is shown 
below.  

 

• Pseudocolor density plot: By default, density plots are displayed in 
pseudocolor. In this view, areas of the plot with a higher density of events are 
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shown in warmer colors (colors toward the right of the color bar below) and 
areas of the plot with a lower density of events are shown in cooler colors 
(colors toward the left of the color bar below). 

 

To switch from a pseudocolor to a gray-scale density plot, right-click on a 
density plot and unselect Pseudocolor or unselect Pseudocolor from the Plot 
tab of the Menu Bar. A comparison of a grayscale density plot (left) and a 
pseudocolor density plot (right) is shown below. 

 

Histogram Plot Formatting 
• Smooth histogram: To smooth the edges of a histogram, right-click on a 

histogram plot and select Smooth or select Smooth from the Plot tab of the 
Menu Bar. A comparison of a standard histogram plot (left) and a smooth 
histogram plot (right) is shown below. 
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• Histogram fill type: Histogram plots can be viewed with different fill types. To 
select a fill type, right-click a histogram plot and select Filling and select the fill 
type or select the fill type from the Filling drop-down menu in the Plot tab of 
the Menu Bar. A comparison of the filling types is shown below. The options 
include None (left), Filled (middle), and Tinted (right). 

 

• Histogram Normalization: When overlaying histogram plots, user can right-
click the histogram plot and select Normalize to normalize the histogram. The 
Y axis value of each point on histogram plot is converted to the percentage of 
its max value. The Y axis of normalized histogram plot changes to percentage 
accordingly. An example of overlayed histogram before the normalization 
(left), and after the normalization (right) is shown below. 

 

• Histogram layering: When overlaying histogram plots, different overlay styles 
can be selected. To select an overlay style, right-click in a histogram plot with 
layers and select Style to select the overlay style. The overlay style options, as 
shown below, include Overlaid (left), Offset (middle), and Half Offset (right). 
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Contour Plot Formatting 

With contour plots, there is also an option to only display the most recently 
collected events. Please refer to Dot Plot Formatting for more details. Besides, 
following formatting options are available from the right click menu of contour 
plot. 
• Contour levels: Different contour levels are available for contour plots. Higher 

contour levels indicate a larger density interval in between contour lines on the 
plot. The available contour levels include 10%, 5%, and 2%. A contour plot is 
shown below with a 10% contour level (left) and a 5% contour level (right). 

 

• Show Outlier: If selected, outlier events are shown as dots on contour plots. A 
contour plot is shown below with Show Outlier selected. 
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Spectrum Density (Dot) Plot Formatting 

With spectrum density (dot) plots, the following formatting options are available 
from the right click menu. 

  

• Events Displayed: Allows user to set the number of events to be displayed in 
the plot in a prompted window. Refer to Plot Formatting for more details on 
this function. 
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• Style: Allows user to select different plot style (i.e., Original or Smooth). A 
spectrum density plot is shown below with Original plot style (left) and a 
Smooth plot style (right). 

 

• Plot Width Setting: Different plot width levels are available for spectrum 
density plots. Higher width levels indicate a wider plot. The available width 
levels can be selected from 1 to 4. A spectrum density plot is shown below 
with a width level of 1 (left) and a width level of 4 (right). 

  

Plot Format 

The Plot Format defines plot appearance. The font, size, style, color, line weight, 
and visibility can be customized. To open the Plot Format window, right click 
inside plot area and select the Format... menu item in the popup menu. 
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• Using Default Format: 

Check this box to set plot using system default format. 
• Objects: 

Select objects that the format is applied to. The objects are listed in tree mode. 
Select parent node will apply to all its child nodes. 

• Font: 

Set font name and font size for the selected objects. 
• Style: 

Set font style for the selected objects. Check button B for bold, button I for 
italic.  

• Default Color: 

Set color for the selected objects. Check Default Color box if the software 
default color is to be used. For gate label on plot or plot title, the default color 
is the color of the gate. For the other objects, the default color is black. 

• Visible: 

Check this box to set the object visible. 
• Line Weight: 

Select line weight of selected objects. 
• Set as Default: 
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Check this box to set the format settings as the default when Apply or OK 
button is clicked. 

• Apply to: 

Select which plot(s) to apply the format settings. 
• Apply: 

Click to apply changes and keep this window open. 
• OK: 

Click to apply changes and close this window. 
• Cancel: 

Click to close this window without applying any changes. 

Default Plot Settings 

To change the default settings for plots, go to File > Options and select the 
Analysis tab. Refer to Setting in this guide for details. 
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Quick Compensation  

The NovoExpress (Opteon) Software’s quick compensation method gives users 
the option to use a slider bar for quick and intuitive adjustment of fluorescence 
Compensation Matrix or Spillover Matrix after unmixing. 

To open the Quick Compensation Adjustment, ensure to work in the Unmixed 
Workspace from the Unmix tab of the Menu Bar, click the Quick Compensation 
button.  

 
 
 

NOTE User can also access the quick compensation function from Fluorochrome Bi-
Variate Plots window. Refer to Fluorochrome Bi-Variate Plots in this guide for 
details. 

 
 

Scrollbars will appear on plot which meets following requirements. 
• Plot created in Unmixed Workspace. 
• Two-parameter plot 
• Plot of fluorescent parameters on both axes 
• Both X-axis and Y-axis are Height or Area parameters  

 

To hide the quick compensation scrollbars, click again on the Quick 
Compensation button. 

Please follow the instructions below to quickly adjust compensation using the 
scroll bar. For illustration purpose, density plot of selected single stained sample is 
used.  
1 Set the X-axis parameter as the sample’s fluorochrome parameter. Set the Y-

axis as the spillover parameter to be corrected. For example, to correct for the 



Data Analysis 
 
 

NovoExpress (Opteon) Software Guide 232 

spillover of CD3 FITC-H into CD4 PerCP-Cy5.5-H, analyze a sample stained 
only with CD3 FITC and use a plot with the X-axis set to CD3 FITC-H and the Y-
axis set to CD4 PerCP-Cy5.5-H. 

2 Create a quadrant gate to gate the positive and negative populations as shown 
below. 

 

3 Drag the vertical scrollbar to adjust compensation. The associated tooltip will 
automatically display the compensation percentage.  
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NOTE When Spectral Unmix is used, there is a triangle symbol automatically displayed in 
both X and Y axis scroll bar as shown below. This triangle symbol indicates where 
the zero spillover (i.e., the value without post unmixing adjustment) is at. User can 
double click this symbol to return to zero spillover state. 

  
 
 

NOTE The spillover value range user can adjust is between is -99% and 99% when 
Spectral Unmix is used, or between 0 and 800 when Compensation is used.  
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NOTE Clicking on the blank area of the scrollbar adjusts the spillover by 0.1% increments 
and clicking on the arrows of the scrollbar adjusts the spillover by 0.01% 
increments. 

 
 

Spectrum Density (Dot) Plot 

Spectrum Density Plot (or Spectrum Dot Plot) can be created in the Raw 
Workspace with Mean Fluorescence Intensity (MFI) from each available 
fluorescence channel displayed in a density plot or dot plot format. 

  

 

When user creates the single stained or unstained Reference Control sample, the 
Spectrum Density Plot for this sample will be automatically created in Raw 
Workspace. For Single Stained Control sample, after the data acquisition, the MFI 
associated with the pre-defined emission channel for the associated 
fluorochromes will be automatically gated for positive and negative populations 
These two gates are synchronized with the ones on associated histogram plot as 
shown below. 

Spectrum Dot Plot 

Spectrum Density Plot 
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• Channels: Displays all the channels in the order of laser wavelength (i.e., UV, V, 
B, Y, R) and emission wavelength (from low to high) by default. User can select 
the channels for designated laser from the right click menu (refer to Right 
Click Menu of Spectrum Density (Dot) Plot in this guide for more details). 

• MFI-H or MFI-A: Displays the value of MFI- A or MFI-H (Default). User can 
switch between MFI-H and MFI-A from the right click menu (refer to Right 
Click Menu of Spectrum Density (Dot) Plot in this guide for more details). 

 
 

NOTE The upper border of the spectrum density (dot) plot is color-banded to indicate 
corresponding excitation laser.  

 
 

Manually Create Spectrum Density (Dot) Plot 

Under the situation when manually creating a spectrum density (dot) plot is 
required (e.g., for experiment sample), user can select Raw Workspace, click the 
associated icon from the workspace toolbar. Alternatively, user can create a new 
spectrum density (dot) plot through the Experiment Manager, or the gate of 
existing plot. Refer to Create a Plot in this guide for more details. 

View Statistical Information  

User can view the statistical information (e.g., CV, Mean, Median) of associated 
channels in tabular format from Spectrum Density (dot) plot. To access this table, 
click  located in the lower right corner of the plot. By default, the CV, mean and 
median value of associated channels will be displayed. User can also right click 
anywhere inside the table, check the statistical info to be displayed, and the table 
will be automatically updated based on the selection. User can also check Set as 
Default to make the selection become default for Spectrum Density (dot) Plot 
created afterwards. When Apply to All is checked, the selections will be applied to 
all spectrum density (dot) plots of the same sample. 
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Set Color Displaying Priority for Spectrum Dot Plot  

User can left click the selected data points from spectrum dot plot to set the 
associated color as highest priority displaying color. To go back to the default 
color, user can left click the blank area of the plot. 

 

NOTE This function is only available for the Spectrum Dot Plot.  
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Right-Click Menu of Spectrum Density (Dot) Plot 

The following additional functions are available from the right click menu of 
Spectrum Density (dot) plot. 
• When right clicking Channels or any emission channel in the plot, user can 

check the laser in the prompted menu to display only the channels associated 
with selected laser(s) in the plot. 

 

• When right clicking MFI in the plot, user can check either MFI-H or MFI-A to 
switch the displayed parameter between MFI-H and MFI-A. 

Default Display 

After Clicking Selected 
Data Points 
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• When right clicking MFI axis, user can select to display the MFI values in 
desired scale (e.g., Linear, Log, Biexponential, Auto range, or Full range). User 
can also select to reset below zero value. When user clicks Setting, user can 
edit the additional axis setting of the plot. Please refer to Set the Coordinates 
of the Axis in this guide for more details of each function in this right click 
menu. 

 
 

• When right clicking plot header in the plot, user can select to display the 
spectrum density (dot)of the events within a selected gate. 
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• When right clicking the plot area in the spectrum density (dot) plot, user can 
access additional functions which are listed below. 

 
 
 

Function Description 

Gating Click to select to select gate from the drop-down menu to display the 
spectrum density plot within the checked gates. 

Plot Type Click and switch the plot between Spectrum Density Plot and Spectrum Dot 
Plot from the expanded sub-menu. This option is not available when user 
right clicks the software to automatically create a spectrum density plot of 
the reference control sample. 

 

Copy Click to copy the spectrum density plot and associated information into 
clipboard. User can select to copy plot only in Bitmap image format, or copy 
plot with statistics in Bitmap image format, or copy plot in EMF image 
format, or copy statistics only in text from the drop-down menu. 

 

Paste Gate Click to paste the copied Vertical Range Gate to the target spectrum density 
plot. First, select a Vertical Range Gate, right click and select Copy from drop-
down list. Then move to the target spectrum density plot, right click and 
select Paste Gate from drop-down list.  

Duplicate Click to duplicate a spectrum density plot for the same sample. 
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Paste to All Cells 
(Beads) Type Samples 
in the same Specimen 

Click to past the spectrum density plot to all control samples defined in 
Reference Control specimen with the same cell (bead) type. This option is 
not available for experiment sample. 

Paste to All Cells 
(Beads) Type Single 
Stained Samples in 
the same Specimen 

Click to past the spectrum density plot to all single stained samples in 
Reference Control specimen with the same cell (bead) type. This option is 
not available for experiment sample. 

Paste to All Cells 
(Beads)Type 
Unstained Samples in 
the same Specimen 

Click to past the spectrum density plot to all unstained samples in Reference 
Control Specimen with the same cell (bead) type. This option is not available 
for experiment sample. 

Format Clicks to defines plot appearance in prompted window below. Refer to Plot 
Format in this guide for more details.  

 

Events Displayed Click to set the number of events to be displayed in the plot in the prompted 
window. Refer to Spectrum Density (Dot) Plot Formatting in this guide for 
more details. 

 

Style Click to set the plot style (i.e., Original or Smooth) for the spectrum density 
plot in the drop-down menu. Refer to Spectrum Density Plot Formatting in 
this guide for more details. 
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Plot Width Setting Click to set the plot width for the spectrum density plot in the drop-down 
menu. Refer to Spectrum Density Plot Formatting in this guide for more 
details. 

 

Set XXX as Emission 
Channel 

Click to select a specific channel on a spectrum density plot, right click and 
select this option to manually apply the Vertical Range Gate to the selected 
emission channel. XXX is automatically updated when selecting the emission 
channel. The gates will be automatically updated on both the Spectrum 
Density Plot and histogram plot after this operation. Alternatively, user can 
click and hold the gate and drag to the designated channel to set it as 
emission channel. This option is available only for Single Stained Control 
sample. 

Fluorochrome Bi-Variate Plots 

The Fluorochrome Bi-Variate plots can be created through Fluorochrome Bi-
Variate Plots window. It is very useful to check the results of spectral unmixing 
and apply necessary adjustment of compensation to be unmixed data. To open 
this window, ensure to select Unmixed Workspace, and click  icon in the 
workspace toolbar. 
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Following options are available in Fluorochrome Bi-Variate Plots window. 
• Samples: Select which sample in the experiment file to be used for the plots. 

By default, the current Active Sample will be selected when the window is 
opened. Used  icon to switch samples forward and backward. 

 

• Height: Select to set the parameter of the plots to Height. 
• Area: Select to set the parameter of the plots to Area. 
• Spillover Matrix after Unmixing: Check to display the Spillover Matrix after 

unmixing in tabular format. This option is available only when Spectral Unmix 
is selected. 

• Compensation Spillover Matrix: Check to display the Spillover Matrix after 
compensation in tabular format. This option is available only when 
compensation is selected. 

• Hide Auto Fluorescence: Check to hide the autofluorescence parameters. This 
option is available only when Spectral Unmix is selected. 

• Editing: Check to enter the editing mode. The Quick Compensation option in 
this window will be available for user to check and perform quick 
compensation on the plot. The Spillover Matrix and all the plots will be 
automatically updated after the Quick Compensation is applied. 
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• Pre-Editing: Check to display the Spillover Matrix currently applied to the 
sample and associated plots. The Quick Compensation option in this window 
will be disabled.  

• Blank: Check to display blank Spillover Matrix and associated plots. The Quick 
Compensation option in this window will be disabled. 

 
 

NOTE Editing, Pre-Editing, and Blank options allow user to quickly check the effect of 
three conditions by checking the changes in the Fluorochrome Bi-Variate Plots.  

 
 

• Gate: Select the gates of the selected sample in the drop-down box. When 
selected, only the data in the selected gate will be displayed on the plots. 

• Display Maximum Events: Select the maximum number of events to be 
displayed in the plot. 

 
 

NOTE Define proper Display Maximum Events will help with the software response speed. 
Less events displayed in the plot, faster the response.  

 
 

• Gate Events: Display the number of events in the selected gate. It is read-only 
and user cannot edit it. 

• Quick Compensation: When checked, user can perform quick compensation 
on the selected plot. This option is available only when user is working in 
Editing mode (i.e., Editing is checked in this window). Refer to Quick 
Compensation in this guide for detailed instructions of performing quick 
compensation on a plot. 

• Plot Type: Select plot type (i.e., dot plot, density plot, and contour plot) for the 
created fluorochrome bi-variate plots. 

• Layout: Select to create the plot in 1x N or N x N layout. When 1 x N is 
selected, the X axis of each plot will be the parameter defined in Parameters 
box. 

• Parameters: Select the parameter(s) to be plotted in the Fluorochrome Bi-
Variate Plots. 

• Live Update Plot: Check to automatically update the plot when Gate, Display 
Maximum Events settings in this window are changed. 

• Update: Click to manually update the plot when Gate, Display Maximum 
Events settings in this window are changed. This button will be automatically 
disabled when Live Update Plot is checked. 
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NOTE It is recommended to manually update the plot when the software response speed 
is compromised.  

• Plot Size: Move the slider to change the size of the plots. 
• Select: Click on the pop-up selection menu to select or unselect all plots. The 

plot can also be selected by clicking individual plot. Multiple plots can be 
manually selected by holding the Shift or Ctrl key. Once selected, a red border 
will be displayed on the plot. Clicking on the selected plot one more time will 
cancel the selection. Selected plots can be added into the Unmixed 
Workspace by clicking “Create Selected” button.  

 

• Create Selected: Click to create the selected plots in Unmixed Workspace. 
• Clear Compensation: Click to clear any changes made after unmixing. This 

option is available only when user is working in Editing mode (i.e., Editing is 
checked in this window). 

• Restore Current Parameter: Click to restore the Spillover Matrix values of 
selected fluorochrome back to the ones displayed in Pre-Editing mode (i.e., 
Spillover Matrix currently applied to the sample and associated plots). This 
option is available only when user is working in Editing mode (i.e., Editing is 
checked in this window). 

• Restore All Parameters: Click to restore the Spillover Matrix values of all 
fluorochrome back to ones displayed in Pre-Editing mode (i.e., Spillover Matrix 
currently applied to the sample and associated plots ).. This option is available 
only when user is working in Editing mode (i.e., Editing is checked in this 
window). 

• Apply: Click to apply the changes to selected sample. 
 
 

NOTE The settings user defined in Fluorochrome Bi-variate Plots window, including 
Spillover Matrix after Unmixing, Hide Auto Fluorochrome, Display Maximum 
Events, Quick Compensation, Plot Type, Layout, Live Update Plot, Plot Size will be 
automatically recorded by the software. When user re-open this window or restart 
the software, these settings will be automatically applied. 
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Gates 

Gates allow for the analysis of subpopulations from the total population collected. 
As described in Plot Gating gates can be applied to subsequent plots to focus in 
on a specific population. These plots can then be further gated and new plot 
created to focus on a more specific population. 

 

The Workspace Toolbar includes icons for creating rectangular gates  , elliptical 
gates  , polygonal gates  , freehand Gates  , quadrant gates  , logic 
gates  , range gates  , bi-range gates , and vertical range gates  . 

 
 
 

NOTE The Vertical Range gate is only available for Spectrum Density Plot. 
 
 

The gating tools can be also selected from the right-click popup mini toolbar on 
plots. 

 
 
 

NOTE When user right click Spectrum Density Plot, only the Vertical Range gate is 
available for gating as shown below. 

 
 
 

All gate types (except vertical gate) can be created on dot plots and density plots. 
Range gates and bi-range gates (except vertical gate) can be created on 
histograms. Vertical Range gate can be created only on Spectrum Density Plot. 
Gates can also be combined to create a logic gate. 

Create Gates 

• To create a rectangular gate: Click the rectangular gate icon  , in the 
Workspace Toolbar. Click and drag in the plot to enclose the target population 
within the rectangle. Release the mouse button to create the gate. 

• To create an elliptical  , range  , or bi-range gate  : Follow similar 
procedures as for creating the rectangular gate. 
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• To create a polygonal gate: Click the polygonal gate icon  , in the 
Workspace Toolbar. Left click in the plot to create the first vertex of the 
polygon. Click in a new location to create the second vertex of the polygon. 
Continue moving around the target population and creating vertices until the 
target population is enclosed. On the last vertex, double-click to complete the 
polygon and create the gate. 

• To create a Freehand Gate: Click the Freehand Gate icon  , in the 
Workspace Toolbar. Left click start point in the plot to begin creating the 
Freehand Gate. Move the mouse cursor inside the plot to draw curve. Double-
click the end point to complete and create the gate. 

The following figures include a rectangular gate GR, an elliptical gate MO, a 
polygonal gate LY, a range gate M1, and a bi-range gate separating CD3- and 
CD3+. 

 

• To create a quadrant gate: Click the quadrant gate icon  , in the Workspace 
Toolbar. Click in the plot to create the center of the quadrants and create the 
gate. As shown below, the center, endpoints, and lines of the quadrant gate 
can be moved to enclose the correct populations. 
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• To create a logic gate: Click the logic gate icon  , in the Workspace Toolbar 
to open the Create Logic Gate window. In this window, the user can create a 
logic gate for the sample in the selected plot. 

There are three types of logic gates: AND gates, OR gates, and NOT gates. In 
the window, a drop-down menu includes the three logic gate types. 

When AND or is selected from the drop-down menu, there are two additional 
drop-down menus to select gates. With an AND gate, the new gate includes 
events that are included in both of the selected gates. With an OR gate, the 
new gate includes events that are included in either one of the selected gates. 

When NOT is selected from the drop-down menu, there is one additional drop-
down menu to select a gate. With a NOT gate, the new gate includes all of the 
events excluded from the selected gate. 

 

In the Experiment Manager panel, logic gates can be found under the 
sample’s Analysis node. 

• To create a vertical gate: Ensure to select Raw Workspace, click the Vertical 
Range gate icon  in the Workspace Toolbar. Left click in the Spectrum 
Density Plot and drag vertically in the plot to enclose the target population 
within the gate. Release the mouse button to create the gate. 

 
 

NOTE If you want to create multiple gates of the same type, double click the gate icon (a 
blue outer line will show on the gate icon). The gating tool will then remain active 
and you can create multiple gates of the selected type. Once completed, press the 
Esc key on the keyboard to exit. 
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Edit Gates 

All gates can be moved and resized after being created. If a gate is edited, all gate 
statistics and subsequent plots dependent on the gates are updated to reflect the 
changes. 

There are multiple methods to select a gate for editing. Options include: 
• Click the pointer icon  , in the Workspace Toolbar to activate the cursor. 

Select the gate by clicking on a vertex or edge of the gate. 
• Click on the gate label. 
• From the Gate tab of the Menu Bar, select the gate from the drop-down menu 

in the Current Selection group. 
• Double-click on an area within the gate. This does not work for quadrant gates. 

After the gate is selected, the gate’s control points are displayed (as white boxes). 
To change the size of a gate, click and drag the control points to modify the gate. 

 
 

NOTE Extra grey control points are displayed when a polygon gate is selected, which can 
be used to scale the gate as a whole. 

 
 

 

To move the gate, select the gate as described above and drag within the gate or 
press keyboard arrows. While moving, the cursor should change into the crossed 
arrow symbol. 
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After editing is complete, click outside of the gate to unselect the gate. 

To delete a gate, select the gate as described above and press the Delete key on 
the keyboard. When a gate is deleted, the subsequent gates and plots that depend 
on it are reset. 

Gate Display Format 

The NovoExpress (Opteon) Software allows users to format the color and labels of 
gates. Gate color determines the color of events displayed on the dot plot, as well 
as the color of the histogram when the gate is applied to a histogram.  

Set the Color of the Gate 

The color of each gate can be set. In dot plots, the events included in the gates are 
displayed in the chosen color. If additional dot plots are created, these events are 
displayed in the same color for easy identification. 

To remove the color from gates, select the gate and right-click on the gate and 
unselect Show Color or select the gate and unselect Color from the Gate tab of the 
Menu Bar. 

The plot shown below have a gate with the color unselected. 
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The plot below has a gate with the color selected. 

 

To change the color of a gate, select the gate, right-click and select Change Color… 
or select the gate and change the color from the drop-down menu next to Color in 
the Gate tab of the Menu Bar. Gate color can also be changed via color column of 
Gate Manager. 
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When an event is inside more than one gate, its color on dot plot is determined by 
the color precedence of the gates. The plots below show that gate CD3+CD4+ has 
higher color precedence than does gate Lym. To view or modify color precedence 
of gate, refer to Gate Manager in this guide. 

 

Gate Labels 

Gate labels are displayed near the gates and include the gate name and the 
percentage of the events included in the gate relative to the total number of events 
displayed on the plot.  

To change the name of a gate, select the gate and click on the gate name to edit or 
select the gate and edit it from the Gate Name box of the Gate tab in the Menu 
Bar. 

To hide the population percentage, unselect Show Value from the Gate tab of the 
Menu Bar, or unselect Show population percentile in the gate label in the Analysis 
Tab of Options. 

If a parameter is associated with marker, quadrant and bi-range gates can be used 
to easily label positive and negative populations. To use this setting, the parameter 
must be associated with marker in New Reference Control Specimen window. 
Right-click on the quadrant or bi-range gate and select Name with Marker to 
rename the gates according to the markers.  
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Apply a Gate to a Plot 

There are multiple methods for applying a gate to a plot. When gates are applied to 
plots, the plots only display events included within the specified gate. Gates can be 
applied to a plot if the creation of the gate is not dependent on the plot. 

To apply a gate to a plot: 
• Within the workspace, hold down the keyboard Ctrl key while dragging the gate 

to the plot. The dragged gate is applied to the plot where it was dropped. 
• Select a gate in the workspace and drag it to the title of the plot to be gated. 
• Select the gate and right-click on the gate. Select Gating and select the plots 

to have the gate applied. 
• Select the gate from the Gate tab of the Menu Bar, select the Gating button 

and select the plots to have the gate applied. 

Copy and Paste Gates 

There are multiple methods to copy and paste a gate: 
• Select the gate and use the keyboard shortcut Ctrl C to copy the gate. Select a 

plot and use the keyboard shortcut Ctrl V to paste the gate into the selected 
plot. 
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• Select a gate. Drag and drop the gate into a different plot. The dragged gates 
are pasted into the plot where it was dropped. 

• To duplicate a gate within the same plot, select a gate and use the keyboard 
shortcut Ctrl D or select the gate and use the Duplicate button from the Home 
tab of the Menu Bar. The duplicate plot appears at the same location as the 
original gate. 

Export Gate Events 

The data from a gate can be exported in either CSV or FCS file format. To export: 
1 Select the gate. 
2 In the Gate tab of the Menu Bar, click the Export Events button to open the 

window shown below. 

 

3 In the window, set the export path, file format, parameter range and post gain. 
Click OK to export the data. 

 

NOTE For more information regarding this window, Refer to Export Data in this guide. 
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Gate Manager 

The Gate Manager displays all gates of the active sample in list mode or tree 
mode. It provides user interface to modify gate name, color and color precedence 
and also shows gate hierarchy and gate statistics. 

  

Toolbar of Gate Manager 

  
 

Icon Description 

 
Show Gate Hierarchy: When checked, the table displays output in tree mode. Child 
gates are indented. 

 
Show Columns: Choose which statistical columns to display in the table. Refer to 
Calculation of Statistics in this guide for further information on calculation of gate 
statistics. 

 
Modify Color Precedence: When checked, the table displays output as list mode. The 
table is sorted by color precedence – the gate with highest color precedence is 
displayed on the top. 

 
Reset to Default Color Precedence: Sets color precedence of all gates to default 
values. By default, newer gates have higher precedence than do older gates. Child gates 
have higher precedence than do parent gates. Logic gates have higher precedence than 
do gates which compose the logic gates. 

 
Clear Color: Click to uncheck all checkboxes in front of each color and remove all the 
previously defined color. 

 
To Top: Sets color precedence of selected gate to the highest precedence. Only 
available when Modify Color Precedence is checked. 

 
Up: Sets color precedence of selected gate higher. Only available when Modify Color 
Precedence is checked. 

 
Down: Sets color precedence of selected gate lower. Only available when Modify Color 
Precedence is checked. 
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To Bottom: Sets color precedence of selected gate to the lowest precedence. Only 
available when Modify Color Precedence is checked. 

 
Copy Text: Copies all gate name(s) and statistics as text to clipboard. 

Modify Gate Color and Color Precedence 

A gate can be set with a color, and the color will be used to draw the gate label. On 
dot plots, events inside a gate are shown as colored dots defined by the gate color. 
When an event is inside more than one gate, its color on a dot plot is determined 
by the color precedence of the gates. To understand more about gate color and 
color precedence, refer to Set the Color of the Gate in this guide. 

To modify gate color precedence, check the Modify Color Precedence tool in the 
toolbar. The color column in Gate Manager is shown below: 

 

The number in the Color column is the gate color precedence. Number 1 indicates 
highest color precedence. The gate rows are sorted by color precedence. To 
change the color precedence of a gate, drag the gate row and drop it to desired 
position. Click the checkbox to set whether to show gate color (black color 
indicates no color is shown). Click the color square box to change gate color in a 
pop up tool window.  

Context menu 

The context menu is shown below for right clicking on only one gate. 
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Create Plot: Creates a new plot including the events from the selected gate. 

Gating: Selects plots to apply the gate.  

Open: Opens the plot containing the gate. 

Copy: Copies the gate. 

Delete: Deletes the gate. 

Rename: Renames the gate. 

Name with Marker: If a fluorescence parameter is associated with marker, this 
labels the gate using the marker specified. 

Change Color: Modifies the color of the gate. 

Show Color: Sets whether to display the gate in color. 

Color Precedence: Modifies color precedence of the gate. 

Show Name: Shows the gate name in gate label on plot. If the Show gate name in 
gate label option in Setting > Analysis is not checked, the Show Name menu item 
here will be disabled. 

Show Percentile: Shows the percentage of the gated events relative to the total 
number of events on the plot. If the Show population percentile in gate label 
option in Setting > Analysis is not checked, the Show Percentile menu item here 
will be disabled. 

Format: Opens Plot Format dialog to define gate format. 

Export Events: Exports data for the events inside the current gate in either FCS or 
CVS format. 
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Export to GatingML File: Exports the gating information of selected gates or all 
gates to a Gating-ML file. Please refer to Export to Gating-ML File in this guide for 
more details. 

 
 

NOTE When multiple gates are selected in Gate Manager, only Delete, Show Color, Color 
Precedence, Show Name and Show Percentile are available. 

Export to Gating-ML File 

The gating information of the selected gates can be exported to a Gating-ML file. 
The exported Gating-ML file can be further analyzed by a third party software 
which also supports the Gating-ML standard, using the Export to GatingML File 
function. 

This function can be accessed with one of the following methods: 
• From Experiment Manager panel: Right click the selected sample, click 

Export→ Export to GatingML Files… to export gating information associated 
with the selected sample. 

 

In the prompted window, the Path field will be automatically filled with the 
default target folder (i.e., the folder where the experiment file is stored when 
exporting the file for the first time, or the folder that user has defined when the 
file was exported previously) and the default file name (i.e., Sample 
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Name.GatingML). User can check the box in front of Specimen Name to 
include the specimen name as part of the file name, and/or check the box in 
front of Well ID (when NovoSampler S is connected) to include Well ID as part 
of the name. 

 

To use different folder and file name, user can directly edit the Path field, or 
click   to the right of the Path text box to open the window below, select 
the appropriate path and edit the file name, and click Save. The updated folder 
and file name will be automatically filled into Path field in Export to Gating-ML 
File window. 

 

Click OK in Export to GatingML File window to export Gating-ML file, the file 
contains all the gating information of the sample. Following window will be 
prompted. Click Yes to open the file location or click No to close this window 
and complete the exporting process. 
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• From Experiment Manager panel: Right click an experiment file, a group, or a 
specimen, and click Export→ Export to GatingML Files… to export gating 
information of all samples associated with the selected experiment, group or 
specimen correspondingly. Each sample corresponds to a Gating-ML file 
respectively. 

 

In the prompted window, the Path field will be automatically filled with the 
default folder (i.e., the folder where the experiment file is stored when 
exporting the file for the first time, or the folder that user has defined when the 
file was exported previously). The default name of exported file will be in the 
format of Sample Name.GatingML, and user cannot edit the file name in this 
window. User can also check the box in front of Specimen Name to include 
the specimen name as part of the file name, and/or check the box in front of 
Well ID (when NovoSampler S is connected) to include Well ID as part of the 
name. 
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To use a different folder, user can directly edit the Path field, or click  to 
the right of the Path text box, select the appropriate path, and click OK. The 
updated folder will be automatically filled into Path field in Export to GatingML 
File window. 

 

Click OK in Export to GatingML File window to export Gating-ML file. The file 
contains all gates of the sample. Following window will be prompted. Click 
Yes to open the file location or click No to close this window and complete the 
exporting process. 
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• From Gate Manager panel: Right click the selected gates, click Export to 
GatingML File… and select All Gates to export all gates of the selected sample 
to the Gating-ML file, or select Selected Gates to export the selected gates 
and their associated parent gates to the Gating-ML file.  

 

In prompted window as shown below, user can select the target folder and 
edit the file name. The default folder is the folder where the experiment file is 
stored when exporting the file for the first time, or the folder that user has 
defined when the file was exported previously. The default file name is Sample 
Name.GatingML. Click Save to continue. 
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Following window will be prompted. Click Yes to open the file location or click 
No to close this window and complete the exporting process. 

 

• From Plot area: Right click the selected gate, click Export to GatingML File… 
and select All Gates to export all gates of the active sample to the Gating-ML 
file, or select Selected Gates to export the selected gates and their associated 
parent gates to the Gating-ML file. 
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In prompted window as shown below, user can select the target folder and 
edit the file name. The default folder is the folder where the experiment file is 
stored when exporting the file for the first time, or the folder that user has 
defined when the file was exported previously. The default file name is Sample 
Name.GatingML. Click Save to continue. 
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Following window will be prompted. Click Yes to open the file location or click 
No to close this window and complete the exporting process. 

 

Statistics 

In the NovoExpress (Opteon) Software, a table of statistical information can be 
found under plots. 

Display Statistical Information 

In the following figure, the statistical information chart is displayed below the plot. 

 

Open the Statistics Chart 

There are two methods to open the statistical information chart. 
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• From the plot, click the button on the lower right corner to expand the plot and 
display the statistics chart. 

 

• From the Workspace Toolbar, click the Show Statistics button to show/hide 
the statistics chart of a plot. 

Statistics Layout 

In the statistics chart, the first column is the Gate column, and the remaining 
columns list the statistical parameters. As labeled by the Gate column, the first 
row of the chart contains statistical information for all events, and the remaining 
rows contain statistical information for individual gates. 

 

To hide or show individual statistical parameters in the chart, right-click within the 
chart and select the parameters to hide or display. Check Set as Default to set the 
current setting as the default setting of new plot. And click Apply to All to hide or 
show individual statistical parameters to all plots of current sample. 
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Copy Statistical Information to Clipboard 

Data from the statistics chart can be copied to the clipboard. The copied data can 
by pasted to a spreadsheet program, such as Microsoft Excel, for further analysis. 

There are two methods to copy statistical information to the clipboard: 
• Select the statistical information from the chart by clicking and dragging or by 

using the keyboard shortcut Ctrl A to select all. Use the keyboard shortcut Ctrl 
C or Shift C to copy the selected information. With Ctrl C and Shift C, one may 
copy the information with the column header and one may copy the 
information without the header. This can be set under File > Options > 
General. 
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• Right-click in the plot, select Copy, and select Copy Statistics (Text). 

 

Statistics Layers 

For plots with multiple layers, the statistical table includes additional columns. The 
first column, #, indicates the layer on the plot. The second column, Sample, 
indicates the sample plotted in the layer. The third column, Gate, indicates the 
gate. The remaining columns describe the statistical parameters. 
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If a gate belongs to a sample which is different from the first layer’s sample, an 
asterisk appears next to the gate name to indicate such situation. In the figure 
below, the statistics of the second row is for gate LYM which applies to the sample 
named Negative as indicated by the asterisk next to the gate name to distinguish it 
from the LYM gate which applies to the sample named Positive. 

 

For gates in a layered plot, the statistical information is displayed for all layers. In 
the figure below, statistical information for Gate M3 is displayed for both the layer 
corresponding to the Positive sample and the layer corresponding to the Negative 
sample. The statistics in the last row is for gate M3 which belongs to the sample 
named Positive; since this is the same as the first layer, no asterisk shows next to 
the gate name. 

 

Calculation of Statistics 

In calculating the statistics, linear scale data are used regardless of the coordinate 
scale displayed by the plot. The calculation also takes into account any Spillover 
Compensation applied to the data.  
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In addition, the calculations update automatically if the data set, gates, Spillover 
Compensation, or plot parameters are modified. 

The statistics include the total number of events, absolute count, percentage 
gated, mean, coefficient of variation, half-peak coefficient of variation, median, and 
geometric mean. 
• Count 

The number of events collected in the specified gate. 
• Abs. Count 

The abbreviation of Absolute Count. The concentration of events defined as: 

Absolute Count = Count / Ve / DF / Absolute Count Unit 

Where Count is the number of events in the gate, Ve is the sample acquisition 
volume, DF is the dilution factor, and Absolute Count Unit is the absolute 
number of units. To set the dilution factor and the absolute number of units, 
click on Absolute Count Setting from the Sample tab of the Menu Bar. 

 

• % Parent  

Percentage of events included within the gate relative to the number of events 
within parent gate. 

• % Grandparent 

Percentage of events included within the gate relative to the number of events 
within grandparent gate. 
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• % All 

Percentage of events included within the gate relative to the total number of 
events collected. 

• Mean 

The mean is defined as  

X� =
1
𝑛𝑛 

 �𝑋𝑋𝑖𝑖

𝑛𝑛

𝑖𝑖=1

 

Where n is the number of events and 𝑋𝑋𝑖𝑖 is the parameter value of the number i 
event. 

• SD 

The standard deviation indicates the variation in the data set and is defined as  

�
1

𝑛𝑛 − 1
�(𝑋𝑋𝑖𝑖 − 𝑋𝑋�)2
𝑛𝑛

𝑖𝑖=1

 

Where n is the number of events, 𝑋𝑋𝑖𝑖 is the parameter value of the number i 
event, and 𝑋𝑋� is the mean of the set. 

• rSD (Robust SD) 

The robust SD is relatively insensitive to outliers comparing to the classical 
standard deviation. It is equal to 0.75 multiplied by the interquartile range 
(IQR). The interquartile range is the 75th percentile channel minus the 25th 
percentile channel.  

The rSD is defined as 

rSD = 0.75 × IQR = 0.75 × (Q3 − Q1) 

Where Q1 is the 25th percentile channel and Q3 is the 75th percentile channel. 
• CV 

The coefficient of variation indicates the variation of the data set expressed as 
a percentage and is defined as  

CV = (SD / 𝑋𝑋�) × 100% 

Where SD is the standard deviation and X �  is the mean. 
• rCV (Robust CV) 

Robust CV is calculated by Robust SD divided by population median. 
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rCV = rSD / Median 
• HPCV 

The half-peak coefficient of variation is expressed as a percentage and is 
defined as  

HPCV = FWHM / (2.36𝑋𝑋�) × 100% 

Where FWHM is the full width at half maximum of the peak and 𝑋𝑋� is the mean 
of the set. 

• Median 

The median value separates the data set so that number of events larger and 
the number of events smaller than the median are equal. 

• Geom. Mean 

The geometric mean is defined as 

𝑋𝑋�𝑔𝑔𝑔𝑔𝑔𝑔 = 10
1
𝑛𝑛∑ log𝑋𝑋𝑖𝑖

𝑛𝑛
𝑖𝑖=1  

Where, n is the number of events and Xi is the parameter value of the number i 
event. Note that the geometric mean cannot be calculated for events with 
negative values. If you include the geometric mean for populations with 
negative values, the resulting statistics will be invalid. 

• Stain Index 

The Stain Index is a normalized functional measure of the reagent brightness, 
defined as 

Stain_Index = (𝑀𝑀𝑀𝑀𝑀𝑀1 − 𝑀𝑀𝑀𝑀𝑀𝑀2)/(2 × 𝑆𝑆𝑆𝑆2) 

Where 𝑀𝑀𝑀𝑀𝑀𝑀1 is the Mean Fluorescence Intensity of the positive population, 
𝑀𝑀𝑀𝑀𝑀𝑀2 is the Mean Fluorescence Intensity of the negative population and 𝑆𝑆𝑆𝑆2 is 
the standard deviation for the negative population. The Stain Index function is 
only available in statistical table but not statistics chart below the plot. 

• % Gate 
Percentage of events included within the gate shown in Gate Manager relative 
to the number of events within the gate that user selected from %Gate drop-
down menu. 
. 
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Cell Cycle Analysis 

The NovoExpress (Opteon) Software includes a cell cycle analysis feature that 
allows for the quantification of cells in each phase of the cell cycle based on DNA 
content. This feature is only available when user works in Unmixed workspace. 

Automated Cell Cycle Analysis 

• Add Cell Proliferation Fluorochrome 
In the Fluorochrome Setting panel, click Edit and add the cell proliferation 
fluorochrome (e.g., PI) in prompted Edit Fluorochrome window. Refer to 
Fluorochrome Setting in this guide for more details.  

 

• Select Compensation to analyze the data. 
Right click the Reference Spectra node of experiment sample in Experiment 
Manager, select Compensation.  
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• Gating Single Cell Population 

After collecting the DNA stained cells, use an FSC-H /SSC-H density plot to get 
the target population and exclude cell debris. From the target population, 
create a Height versus Area density plot on the fluorochrome corresponding to 
the DNA stain, and gate for the single cell population and exclude cell 
aggregates. This is shown in the figure below. 

 

• Cell Cycle Analysis 

Click on the Cell Cycle Plot button in the Workspace Toolbar to create a cell 
cycle plot. Set the X-axis of the plot to a channel for the DNA content stain, 
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such as PI-A. Apply the previously created single cell gate to the plot and make 
sure all events inside the single cell gate are on plot scale. The software 
automatically attempts to fit the data and if successful, the results are 
calculated. To display the statistics, right click on the resulting cell cycle 
histogram and select Show Fitting Result. 

 

• Fitting results: 
 

Item Description 

Watson The model used for cell cycle fitting 

RMS The root means square error of the fit of the G1, S, and G2 phases. A smaller value 
indicates a better fit. 

Freq G1 Percentage in G1 phase 

Freq S Percentage in S phase 

Freq G2 Percentage in G2 phase 

Mean G1 The mean fluorescence intensity of the G1 phase 

Mean G2 The mean fluorescence intensity of the G2 phase 

G2/G1 The ratio comparing the mean fluorescence intensity of the G1 to G2 phase 

CV G1 The coefficient of variation of the G1 phase 

CV G2 The coefficient of variation of the G2 phase 

Freq Sub-
G1 

Percentage in Sub-G1 

Freq Super-
G2 

Percentage in Super-G2 
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Manual Cell Cycle Analysis 

In some cases, the automatic fitting is not successful or additional constraints 
need to be applied to increase the accuracy of the fitting. 
• Constrain G1 and G2 peaks 

To modify the G1 or G2 peaks, click on the peak. Black boxes appear on the 
left, center, and right of the peak. Dragging the boxes adjusts the mean and CV 
used in the fitting. After the modification, the cell-cycle results update 
automatically. 

 

• Cell Cycle Setting window 

Right-click on the cell cycle plot and select Cell Cycle Setting to open the Cell 
Cycle Setting window. 

 

In the Cell Cycle Setting window, there are two mathematical models can be 
selected, the Watson model and the Dean-Jett-Fox model. For Dean-Jett-Fox 
model, the S Phase Shape can be fitted with three options: Rectangle, 
Trapezoid, and Polynomial. Normally, select Rectangle if the S phase looks 
relatively flat, select Trapezoid if the S phase is inclined, and select Polynomial 
if the S phase presents the middle low and the sides are high. When analyzing 
the experimental data for cell cycle S phase synchronization, Synchronous S 
Phase should be enabled. Constraints on the fitting can be applied including 
the mean of G1 and G2 peaks, the CV of G1 and G2 peaks, and the ratio 
between the mean of G1 and G2 peaks. In addition, the color of the fitting 
curves can be set for better visualization of the fitting results. 
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When Watson model is selected 

 
When Dean-Jett-Fox model is selected 
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Cell Proliferation Analysis 

The NovoExpress (Opteon) Software includes a cell proliferation analysis feature 
that allows for the quantification of cell numbers as a function of time. This 
feature is only available when user works in Unmixed workspace. 

Automated Cell Proliferation Analysis 

• Add Cell Proliferation Fluorochrome 
In the Fluorochrome Setting panel, click Edit and add the cell proliferation 
fluorochrome (e.g., ViaFluor 488) in prompted Edit Fluorochrome window. 
Refer to Fluorochrome Setting in this guide for more details.  

 

• Select Compensation to analyze the data. 
Right click the Reference Spectra node of experiment sample in Experiment 
Manager, select Compensation.  
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• Gating Target Cell Population 

On the density plot of FSC-H/SSC-H, create a gate which includes the target 
cell population you are interested in. From the target population, create a 
Height versus Area density plot on FSC, and gate for the single cell population 
and exclude cell aggregates. This is shown in the figure below. 

 

• Cell Proliferation Analysis 

Click on the Cell Proliferation Plot icon in the Workspace Toolbar to create a 
cell Proliferation plot. Set the X-axis of the plot to the fluorochrome that relates 
to the proliferation staining dye, such as ViaFluor 488-H. Apply the previously 
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created cell gate to the plot and make sure all the events inside this gate are 
within the plot scale. The software automatically attempts to fit the data using 
the modeling algorithm and calculates the results.  

 

 
To display the statistics, right click the resulting cell proliferation histogram and 
select Show Fitting Result. 

 

Item Description 

￼ 

Model The name of model used for analysis and generates results, including Standard and 
Floating models.  

RMS Root Mean Square error. It is an estimate of the “goodness of fit” of the model. 

Peaks The count of Peaks. 

Peak Log CV Log CV of peak 

Peak Ratio The average ratio of all the peak positions. 

 
where 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑖𝑖 is the mean of the peak of 𝑖𝑖𝑡𝑡ℎ generation, n is the count of peaks 
include the parent peak. 

Freq Divided The percentage of the original cells that are divided. 

 
where i=0 means the original generation. 

Prol. Index Proliferation Index. It is the sum of the number of divisions in each generation 
divided by the number of original cells that are divided. 
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Exp. Index Expansion Index. It is the number of cells divided by the number of original cells. 

 

Div. Index Division Index. It is the sum of the number of divisions in each generation divided by 
the number of original cells. 

 

Rep. Index Replication Index. It is the number of non-original cells divided by the number of 
original cells that divided. 

 

Reduced Chi-
Square 

Reduced Chi-Square equals the Chi-Square value divided by the free degree. It is an 
estimate of the “goodness of fit” of the model. 

Freq Gi The percentage of the 𝑖𝑖𝑡𝑡ℎ generation. It equals the number of cells of 𝑖𝑖𝑡𝑡ℎ generation 
divided by the number of cells. 

Mean Gi The mean of the peak of the 𝑖𝑖𝑡𝑡ℎ generation. 

Cell Proliferation Setting 

You can select model to fit the data, format to display the results, and set 
constraints for analyzing cell proliferation data. On a generated Cell Proliferation 
analysis plot, right click and select Cell Proliferation Setting to open the Cell 
Proliferation Setting window as shown below.  
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• Select Cell Proliferation Model 

The default cell proliferation model is Standard model, which is suitable for the 
case that there are overlaps between peaks of generations. The peak ratios 
between generations are the same. Floating model is only suitable for the case 
that peaks of generations are distinct, and almost no overlap between them. 
The peak ratios between generations are distinct. 
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• Format the Modeling Display Results 

Select Draw Model Sum, Draw Components, and Fill Components to format 
the cell proliferation modeling results displayed on the plot. Select Show 
Fitting Results to enable the statistical results shown on the plot.  

• Set Cell Proliferation Constraints 

In the Cell Proliferation Setting window, Constraints on the fitting can be 
applied including Peak Count, Peak Ratio, Peak Log CV, and mean value of the 
parent peak. 

Statistical Tables 

The statistical tables provide a summary from multiple samples, gates, and 
parameters enabling batch analysis and data comparison. For data generated 
using NovoSampler S, additional columns including Plate ID, Well ID, Plate 
Barcode and Plate Description are available. 

Many of the features of the statistical table can be accessed through the toolbar in 
the Statistical Table window. 

 
 

Icon Description 

 
Sets the type of statistical table 

 
Adds a column to the table  

 
Edits a column 

 
Duplicates columns  

 
Deletes columns 

 
Hides columns  

 
Selects columns to show 
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Selects samples to show  

 
Deletes rows  

 
Exports table as a CSV file 

 
Opens the Options > Statistical Table window 

Create Different Types of Statistical Tables 

Use the following method to create and format a new statistical table. 
• Creating a New Statistical Table 

In the Experiment Manager panel, under the experiment file name, right-click 
on the Tables node and select Create. A new table is created. 

  

Alternatively, click on the Statistical Table button  in the Home tab of the 
Menu Bar. This also creates a new statistical table. 

The new statistical table will contain Specimen ID, Specimen, Sample, and 
Run Time columns, and lists all of the samples in the experiment file. 
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• Creating a New Statistical Table from Template 

In the Experiment Manager panel, under the experiment filename, right-click 
on the Tables node and select New from Template, a new table is created. 

• Selecting the Type of Statistical Table 

There are five types of statistical tables to choose from: Default Type, a table 
With Gate as Column, a table With Cell Cycle Analysis Results as Column, a 
table With Cell Proliferation Analysis Results as Column, and a table With 
Specimen as Column.  

New tables are created as The Default Type. To change the table type, click 
the Table Type button  from the toolbar and select the new table type from 
the drop-down menu. 

 

Shown below is an example for a table With Gate as Column. 
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Shown below is an example for a table With Cell Cycle Analysis Results as 
Column. 

 

Shown below is an example for a table With Cell Proliferation Analysis 
Results as Column. 

 

Shown below is an example for a table With Specimen as Column. Each 
specimen takes up one row in the table. 

 

• Add columns and rows to the table and close the window. 
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• Rename the statistical table by selecting it from the Experiment Manager 
panel. Right-click and select Rename to rename the table. 

 
 

NOTE If columns or rows are not added to the table before closing the window, the table 
will not be saved. 

 

Statistical Table Columns 

Two types of columns can be added to the statistical table. These include 
statistical columns and formula columns. Formula columns are new parameters 
based on statistical parameters and user-defined formulas. 

After columns are created, they can be edited, deleted, duplicated, hidden, moved, 
and sorted. 

Add and Edit Columns 
• Drag and Drop to Add Columns 

For the Default statistical table type, dragging and dropping a gate into the 
statistical table creates a percent population column for the gate. For this 
method, select a gate from a plot in the Workspace and drag and drop it into 
the statistical table window. A percent population column is created. Gates 
can also be selected from the Experiment Manager panel and dragged and 
dropped into the statistical table window to create the percent population 
column.  

• Add Column window 

Click on the Add Column button in the toolbar. The Add Column window will 
appear. Select the statistical value, the gate, and the parameter. Click the Add 
button to add the column to the table. 



Data Analysis 
 
 

NovoExpress (Opteon) Software Guide 287 

 
 
 

NOTE To add multiple items from each column, highlight the items to be added while 
holding the Ctrl or Shift key. Click Add to add the selected items to the table. 

 
 

NOTE For a table With Specimen as Column, the Sample Name should be specified when 
adding columns. If selecting “All” in the sample list box, the statistical results will be 
the average of all samples in each specimen. For Abs. Count calculation, if Abs. 
Count Unit defined for samples in the specimen is different, the Abs. Count result 
will be empty. 

 
 

NOTE To calculate the Stain Index, you need to select two gates. The gate with smaller 
MFI will be used as negative population gate while the gate with larger MFI is used 
as positive population gate. Refer to Calculation of Statistics in this guide for 
detailed description of Stain Index. 
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NOTE To add Percentile statistics, click on Percentile, enter the Percentile value in the 
Add Percentile window, such as 10 for calculating the 10th percentile. Then click 
OK and10th Percentile item will be added in the statistics column. 

  
 
 
 

• Edit a Column 

Select the column in the statistical table window and click the Edit Column 
button  , in the toolbar. The Edit Column window opens. Select the 
modifications and click OK to edit the column. 

By default, the column name is automatically generated. The name can be 
modified by the Column Name box at the top of the Edit Column window. 

Formula Columns 

In the Add Column and the Edit Column windows, click the Formula tab to enter a 
user-defined formula. The formula can be defined using existing column values 
and basic arithmetic operations. Click Add or OK to define the formula and create 
a new column. User can select Number, Percentage or Text in the drop-down 
menu of Format, select the Decimal Places and check Use Thousands Separator 
to add thousands separator to the formula.  When Percentage is selected, user 
cannot check Use Thousands Separator box (i.e., greyed out). When Text is 
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selected, user cannot select the Decimal Places and check Use Thousands 
Separator box. 

 
 

NOTE If the formula is displayed in red, there is an error in the equation. 
 

 

Select Multiple Columns 

In the header row of the table, click and drag in the top half of the cell to select 
multiple columns. 

 
 

NOTE Click and drag in the lower half of the cell to move the column. 
 

Duplicate Columns 

Select the column, and click the Duplicate Column button  , in the toolbar to 
duplicate the selected column. 

Delete Columns 

Select the column, and click the Delete Column button  , in the toolbar to delete 
the selected column. 
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Show and hide Columns 

Select the column, and click the Hide Column button , in the toolbar to hide the 
selected column. 

To show the column again, click the Show Columns button  , and select the 
column to show from the drop-down menu. 

Move Columns 

In the header row of the table, click and drag in the lower half of the cell to move 
columns. 

 
 

NOTE Click and drag in the upper half of the cell to select multiple columns. 
 

Sort by Columns 

In the header row of the table, double-click on a column header. The rows of the 
table are sorted in ascending order based on the selected column. Double-click on 
the header again to sort in descending order. 

Statistical Table Rows 

In the statistical table, the rows list separate populations for analysis. 

Add Rows 
• Filter Rows window 

In the toolbar, click the Filter Rows button  . The Filter Rows window will 
appear. Check the boxes to be used as rows to the table. Unchecked boxes 
will be excluded from the table. Click OK to recreate or delete the rows in the 
table. 
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If Automatically check new samples is selected, the samples created later will 
be added into the statistical table automatically. For with Specimen as 
Column statistical table type, if Automatically check new specimens is 
selected, the specimens created later will be added into the statistical table 
automatically. 

• Drag and Drop to Add Rows 

Drag and drop a sample, a specimen, or a group from the Experiment 
Manager panel into the statistical table window can create new rows for each 
added sample.  

For the With Gate as Column statistical table type, drag and drop a gate from 
the Experiment Manager panel or plot in the workspace into the statistical 
table window to create rows for the selected gate. If multiple samples contain 
a gate with the same name as the dropped gate, a row is created in the table 
for each of those samples’ gates. 

For the With Cell Cycle Analysis Results as Columns statistical table type, 
drag and drop a cell cycle analysis plot from the Experiment Manager panel or 
workspace into the statistical table window to create a row for the sample. If 
multiple samples have a cell cycle analysis plot with the same name, a row is 
added to the table for each of those samples. 
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Select Multiple Rows 

Click and drag in the column to the left of the Sample row to select multiple rows. 
Alternatively, hold down Ctrl and click in the column to the left to the Sample row 
to select multiple noncontiguous rows. 

Delete Row 

Select the row, and click the Delete Rows button , in the toolbar to delete the 
selected row. Alternatively, select the row and press the keyboard Delete key. 

Statistical Tables Export or Copy Text 

Statistical table results can be exported to CSV file or copied to clipboard as text. 

Export Statistical Tables as CSV File 

In the Sample tab toolbar, click the Export CSV File button . Enter the file path 
and click Save to export the file. 

Copy Statistical Table as Text to the Clipboard 

Select the cells to be copied by clicking and dragging with the mouse or select all 
using the keyboard shortcut Ctrl A. Use the keyboard shortcut Ctrl C to copy the 
selected cells to the clipboard. The copied table can be pasted to a program, such 
as Microsoft Excel, for further analysis. 

Statistical Table Options 

In the toolbar, click the Statistical Table Options button  to open the Statistical 
Table tab of Options window, set Customize Name and Default Visibility of 
Group, Specimen, Specimen ID, Sample, Sample ID, Operator, Run Time, Unmix 
Method and Gate columns. When NovoSampler S is connected, user can set 
Customize Name and Default Visibility of additional Plate ID, Plate Barcode, and 
Well ID columns. Please refer to Option Settings in this guide for more details. 

Statistical Table Management 

Statistical tables can be managed in the Experiment Manager panel under the 
Tables node. 
• Copy and Paste Statistical Tables 

In the Experiment Manager panel, dragging a statistical table and dropping it 
into the Tables node will create a new table with identical information. 
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Alternatively, a statistical table can be copied and then pasted into the Tables 
node to also create a new table with identical information.  

• Delete Statistical Tables 

In the Experiment Manager panel, select the table. Right-click and select 
Delete to delete the table. Alternatively, select the table and press the Delete 
key on the keyboard. 

• Rename Statistical Tables 

In the Experiment Manager panel, select the table. Right-click and select 
Rename. Enter the new name to rename the table. 

• Export Statistical Table as Template 

In the Experiment Manager panel, select the table. Right-click and select 
Export Template... Enter the name for the template in the prompted window 
and click Save to create a template. The template will be saved as a *.nst file.  

Heat Maps 

The heat map can be used to visualize the data in a well plate format. It uses 
different color to display the result of a specified statistical parameter. The color is 
determined by the color scale set for the statistical parameter to be analyzed. 
Multiple heat maps can be opened at the same time, and one heat map supports 
up to four statistical items. 

Create a New Heat Map 

In the Experiment Manager panel, under the experiment file name, right-click on 
the Heat Maps node and select Create.  
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Alternatively, click on the Heat Map icon  in the Home tab of the Menu Bar. The 
Heat Map window will show up.  

Heat Map Window 

The heat map window contains heat map and legends. The well plate ID, plate 
type, and whether to show the sample name and statistics can be changed, and 
the heat map statistics can be edited. In addition, the heat map and legend can be 
copied and saved as image (i.e., PNG, JPEG, BMP, GIF, TIFF, or EMF) or a CSV file. 

 
 
 

NOTE If there are multiple samples in the same well, only the first sample will be used to 
generate the heat map. 

 
 

NOTE If there are samples outside the current plate type, “*” will be displayed in the upper 
left corner of the heat map. 
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Heat Map Grid 

A heat map can be generated for up to four statistic parameters. Each parameter 
will be displayed in a heat map with a corresponding section as illustrated below, 
based on the number of parameters to be displayed together. 

 

Heat Map for Multiple Statistics 

The following figure shows a heat map with two statistics. 
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NOTE The gate, color scale, and color scale range of each statistic parameter can be set 
separately. 

 

Add Statistics 
• Drag and Drop to Add Statistic Parameter 

Directly dragging and dropping a gate into the heat map will add the Count 
parameter from the selected into the heat map. To do so, select a gate from a 
plot in the Workspace, drag and drop it into the created heat map. If there is no 
statistic parameter defined in the heat map, this action will add the Count 
statistics of the selected into the heat map. Otherwise, the current statistic 
parameter will be replaced by the Count statistics of the selected gate. To add 
the Count of a gate as a new statistic parameter, press the Ctrl key while drag 
and drop a gate. You can also select the gate from the Experiment Manager 
panel and drag and drop it into the heat map to add Count statistics of the 
gate.  

Edit Heat Map Statistics Window 

You can add, edit, and remove statistics in Edit Heat Map Statistics window. To do 
so, click the Edit Statistics… button in the heat map. The Edit Heat Map Statistics 
window will appear.  
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• Add: Click to add a new statistic to the list. Up to 4 statistics parameters can 
be added into the list. 

• Remove: Click to delete the selected statistics parameter. 
• Type: Select Basic, Cell Cycle, or Cell Proliferation to be displayed in the heat 

map from the drop-down list. 
 
 

NOTE User can select Cell Cycle or Cell Proliferation only when associated analysis 
results are included for selected sample. 

 
 

• Statistics: Select the statistics type to be displayed in the heat map from the 
drop-down list. 

• Gate: Select the gate whose associated statistics is displayed in the heat map 
from the drop-down list. 

• Parameter: Select the parameter to be displayed in the heat map from the 
drop-down list. 

• Plot: Select the plot to be displayed in the heat map from the drop-down list. 
This option is available only when Cell Cycle or Cell Proliferation is selected in 
the drop-down list of Type. 
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• Select color scale and range: There are two color scale displaying patterns you 
can choose for each statistic in the heat map, Threshold mode and Gradient 
mode.  

Threshold pattern defines the statistics parameter with two colors, depending 
on if the result is larger or smaller than the defined threshold. Select different 
color scheme from the drop-down list in the Threshold option and enter the 
Threshold into the text box below.  

Gradient pattern shows the statistics parameter in a color gradient. Select 
different color scheme from the drop-down list in the Gradient option. The 
scale of the statistics parameter can be defined as Auto Range (software 
identifies the minimum and maximum value and calculate the range 
automatically) or you can manually define the range by entering the minimum 
value in the Min. text box and the maximum value in the Max. text box.  

Update Heat Map 

When the statistics of a sample are changed in value or in scale, the heat map will 
be automatically updated in real time. 

Save Heat Map 

The heat map and legend can be saved as image or a CSV file. 
• Select Image or CSV File from the drop-down menu of Save As.  
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• Select the target folder, and enter the file name, click Save. The currently 
displayed heat map will be saved in designated folder as an image file (i.e. 
PNG, JPEG, BMP, GIF, TIFF, or EMF) or a CSV file. The default prefix of the 
saved file is in the format of Experiment File Name_Heat Map Name. For 
example, if the experiment file name is 190417_1507.ncf,  and name of the 
current heat map is HM20201012, the prefix of the saved file will be 
190417_1507_ HM20201012.  

 
 

Copy Heat Map 

The heat map and statistics result can be copied to clipboard. To do this, select 
Image or Statistics from the drop-down menu of Copy. The currently displayed 
heat map or statistics will be copied to clipboard. User can paste it to a third-party 
editing software (e.g. Microsoft Excel) for further analysis. 
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Heat Maps Management 

Heat maps can be managed in the Experiment Manager panel under the Heat 
Maps node. 
• Copy and Paste Heat Map 

In the Experiment Manager panel, drag a heat map and drop it into the Heat 
Maps node will create a new heat map identical to the original one. 
Alternatively, a heat map can be copied and then pasted into the Heat Maps 
node to create a new heat map identical to the original one.  

• Duplicate Heat Map 

In the Experiment Manager panel, select a heat map. Right-click and select 
Duplicate to create a new heat map identical to the original one.  
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• Delete Heat Map 

In the Experiment Manager panel, select a heat map. Right-click and select 
Delete to delete the selected heat map. Alternatively, select the heat map and 
press the Delete key on the keyboard. 

• Rename Heat Map 

In the Experiment Manager panel, select a heat map. Right-click and select 
Rename. Enter the new name to rename the heat map.  
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6 Plate Manager 

This chapter provides the information for the Plate Manager panel, including 
overview of Plate Manager panel and context menu. 

Overview of Plate Manager Panel 

The Plate Manager panel will only be available when the NovoSampler S is 
installed, or the NovoSampler S installed checkbox is checked in the Instrument 
Configuration window in the NovoExpress (Opteon) software offline mode. This 
management tool provides users with an intuitive and convenient way to manage 
samples on a multi-well plate or tube rack. The Plate Manager also allows user to 
set up the working mode, plate type, mixing and rinsing conditions.  
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Icon  Description  

 

The Plate Manager panel displays a 16 x 24 grid indicating a 384-well 
plate map (for NovoSampler S only) and an 8 x 12 grid indicating a 96-
well plate map. In settings for a 24 or 40 tube-rack or a plate type other 
than 384-well and 96-well plate, an 8 x12 grid will be displayed while 
invalid wells will be grayed out. 
In one plate, multiple samples can be set with the same Well ID. In the 
grid, one well will show one sample at one time. The currently visible 
sample in a well is defined as selected sample of a well. 
The state of each well can be: 
•   This icon indicates that this well is selected. Multiple wells can 

be selected at the same time. 
•   The number is the Specimen ID and indicates to which 

specimen the selected sample belongs to. 

•    An underlined number indicates that the selected sample has 
acquired data. 

•   The arrow in the upper right corner indicates that the well has 
multiple samples. Context menu of the well will list all samples.  

•   The italicized number indicates the acquisition sequence of the 
selected sample. 

•   A red background indicates the well contains the Active 
Sample.  

•   A green background indicates that the well contains sample in 
queue to be collected. 

•  /   An alternating green and dark green background indicate 
that the well contains sample currently in acquisition. 

• /   An alternating green and red background indicate that the 
well contains sample currently in acquisition and also is the Active 
Sample. 

The following operations can be operated on the plate grid: 
• Click: Click the header of a row or a column to select the entire row 

or column. Click the top left corner cell selects all wells in the plate. 
• Right-click: Displays context menu. 
• Double-click: Set selected sample to be the Active Sample. 
• Drag: Drag to select multiple wells in a rectangular range. 
• Ctrl + Click: Hold Ctrl to select multiple individual wells. 
• Shift + Click: Hold Shift to select consecutive wells between two 

wells. 

 
 

Work List: View and edit Work List. 

 
 

Samples Created Order: Selects whether to automatically proceed 
horizontally across the plate or vertically across the plate when 
creating new samples. 

 
 
 

New Sample(s) on Selected Well(s): Creates new samples on the 
selected wells. The created samples will have the same template as 
the Active Sample with the same compensation matrix, report, data 
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analysis, and Cytometer Setting. The samples will be created in the 
specimen with name specified in Specimen Name box. If specified 
specimen name is empty or does not exist, a new specimen will be 
created. The created sample name will use the name specified in the 
Sample Name box as a prefix. If the sample name box is empty, the 
default sample name prefix (sample 1, sample 2 …) will be used.  
Without Template: Creates new samples on the selected wells without 
template applied. The compensation matrix, report, and data analysis 
template will be empty. But the cytometer setting will be the same as 
the current cytometer setting in the Cytometer Setting panel. 

 
 

Delete Sample(s) on Selected Well(s): Deletes the selected samples 
from the selected wells. If one well has multiple samples defined, only 
the selected sample will be deleted. 

 
 

Copy Sample(s) on Selected Well(s): Copies templates of selected 
samples from the selected wells. If no sample has defined in the 
selected wells, this function is disabled. If part of selected wells has 
samples defined, only the wells which have sample defined will be 
copied. 

 
 

Paste Sample(s) on Selected Well(s): Pastes sample template or 
sample events to the selected wells according to copied content. 
• If all the selected wells have samples defined, then it applies 

templates of the copied samples to the selected samples of 
selected wells one by one repeatedly. 

• If all the selected wells have no samples defined, then it creates 
samples with the same templates as copied samples on the 
selected wells. The samples will be created in the specimen with 
the name specified in Specimen Name box.  

• If part of the selected wells has samples defined and the rest part 
have no samples defined, or the selected samples of the selected 
wells are in different specimen, this tool will be disabled. 

• If Copy Events is selected from context menu of a well, this tool will 
be available when only one well is selected and the selected sample 
of the selected well contains no events. 

 
 

 

Duplicate Sample(s) on Selected Well(s): Creates new samples on 
empty wells, duplicating the template of the selected samples of the 
selected wells. 
• If part of the selected wells has samples defined and the rest part 

have no samples defined, or the selected samples of the selected 
wells are in different specimen, this tool will be disabled. 

• If the specimen contains more than one sample, and all the 
samples are selected, clicking this icon will create duplicated 
samples under a newly created specimen. 

New Plate: Creates new plate and specimen, and creates new samples 
in the new specimen, duplicating the template of the selected samples 
of the selected wells. The new samples have the same well ID with the 
selected wells. 

 Show Run Order: When selected, a blue outline shows on the icon . 
The sample acquisition sequence will be shown in the plate view. 
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 Mode: Allows user to select the working mode (Standard, High- 
Throughput and Custom) of the NovoSampler S in this area. Default 
mixing condition, rinse condition, and flow rate will be automatically 
applied when Standard or HT mode is selected. Please refer to 
associated operator's guide for more details. User can only customize 
these settings when Custom mode is selected.  

NOTE  Selecting the working mode is only available before the 
sample is created. 

 

 
This area is designed to input plate information. The left drop-down 
box is the Plate ID. The Plate ID is a positive integer and can be 
modified by highlighting the area and entering a new number.  
The middle drop-down box is the Plate Type. The drop-down box lists 
all the available plate type defined in the Manage Plate Types window. 
Pull down the list and select the corresponding plate type for the 
experiment. The right box is the Plate Name. Input plate name in this 
box to help identify the plate.  

NOTE  The plate type cannot be modified once the sample 
acquisition has begun. 

 

NOTE  When NovoSampler S is connected and the barcode 
reading function is enabled, user can view the scanned 
barcode information from the row below this area (see 
example below). Please refer to NovoSampler S 
Operator's Guide for more details. 

 

 

 
This area is designed to input the specimen and sample information. 
The left drop-down box is the Specimen ID and Specimen Name, 
separated by a colon. The right box is the Sample Name.  
When creating new samples, the samples will be created in a specimen 
with specimen name specified in the Specimen Name box. If the 
Specimen Name box is empty or does not exist, a new specimen will 

Barcode 
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be created. The default new specimen name is Specimen1, 
Specimen2…. The default sample name is Sample1, Sample2 …. 

 This function is available only when NovoSampler S is connected. With 
Absolute Count is selected, user can analyze the exact number of cells 
or particles per unit volume. This function is disabled by default when 
NovoSampler S works in Standard or High-Throughput (HT) mode. 
When Custom mode is selected, user can select to disable or enable 
this function.   

 This function is available only when NovoSampler S is connected. 
With Recover Remaining Samples selected, user can recover the 
remaining sample aspirated into the sampling tube back to the sample 
tube or plate well after sample acquisition. This function is disabled by 
default when Standard or High-Throughput (HT) are selected. When 
Custom mode is selected, user can select to disable or enable this 
function. 

NOTE  The Recover Remaining Samples function is disabled 
by default. To enable this function, user need to check 
the checkbox in the front. 

 

NOTE  Any changes to this setting (i.e., disable or enable) 
during the sample collection will only be effective from 
the next well forward.   

 

 
Mix: Sets the mixing conditions. Mix can be set for None (no mixing), 1 
Cycle, 2 Cycles, 3 Cycles for every defined number of wells or every 
defined number of minutes.  

NOTE  Default mixing conditions (i.e., Mix 1 Cycle Every 1 
Well) will be automatically applied and cannot be 
modified by user when Standard or HT mode is 
selected. 

 

 
Rinse: Sets the rinse cycle to clean the sample injection probe. Rinse 
can be set for None (no rinse), 1 Cycle, 2 Cycles, 3 Cycles for every 
defined number of wells. 

NOTE  There is always one rinse cycle at the end of each plate 
run even the Rinse setting is set to None. 

 

NOTE  Default rinse conditions (i.e., Rinse 1 Cycle Every 1 Well 
when Standard mode is selected, or None when HT 
mode is selected) will be automatically applied and 
cannot be modified by user when Standard or HT 
mode is selected. 

 

 

Mixing Parameters: User can view or set the mixing parameters for the 
orbital shaker in this panel. When NovoSampler S works in Custom 
mode, these mixing parameters for each plate type are defined in the 
Manage Plate Type window and can be modified in this area for the 
current experiment. When NovoSampler S works in Standard or HT 
mode, default mixing parameters will be automatically applied and 
cannot be modified by user.  
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Speed: The mix speed of the orbital shaker. Please refer to table below 
for the default mix speed when NovoSampler S works in different 
mode. 

Plate Type Default Mix Speed (rpm) 

Standard 
Mode 

HT 
Mode 

Custom 
Mode 

96 well plate (U, V and Flat 
bottom) 

1500 1500 1500 

24 well plate 2500 2500 2500 

48 well plate 1500 1500 1500 

40 tube rack (12 X 75 mm 
tubes) 

1000 1000 1000 

384 well plate 2500 2500 2500 

24 tube cooling rack (12 X 75 
mm tubes) 

1000 1000 1000 

96 well plate (U, V and Flat 
bottom) with cooling box 

1500 1500 1500   

40 tube rack (1.5/2.0 mL 
tubes) 

1500 1500 1500 

Acceleration: The acceleration time for the orbital shaker to reach the 
specified Mix Speed. By default, the mix acceleration is set to 1 second. 

Duration: The mixing time for the orbital shaker to mix the sample in 
one cycle. Please refer to table below for the default mix duration when 
NovoSampler S works in different mode. 

Plate Type Default Mix Duration (s) 

Standard 
Mode 

HT 
Mode 

Custom 
Mode 

96 well plate (U, V and Flat 
bottom) 

8 1 10 

24 well plate 10 4 10 

48 well plate 10 5 10 

40 tube rack (12 X 75 mm 
tubes) 

10 5 10 

384 well plate 8 1 10 

24 tube cooling rack (12 X 75 
mm tubes) 

10 5 10 
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96 well plate (U, V and Flat 
bottom) with cooling box 

8 3 10 

40 tube rack (1.5/2.0 mL 
tubes) 

10 5 10 

 

Context Menu 

In addition to the Tools menu, the Plate Management panel also provides a rich 
set of context menu actions. 

Context menu when a single well is selected 

If the selected well has sample already defined, the right-click menu displays a list 
of the samples defined in the selected well and the software functions available to 
be used. This context menu is the same as the context menu by right-clicking a 
sample node in the Experiment Manager panel. From this context menu, you can 
quickly select the defined sample, open, close, delete, and create plots, copy and 
paste templates, copy and delete events, delete, rename and duplicate the sample, 
edit sample notes, import template or the data from a FCS file, or export as a 
template or the data in FCS and CSV formats, move the sample to the selected 
specimen. For additional information regarding these functions, refer to Right-Click 
Menu in this guide. 
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If the selected well has no sample defined, the right-click menu generally has two 
items available, New and Batch Creation of New Specimens. New will create new 
sample without a template. Batch Creation of New Specimens allows user to 
create new specimen(s) with customized specimen and sample organization. 
Refer to Context menu when multiple wells are selected for more details on this 
function. 
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NOTE Paste Sample Names will be available if user copied the sample name in previous 
operation. 
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Context menu when multiple wells are selected 

 

• New: Same as the New Sample(s) on Selected Well(s) tool in the toolbar. 
• Delete: Same as the Delete Sample(s) on Selected Well(s) tool in the toolbar. 
• Batch Creation of New Specimens: Create new specimen(s) with customized 

specimen and sample organization. When clicked, software will prompt 
following window. User needs to define item(s) in this window, click OK to 
complete or cancel to go back to the previous window. 
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 Do not import template: Select this option if no templates need to be 
imported. 

 Import sample template: Select this option if sample template needs to be 
imported for newly created samples. Click  to load the template file 
(.nct file). 

 Import specimen template: Select this option if specimen template needs 
to be imported for newly created specimens. Click  to load the 
template file (.nct file). 

 Specimen order: direction of creating the specimens for selected wells. 
For example, when A1, A2, B1, B2 are selected, and Horizontal is selected 
as the specimen order, and 2 samples per specimen is selected, software 
will automatically create two new specimens and new samples in these 
four wells. Sample A1 and A2 will be placed under the first newly created 
specimen. Sample B1 and B2 will be placed under the second newly 
created specimen. 

 Prefix of specimen name: Set the prefix for the name of the newly created 
specimen(s).  

 Prefix of sample name: Set the prefix for the name of the newly created 
sample(s). 
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 Number of samples per specimen: Set the number of newly created 
samples per each newly created specimen. 

• Delete Specimen: Delete the selected specimen and associated samples on 
selected wells. 

• Copy Template: Same as the Copy Sample(s) on Selected Well(s) tool in the 
toolbar. 

• Paste: Same as the Paste Sample(s) on Selected Well(s) tool in the toolbar. 
• Paste Sample Names: Rename samples of the selected wells with the names 

copied from a spreadsheet program like Microsoft Excel or create new 
samples with copied name on selected wells if there is no sample defined. If 
part of selected wells has samples defined and the rest part have no samples 
defined, this menu will be disabled. 

 
 

NOTE If you have an Excel spreadsheet defining the sample names in a plate format, use 
Paste Sample Names function from the right-click context menu to copy the 
sample name from the spreadsheet and quickly create new samples for a plate in 
NovoExpress (Opteon) Software. 

 
 
 

• Duplicate: Same as the Duplicate Sample(s) on Selected Well(s) tool in the 
toolbar. 

• Move to Specimen: Move the selected sample(s) to the selected specimen or 
new specimen. 
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7 Experiment Manager 

This chapter provides the information for the Experiment Manager function, 
including Experiment Manager Toolbar, Hierarchy, Templates, Import and Export 
Data. 

Experiment Manager Toolbar 

 
 

Icon Description 

 
Work List: View and edit the work list. Contains information on the sample names and 
collection parameters. Refer to Work List in this guide for more information.  

 
Copy the selected node.  

 
Paste the copied content.  

 
Create a copy of the currently selected sample or specimen.  

 
Expand all child nodes of the current node.  

 
Collapse all child nodes of the current node. 

Hierarchy 

Description 

In the NovoExpress (Opteon) Software, the hierarchy structure for experiment 
sample from high to low is groups, specimen, and samples. If Reference Control 
Specimen is created, additional node of Reference Control Specimen and 
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associated Reference Control sample(s) nodes will be displayed in the Experiment 
Manager panel.  

 

In the figure above, the white arrow indicates the active sample. In the 
NovoExpress (Opteon) Software, the active sample collection parameters are 
displayed in the Cytometer Setting and Cytometer Control panels. In the 
Experiment Manager panel, double-clicking on a sample node will make it the 
active sample. When switching to a new active sample, the Cytometer Setting and 
Cytometer Control panels will update with the new active samples’ information, 
and the plots in the Workspace will be replaced with the new active sample’s plots. 

When NovoSampler S is connected, the samples listed in the Experiment Manager 
panel include the Well ID and the sample name, separated by a colon (see figure 
below). Click the sample node to select the sample, right-click and select Rename 
to rename the sample. When renaming the sample, both the Well ID and the 
sample name can be modified. Specimen is also associated with a Specimen ID. 
The Specimen ID is the number before the specimen name, separated by a colon. 
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The Specimen ID is used to identify specimen and can be modified. For additional 
information regarding the Specimen ID, refer to Plate Manager Panel in this guide. 

 

Items in Experiment Manager can be identified by the icon before it which is 
summarized in the table below. Each item has associated right-click menu to allow 
users to conduct further operations conveniently.  

 

Icon Description 

 
File 

The experiment file (*.ncf file format) 

 
Heat Maps 

This node contains Heat Maps for the experiment file. Right-clicking this node 
allows for creating new heat map under this node. 

 
Heat Map 

Individual created Heat map under Heat Maps node. 

 
Tables 

This node contains statistical tables for the experiment file. Right-clicking this 
node allows for the creation of new statistical table under this node. 
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Table 

Individual statistical analysis table 

 

Reference Control 
Specimen 

This node represents a Reference Control Specimen. A Reference Control 
Specimen can contain multiple Reference Control samples (i.e., Unstained and 
Single Stained Control samples) and the Reference Spectra of the Reference 
Control specimen and samples. This node appears only after the Reference 
Control Specimen is created by user. Refer to New Reference Control Specimen 
in this guide for more details.  
Note: If the population gating or autofluorescence setting for Reference Control 
samples changes, the Reference Control Specimen node, associated 
Reference Spectra node and Reference Control sample node will be displayed 
in italicized format. When the Reference Spectra of Reference Control sample 
is updated but Spectral Unmix (or Compensation) is not conducted, only the 
Reference Control Specimen node will be displayed in italicized format.  

 

Reference Spectra 

Reference Spectra can appear under both Reference Control Specimen and 
individual Reference Control sample node. Double click it can open Reference 
Spectra window for associated specimen which contains all the Reference 
Spectra information included in this specimen, or for associated sample which 
only contains Reference Spectra information for this sample. Refer to 
Reference Spectra for more details. 

  
Group 

This node represents a Group in the organizational hierarchy. A group can 
contain multiple specimens and subgroups, and specimens will always be 
placed in front of subgroups.  

  
Specimen 

This node represents an experiment specimen in the organizational hierarchy. 
A experiment specimen can contain multiple experiment samples. Each 
specimen contains a specimen report. In the node text “1:Specimen 1”, the 
former number is Specimen ID, the latter text is Specimen Name. 

    
Sample 

This node represents a Sample (i.e., Reference Control sample or experiment 
sample) in the organizational hierarchy. The sample is the most basic 
organizational unit and contains sample data collection parameters, instrument 
settings, fluorochrome settings, Reference Spectra, reports, analysis, and data. 
The sample icon will display differently depending on the status of the sample. 
A blank sample without any data collected will appear as  
A sample listed for sample acquisition and during acquisition will appear as   
A sample with data collected will appear as   

  
Cytometer settings 

Double click to open Cytometer Settings panel which contains the sample 
parameters, the acquisition stop conditions, and the sample flow rate and 
threshold settings. Refer to Cytometer Setting in this guide for additional 
information. 

 
Fluorochrome 
Setting 

Double click to open Fluorochrome Setting panel which contains the 
information of the selected fluorochromes for current sample including 
fluorochrome parameters, the emission channel, Reference Spectra, etc. Refer 
to Fluorochrome Setting in this guide for additional information. 
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Report 

Contains a report of the data analysis. There is a Report node under specimen 
and sample.  
• Reports under Specimen can include plots and statistical analysis for all 

samples under the specimen. 
• Reports under the Sample can include plots and statistical analysis only 

for the sample. 
Refer to Reports in this guide for additional information. 

  
Analysis 

Analysis contains the plots and gates for a sample. Under the Analysis node, 
there are plot nodes and a logic gate node. Plot nodes are listed for individual 
plots of the sample, and each plot node contains the gates created for the plot. 
A separate logic gate node contains all of the logic gates created for the 
sample.  

Plot A plot created for the analysis of a sample  

Gate A gate created within a plot 

  
Logic gate group 

Contains all logic gates for a sample  

 
 Logic gate 

Logic gates 

 
White arrow 

The white arrow indicates the sample is the active sample.  

 
Flashing green 
arrow 

Flashing green and dark green arrows indicate the sample is being collected. 

/  
Alternatively 
flashing white and 
green arrows 

Flashing red and green arrows indicate the active sample is being collected. 

Right-Click Menu 

From the Experiment Manager panel, right clicking each node will bring up a menu 
of functions. The table below lists the specific functions available by right clicking 
each node type. 

 

Icon Description 

  
File 

New Experiment: When clicked, following options are available in 
the expanded menu. 
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• New Blank Experiment: Create a blank experiment file. 
• New from Template: Create an experiment file from a 

template. 
• New from Experiment File: Create an experiment file from an 

existing experiment file. The Absolute Counting and Sample 
Recovery setting (i.e., enabled or disabled) from the existing 
experiment file will be automatically applied to the newly 
created sample. 

New Sample: Creates a new specimen with a new sample 
included. 
New Specimen: Creates a new specimen.  
New Group: Creates a new group.  
New from Template: Imports selected group, specimen, and 
samples from a template.  
New Reference Control Specimen: Click to open New Reference 
Control Specimen window which allows user to create a 
Reference Control specimen containing Unstained Control and 
Single Stained Control samples. Refer to New Reference Control 
Specimen in this guide for more details. 
Open Plots: Opens all plots from all the samples.  
Close Plots: Closes all plots from all the samples. 
Paste: Creates a new specimen with the copied specimen 
template. 
Paste to All Specimens: Pastes the copied specimen template to 
all specimens. 
Paste to All Samples: Pastes the copied sample template to all 
samples. 
Import FCS Files: Selects a folder to import all FCS files within the 
folder or subfolders as samples. Files up to 10 subfolders deep 
from the selected folder will be added and organized according to 
the folder structure. 
Export: When clicked, following options are available. 

 
• Export as Template: Exports the file as a template file. 
• Export to FCS Files: Exports all samples as FCS files. 
• Export to CSV Files: Exports all samples as CSV files.  
• Export to GatingML Files: Exports all gates in each sample as 

Gating-ML files. 
• Export Plots: Exports all plots from all samples as image files. 
Edit Keywords: Opens Edit Keywords window. The Edit Keywords 
window will list the keywords information for all the samples in the 
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selected file. Please refer to Edit Keywords Window in this guide 
for more details. 
Open Folder: Opens the folder containing the experiment file. 

 
Heat Maps 

 

Create: Creates a new heat map.  
Paste: Pastes a copied heat map. 

 
Heat Map 

 

Open: Opens the selected heat map.  
Copy: Copies the selected heat map. 
Duplicate: Duplicates the selected heat map. 
Delete: Deletes the selected heat map. 
Rename: Renames the selected heat map. 

 
Statistical Tables 

 

Create: Creates a new statistical table.  
Paste: Pastes a copied statistical table. 
New from Template: Creates a new statistical table from an exist 
template. 

 
Statistical Table 

 

Open: Opens the selected statistical table.  
Copy: Copies the selected statistical table. 
Duplicate: Duplicates the selected statistical table. 
Delete: Deletes the selected statistical table. 
Rename: Renames the selected statistical table. 
Export Template: Exports the selected statistical table as template 
(.nst). 
 

 
Group 

New Sample: Creates a new specimen with a new sample 
included. 
New Specimen: Creates a new specimen.  
New Group: Creates a new group.  
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New from Template: Imports selected group, specimen, and 
samples from a template.  
New Reference Control Specimen: Click to open New Reference 
Control Specimen window which allows user to create a 
Reference Control specimen containing Unstained Control and 
Single Stained Control samples. Refer to New Reference Control 
Specimen in this guide for more details.  
Open Plots: Opens all plots from all of the samples within the 
group.  
Close Plots: Closes all plots from all of the samples within the 
group. 
Paste: Creates a new specimen with the copied specimen 
template. 
Paste to All Specimens: Pastes the copied specimen template to 
all specimens in the group. 
Paste to All Samples: Pastes the copied sample template to all 
samples in the group.  
Delete: Deletes the group.  
Rename: Renames the group.  
Import FCS Files: Selects a folder to import all FCS files within the 
folder or subfolders as samples. Files up to 10 subfolders deep 
from the selected folder will be added and organized according to 
the folder structure. 
Export: When clicked, following options are available. 

 
• Export as Template: Exports the group as a template file. 
• Export to FCS Files: Exports all samples as FCS files. 
• Export to CSV Files: Exports all samples as CSV files. 
• Export to GatingML Files: Exports all gates in each sample as 

Gating-ML files. 
• Export Plots: Exports all plots in current group as image files. 
Edit Keywords: Opens Edit Keywords window. The Edit Keywords 
window will list the keywords information for all samples in the 
selected group. Please refer to Edit Keywords Window in this guide 
for more details. 

 

Reference Control Specimen 

Reference Control Specimen Setup: Click to open the Reference 
Control Specimen Setup window. User can edit the reference 
control samples related setting in this window. This window 
contains the same functions as New Reference Control Specimen 
window does. Please refer to New Reference Control Specimen in 
this guide for details.  
Auto Calculate Compensation: Click to allow software to 
automatically conduct the compensation. This option is available 
only when user selects Compensation to analyze the data. By 
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default, it is checked and disabled. When there are any changes to 
the Spillover Matrix, this option will become available.  
Update Reference Spectra and Conduct Unmixing: Click to update 
the Reference Spectra and conduct automatic Spectral Unmix or 
Compensation. This function is available only when Auto Update 
mode is disabled, and the gated population is changed.  
Update Reference Spectra: Click to update the Reference Spectra 
only. This function is available only when Auto Update mode is 
disabled, and the gated population is changed.  
Open Plots: Opens all plots from all of the samples within the 
Reference Control specimen.  
Close Plots: Closes all plots from all of the samples within the 
Reference Control specimen. 
Copy: Copies the template of the Reference Control specimen. 
Paste: Pastes the template of a copied Reference Control 
specimen or creates a new sample with the copied sample 
template.  
Paste to All Samples: Pastes the copied sample template to all 
samples in the Reference Control specimen. 
Duplicate: Creates a duplicate of the Reference Control specimen. 
Delete: Deletes the Reference Control specimen.  
Rename: Renames the Reference Control specimen 
Export: When clicked, following options are available in the 
expanded menu. 

 
• Export as Template: Exports the Reference Control specimen 

as a template file. 
• Export to FCS Files: Exports all Reference Control samples as 

FCS files. 
• Export to CSV Files: Exports all Reference Control samples as 

CSV files. 
• Export to GatingML Files: Exports all gates in each Reference 

Control sample as Gating-ML files. 
• Export Plots: Exports all plots in current Reference Control 

specimen as image files. 
Edit Keywords: Opens Edit Keywords window. The Edit Keywords 
window will list the keywords information for all samples in the 
selected specimen. Please refer to Edit Keywords Window in this 
guide for more details. 
Move to Group: When clicked, user can select to move the 
Reference Control specimen to the root node or new group in the 
expanded menu. 
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Specimen 

 

  

 

New Sample: Creates a new sample in the specimen.  
New Sample from Template: Imports the samples of the first 
specimen from a selected template.  
Open Plots: Opens all plots from all of the samples within the 
specimen.  
Close Plots: Closes all plots from all of the samples within the 
specimen. 
Copy: Copies the template of the specimen. 
Paste: Pastes the template of a copied specimen, or creates a new 
sample with the copied sample template.  
Paste to All Samples: Pastes the copied sample template to all 
samples in the specimen. 
Duplicate: Creates a duplicate of the specimen. 
Delete: Deletes the specimen.  
Rename: Renames the specimen.  
Import: When clicked, following options are available. 

 
• Import Template: Imports template and apply to the selected 

specimen. 
• Import FCS Files: Selects one or more FCS files imported as 

samples. 
Export: When clicked, following options are available. 

 
• Export as Template: Exports the specimen as a template file. 
• Export to FCS Files: Exports all samples as FCS files. 
• Export to CSV Files: Exports all samples as CSV files. 
• Export to GatingML Files: Exports all gates in each sample as 

Gating-ML files. 
• Export Plots: Exports all plots in current specimen as image 

files. 
Edit Keywords: Opens Edit Keywords window. The Edit Keywords 
window will list the keywords information for all samples in the 
selected specimen. Please refer to Edit Keywords Window in this 
guide for more details. 
Move to Group: When clicked, user can select to move the 
specimen to the existing group, new group or root node in 
expanded menu. 

 

 
Auto Calculate Compensation: Click to allow software to 
automatically conduct the compensation. This option is available 
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Sample 

  

only when user selects Compensation to analyze the data. By 
default, it is checked and disabled. When there are any changes to 
the Spillover Matrix, this option will become available. 
Update Reference Spectra: Click to update the Reference Spectra 
only. This function is available only for Reference Control sample, 
and when Auto Update mode is disabled, and user changes the 
gated population. 
Open Plots: Opens all plots from the sample.  
Close Plots: Closes all plots from the sample. 
Delete Plots: Deletes all plots from the sample.  
Create Plot: Creates a new plot for the sample. 
Copy Template: Copies the template of the sample.  
Copy Events: Copies the events of the sample.  
Paste: Pastes the copied template or events of a sample. 
Duplicate: Creates a duplicate of the sample. 
Delete: Deletes the sample.  
Delete Events: Deletes all or part of the sample’s events. Only 
accounts with the Delete Sample Events privilege can perform 
this operation (Refer to Sample in this guide). 
Rename: Renames the sample.  
Edit Sample Notes: Edits the sample notes. 
Import: Click to import a sample template or FCS file in the 
expanded menu. 

 
 Export: Click to export the sample as a template, FCS file, CSV file, 
exports all gates as a Gating-ML file or exports all plots of the 
sample as image files in the expanded menu. 

  
Edit Keywords: Opens Edit Keywords window. The Edit Keywords 
window will list the keywords information for the sample. Please 
refer to Edit Keywords Window in this guide for more details. 
Move to Specimen: Move the sample to the selected specimen or 
new specimen. 

 
View Cytometer Status: Displays the cytometer status when the 
sample is collected. 
View Instrument Information: Displays the instrument information 
when the file is created or the first sample is collected. 
View Merge Information: This option is only available when 
selected sample is merged from other samples. User can view the 
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merge information (e.g., samples which current sample was 
merge from). Please refer to Merge Samples in this guide for more 
details. 

 
Cytometer settings 

 

Copy: Copies the sample’s instrument settings.  
Paste: Pastes the copied instrument settings to the sample.  
Import: Imports the instrument settings from a selected template. 

  
Fluorochrome Setting 
 

 

 

Copy: Copies the sample’s fluorochrome settings.  
Paste: Pastes the copied fluorochrome settings to the sample.  
Import: Imports the fluorochrome settings from a selected 
template. 
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Reference Spectra 

Right click menu of Reference 
Spectra node associated to  
Reference Control specimen or 
sample when user selects 
Spectral Unmix to deconvolute the 
data. 

 

Right click menu of Reference 
Spectra node associated to  
experiment sample when user 
selects Spectral Unmix to 
deconvolute the data. 

 

Right click menu of Reference 
Spectra node associated to  
Reference Control specimen or 
sample when user selects 
Compensation to analyze the 
data. 

Following options are available when Spectral Unmix (LS) is 
used. 
• Clear Reference Spectra and Spillover Matrix after Unmixing: 

Clear the sample’s Reference Spectra and Spillover Matrix after 
unmixing. This option is only available for multi-color 
experiment sample, but not available for Reference Control 
specimen, Unstained Control sample and Single Stained 
Control sample.  

• Clear Spillover Matrix after Unmixing: Clear the sample’s 
Spillover Matrix after unmixing. 

• Copy Reference Spectra and Spillover Matrix after Unmixing: 
Copy the sample’s Reference Spectra and Spillover Matrix after 
unmixing.  

• Copy Reference Spectra: Copy the Reference Spectra of 
selected sample. 

• Copy Spillover Matrix after Unmixing: Copy the Spillover Matrix 
after unmixing of selected sample. 

• Paste: Pastes the copied Reference Spectra or Spillover Matrix 
to the selected sample.  

• Spectral Unmix (LS)/Compensation: Select Spectral Unmix 
(LS) or Compensation to analyze the data. This option is not 
available for Unstained Control sample and Single Stained 
Control sample. For experiment samples, only when the sample 
has not been analyzed by either method, i.e. its associated 
Reference Spectra or Compensation is empty, user can select 
one method to analyze the data.   

• Import Reference Spectra from Library: Imports Reference 
Spectra from library. Refer to Import Reference Spectra from 
Library in this guide for more details. 

• Export Reference Spectra to CSV: Exports Reference Spectra 
to a CSV file. 

• Add to Reference Spectra Library: Add the Reference Spectra 
to library. This option is not available when user selects 
Compensation to analyze the data. When Spectral Unmix (LS) 
analysis method is selected, this option is only available for 
Reference Control samples, but not available for experiment 
sample. 

• Import: This option is available for experiment sample only. 
User can click it to import the Reference Spectra from template 
or import the Reference Spectra from the library to the 
experiment sample in the prompted window. Please refer to 
Import Reference Spectra from Library in this guide for more 
details. 

 
Following options are available if Compensation is used. 
• Compensation Matrix: View and edit the Compensation Matrix 

in prompted Reference Spectra window. Refer to Reference 
Spectra in this guide for more details. 
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Right click menu of Reference 
Spectra node for experiment 
sample node when user selects 
Compensation to analyze the 
data. 

 

• Spillover Matrix: View and edit the Spillover Matrix in prompted 
Reference Spectra window. Refer to Reference Spectra in this 
guide for more details. 

• Clear Compensation: Clear the Compensation Matrix and 
Spillover Matrix of selected sample. This option is available only 
for experiment sample. 

• Copy: Copy the Compensation Matrix of selected sample. 
• Paste: Paste the copied Compensation Matrix to selected 

sample. 
• Spectral Unmix (LS)/Compensation: Check to switch to using 

Spectral Unmix (LS) or Compensation to analyze the data. This 
option is not available for Unstained Control sample and Single 
Stained Control sample. For experiment samples, only when 
the sample has not been analyzed by either method, i.e. its 
associated Reference Spectra or Compensation is empty, user 
can select one method to analyze the data. 

• Import: This option is available for experiment sample only. 
User can click it to import the Reference Spectra from template 
to the experiment sample in the prompted window. Import 
Reference Spectra from Library is not available since 
Compensation is selected for analysis.  

 
• Export Reference Spectra to CSV: Exports Compensation 

Matrix and Spillover Matrix to a CSV file. 
 

NOTE When Spectral Unmix (LS) is used, the Reference 
Spectra node will be displayed in green color if the 
associated specimen or sample has Reference 
Spectra. When Compensation is used, the 
Reference Spectra node will be displayed in blue 
color if the Compensation Matrix of associated 
specimen or sample is not empty.  

  

 
Report 
Specimen Report: 

 

Open: Opens the report.  
Print: Prints the report.  
Copy: Copies the report template.  
Paste: Pastes the copied report template to the sample. Specimen 
reports and sample reports are not able to copy and paste each 
other. 
Import: Imports a report template to the sample from a selected 
template file. 



Experiment Manager 
 
 

NovoExpress (Opteon) Software Guide 328 

Sample Report: 

 

 
Analysis 

 

Open Plots: Opens all plots from the sample.  
Close Plots: Closes all plots from the sample. 
Delete Plots: Deletes all plots from the sample.  
Create Plot: Creates a new plot for the sample. 
Copy: Copies the sample analysis template.  
Paste: Pastes the copied analysis template to the sample. 
Import: Imports an analysis template to the sample from a 
selected template file. 

Plot 

 

Open: Opens the plot.  
Close: Closes the plot.  
Copy: Copies the plot.  
Paste: Pastes a copied gate to the plot.  
Delete: Deletes the plot.  
Rename: Renames the plot. 
Save as image…: Save plot as an image file. 

Gate 

 

Create Plot: Creates a new plot including the events from the 
selected gate. 
Gating: Selects plots to apply the gate. 
Open: Opens the plot containing the gate. 
Copy: Copies the gate. 
Delete: Deletes the gate.  
Rename: Renames the gate.  
Name with Marker: If a fluorescence parameter is associated with 
marker, this labels the gate using the marker specified.  
Change Color: Modifies the color of the gate.  
Show Color: Sets whether to display the gates in color.  
Color Precedence: Modifies color precedence of the gate. 
Show Name: Shows the gate name in gate label on plot. If the 
Show gate name in gate label option in Setting > Analysis is not 
checked, the Show Name menu item here will be disabled. 
Show Percentile: Shows the percentage of the gated events 
relative to the total number of events on the plot. If the Show 
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population percentile in gate label option in Setting > Analysis is 
not checked, the Show Percentile menu item here will be disabled. 
Format: Opens Plot Format dialog to define gate format. 
Export Events: Exports data for the events inside the current gate 
in either FCS or CVS format. 
Export GatingML: Exports gates as Gating-ML file. 

 
Logic gate group 

 

Create: Creates a logic gate.  
Delete: Deletes all logic gates. 

 
Logic gate 

 

Create Plot: Creates a new plot including the events from the 
selected gate. 
Gating: Selects plots to apply the gate. 
Edit: Opens the logic gate editing window.  
Delete: Deletes the logic gate. 
Rename: Renames the logic gate. 
Change Color: Modifies the color of the logic gate.  
Show Color: Sets to display the logic gates in color. 
Color Precedence:  Modifies color precedence of the gate. 
Export Events: Exports data for the events inside the current gate 
in either FCS or CVS format.  
Export to GatingML File: Exports all or selected gates as Gating-
ML file. 

Move Items 

Items in the Experiment Manager can be easily re-organized by drag and drop 
action. Select the item using the left key of the mouse. Move the mouse while 
holding the left key to drag the item. When the mouse cursor turns like  , one may 
move the item to the position indicated by the blue line. When the mouse cursor 
turns like  , one may apply the analysis as the template to another item. For more 
information, refer to Drag and Drop the Templates in this guide. 
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NOTE During the drag, press the ESC key to cancel the drag operation. 
 
 
 

NOTE Experiment Manager supports making multiple selections within tree node to allow 
batch operation of multiple objects. Use Shift key to select continuous nodes on the 
tree and use Ctrl key to select discontinuous nodes on the tree, just like selecting 
multiple files on Windows Explorer. Only nodes of same type can be selected 
simultaneously. The selection menu may have less items available when in multiple 
selection mode. 

 

Merge Samples 

When two or more samples were collected from the same instrument (i.e., same 
instrument serial number, and same optical configuration), with same data 
acquisition parameters selected in the Cytometer Setting panel, with same data 
acquisition mode (i.e., Absolute Count mode applied or not), and the total events 
from merged samples are less than 10 million, these samples can be merged into 
one sample.  

To merge multiple samples,  
1 Ensure the Merge Samples privilege is enabled in the Access Privilege 

window.  
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NOTE When user logs into the software with Administrator account, the Merge Samples 
privilege is automatically enabled by default. 

 
 

2 Select the samples from the Experiment Manager panel or Plate Manager 
panel (if NovoSampler S is connected) while holding the Ctrl or Shift key on 
the keyboard. 

3 Right click any sample, click Merge as New Sample to Specimen. User can 
select either New Specimen to have the merged samples placed under a 
newly created specimen or select Specimen X to have the merged sample 
placed under the selected existing specimen.  
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4 The original samples will be merged in the order of acquisition time with a 

fixed time interval of 30 seconds added between each original sample to 
account for the time needed for fluidic rinsing and sample preparation. The 
icon of the merged sample is displayed as .  

5 User can right click the merged sample and select View Merge Information to 
view the information of merged sample (e.g., Name of original specimen and 
sample).  
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Templates 

The NovoExpress (Opteon) Software allows for the use of templates to quickly set 
up experiment settings. These files can contain the settings for groups, 
specimens, or samples. There are multiple methods for a template to be applied 
including: copying and pasting, dragging and dropping, adding through the toolbar, 
and importing and exporting templates. 
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Copy and Paste the Template 

In the Experiment Manager panel, select a specimen, right-click, and select Copy 
to copy the template of the specimen. To copy the template of a sample, select 
the sample, right-click, and select Copy Template to copy the template of the 
sample. 

   

To paste, right-click on the target node and select Paste or Paste to All Samples 
or Paste to All Specimens to apply the template, as shown below: 
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The following table lists template information transferred when copying from a 
source node type and pasting to a target node type. In addition to copying and 
pasting, the table below also applies to dragging and dropping (Drag and Drop the 
Templates) and using the toolbar (Use the Toolbar) except for one exception 
described in Drag and Drop the Templates. 

 

The source 
node  

Target node 

Specimen  Specimen: The target specimen report is replaced by the template of source 
specimen report and samples in the target specimen are replaced by copying 
samples in the source specimen and pasting to them. 
Group, Experiment File: Creates the same specimen as the source specimen in the 
target group of experiment file. 

Specimen 
Report  

Specimen Report, Specimen: The target specimen report or specimen report of 
target specimen is replaced by template of source specimen report. 
Group, Experiment File: The specimen reports of all specimens within the target node 
are replaced by the template of source specimen report. 

Sample  Sample: The cytometer settings, compensation, sample report and analysis 
templates are replaced. If the target sample contains events, cytometer settings are 
not replaced. 
Specimen: Create the same sample in the target specimen  
Groups, Experiment File: All samples in the target node are replaced by copying the 
source sample and pasting them to the target node. 
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Cytometer 
Setting 

Cytometer Setting, Sample: The cytometer settings template is replaced. If the 
target sample node contains previously collected events, only the parameter aliases 
are replaced. 
Specimen, Groups, Experiment File: The cytometer settings templates for all 
samples within the target node are replaced. 

Fluorochrome 
Setting 

Fluorochrome Setting, Sample: The fluorochrome setting of target sample is 
replaced. 
Specimen, Group, Experiment File: The fluorochrome setting of all samples within 
the target node are replaced. 

Reference 
Spectra  

Reference Spectra, Sample: The Reference Spectra and Fluorochrome setting of 
target sample is replaced. 
Specimen, Group, Experiment File: The Reference Spectra and Fluorochrome setting 
of all samples within the target node are replaced. 
Note: If the photodetector gain value is different between the source Reference 
Spectra and the target sample, the Reference Spectra applied to target sample will 
be calculated automatically based on gain value of the target sample. The unmixing 
results  may not be accurate if this gain difference is significant. 

Sample 
Report  

Sample Report, Sample: The report template is replaced by the report template of 
source sample. 
Specimen, Group, Experiment File: The sample report templates of all samples 
within the target node are replaced. 

Analysis  Analysis, Sample: The analysis template of target sample including plots and gates 
is replaced by the analysis template of source sample. 
Specimen, Group, Experiment File: The analysis templates of all samples within the 
target node are replaced. 

Plot Analysis, Plot: If the target node contains a plot with the same name as the source 
node, the plot will be replaced. Otherwise, the plot will be created. 
Specimen, Group, Experiment File: Either replace or create the plot in all of the 
samples of the target node. 

Gate (does 
not include 
logic gates) 

Plot (does not include cell cycle plots): If the target node contains a gate with the 
same name as the source node, the gate will be replaced. Otherwise, the gate is 
created. Only range and bi-range gates can be drawn into a one-dimensional 
histogram. i.e., a rectangular gate cannot be applied to a histogram. Also, changing a 
two-dimensional gate (such as FITC vs. PE, that has a rectangular gate drawn in it) to 
a histogram will delete rectangular gates. 
Analysis, Sample: Source gate will be pasted to the plot with the same plot name as 
source gate’s plot in the target sample if it exists.  
Specimen, Group, Experiment File: Source gate will be pasted to all samples in the 
target node. 

 
 

NOTE Specimen reports and sample reports cannot copy and paste each other. 
 



Experiment Manager 
 
 

NovoExpress (Opteon) Software Guide 337 

Drag and Drop the Templates 

The template from source nodes can also be applied to target nodes by dragging 
and dropping, as shown below: 

 

When dragging a node over another, if the mouse turns to  , dropping will apply 
template. If the mouse turns to  , dropping will move and reposition the selected 
item. For more details for moving objects, see Move Items.  

 
 

NOTE Drag a sample node to a specimen node, a pop-up dialog box will ask you to create 
new sample or paste a template to all samples of that specimen; drag a specimen 
node to a group node, a pop-up dialog box will ask you whether create new 
specimen or paste a template to all specimen of that group. 

 
 
 

NOTE During the drag, press the ESC key to cancel the drag operation. 
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NOTE Drag a sample node to the workspace (empty area or inside plot window) will apply 
the data analysis template of the current Active Sample to the dragged sample and 
display the data from the dragged sample. In another word, it will keep current 
analysis template and switch the Active Sample to the dragged sample. 

 

Use the Toolbar 

In the Experiment Manager panel, select the source node to be copied. The node 
will be highlighted in yellow (e.g.,  ). To copy the selected node, click the 
Copy button  , from the Experiment Manager panel toolbar. To paste the copied 
node, select the target node in the Experiment Manager panel, and click the Paste 
button  , from the toolbar.  

Import and Export Templates 

Export Template 

In the Experiment Manager panel, select the sample, specimen, group, or 
experiment file to export. Right-click the selected node and select Export > Export 
as Template…. The template will be exported as a *.nct template file. 
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NOTE When exporting sample template or specimen template, only the User-Defined 
Keywords will be automatically included. 

Import Template 
• Import to Experiment File 

If importing to an experiment file, right-click the experiment file node and 
select New from Template…. 

 

• Import to Specimen 

If importing to a specimen, right-click the specimen node and select New 
Sample from Template…. 
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• Import to Sample 

If importing to a sample, right-click the sample node and select Import, then 
Import Template…. 

 

• Import to Cytometer Setting, Fluorochrome Setting, Reference Spectra, 
Report, or Analysis 

If importing to Cytometer Setting, Fluorochrome Setting, Reference Spectra, 
Report, or Analysis, right-click the target node and select Import… 
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NOTE When importing sample template or specimen template, only the User-Defined 
Keywords will be automatically included. 

Import and Export Data 

The NovoExpress (Opteon) Software is capable of importing FCS 2.0, 3.0 and 3.1 
formatted files for data analysis, and it is able to export FCS 3.0, FCS 3.1, and CSV 
formatted files. 

Import Data 

There are multiple methods for importing FCS files through the Experiment 
Manager panel: 
• Select the experiment file node or a group node. Right-click and select Import 

FCS Files…. Select a folder containing the FCS files to import. All FCS files 
within the folder will be imported. Files up to 10 subfolders deep will be 
imported and organized according to the folder structure. 

• Select a specimen node. Right-click and select Import FCS Files…. Select FCS 
files to import as samples under the specimen node. 

 
 

NOTE To import multiple samples, hold down the Ctrl key while selecting samples to 
select more than one sample. 

 

• Select a blank sample node. Right-click and select Import, then Import FCS 
File… . 

Select the FCS file, and data from the file will be imported to the blank sample. 
It is not possible to import data to a sample already containing collected data. 
To import data to a sample already containing data, first clear the sample of 
any events by right clicking the sample and selecting Delete Events. 
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NOTE When importing a FCS file, all the FCS Standard Keywords will be automatically 
included. Other keywords (if any) will be imported as User-Defined Keywords. If the 
imported keyword has the same name as the existing keyword, software will 
automatically add (1) behind the imported keyword. For example, if the imported 
keyword is ADT which already exists, the software will import it as ADT(1). 

 

Export Data 

Select the sample, specimen, group, or experiment file node with data to be 
exported. Right-click the node and select Export > Export to FCS Files… or Export 
to CSV Files…. The Export Events window will open. 

 
 

NOTE When exporting data to FCS file, raw and unmixed data will be exported in separate 
FCS files. A suffix of _unmixed will be automatically added to the FCS file with 
unmixed data. When exporting data to CSV file, raw and unmixed data will be 
exported in one CSV file. 

 

 
When NovoSampler S is not connected 
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When NovoSampler S is connected 

The Export Events window has the following settings: 
• Object: This is the node to be exported. If the object is a sample, only the 

sample will be exported. If the object is a specimen, group, or experiment file, 
all samples within the object will be exported. 

• Gate: The default gate setting is All. In this setting, all events are exported for 
each of the exported samples. A specific gate can be selected using the drop-
down menu. When a gate is selected, only events within the gate are exported. 
If an exported sample does not contain the selected gate, all events within the 
sample are exported. Also, if an exported sample contains the gate but the 
gate does not include any events, all of the sample’s events are exported. 

• Path: The path specifies the location to save the exported files. The user can 
type in the textbox or use the button  , to change the path. When the object 
is a single sample, the exported data file is saved directly at the path. When the 
object is a specimen, group, or experiment file, the exported data files is saved 
in subfolders representative of the sample hierarchy organization in the 
Experiment Manager. 

• Specimen Name: Check this box to include specimen name in the name of the 
exported file. 

• Well ID: Check this box to include Well ID in the name of the exported file. This 
option is available only when NovoSampler S is connected. 

• Format: This specifies the exported data file format. The default setting 
depends on whether the window was opened using Export > Export to FCS 
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Files… or Export > Export to CSV Files…. However, the format can be changed 
post selection using this setting. If you want to import the FCS files to FlowJo 
with version below v10, please select FCS 3.0.  

• Parameter Range: When exporting as a FCS formatted files, there is the option 
to set the recommends visualization parameter range. The three options are 
Default, Auto, and Plots. When Default is selected, the parameter range is the 
full range of the instrument (10 to 224). When Auto is selected, the software 
automatically calculates the best range based on the distribution of the 
sample data. When Plots is selected, the parameter range is determined from 
parameter ranges used in plots. 

• FCS File Type: Allows user to check Raw to export the raw data, or check 
Unmixed to export the unmixed data, or check both to export both raw and 
unmixed data. A suffix of Unmixed will be automatically added to the end of 
the exported FCS file when user exports the unmixed data. For example, when 
user checks Unmixed, and clicks OK, the exported FCS file will be named as 
Sample Name_unmixed.fcs. 

After setting the above options, click OK to begin exporting the data. 
 
 

NOTE When exporting to FCS file, two FCS files will be exported. One FCS file consists of 
the data of the channel and fluorochrome parameters. Another FCS file (with 
_unmixed automatically included in the end of the file name) consists of the data of 
only the fluorochrome parameters. 

 
 

NOTE Parameter range of options does not affect the number of events exported. No 
matter what choice was made it will export all the events within specified gate. 
Export FCS file with Auto or Plots parameter range could help third-party software 
to select the appropriate range when showing plots. 

 
 

NOTE When exporting a FCS file, both Statistical Keywords and User-Defined Keywords 
will be exported automatically with no prefix added. However, the FCS Standard 
Keywords will be exported with prefix of $ automatically added. 

Copy and Paste Events 

In the Experiment Manager panel, data of collected events can be copied and 
pasted to blank samples. 
• Select the sample containing the events to be copied. Right-click and select 

Copy Events. 
• Select the empty sample. Right-click and select Paste, or select the Paste 

button, from the toolbar. Data from all of the collected events in the original 
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sample is pasted into the blank sample. Note that only events and cytometer 
settings are pasted. To copy and paste Analysis, select the sample containing 
the Analysis to be copied. Right click and select Copy Template. Select the 
sample to paste the Analysis into. Right click and select Paste. Alternatively, 
dragging and dropping Analysis from one sample to another will also copy and 
paste the Analysis. Similarly, this can be performed with Reference Spectra 
and Report. 
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8 Reports 

This chapter provides information for the Report function, including Report 
Interface, Automatically Generate Reports, Report Options, Report Editor, Report 
Output and Batch Print Reports.  

Reports can be created using an auto mode and a manual mode. In the auto 
mode, the software generates the report using a fixed format to include user 
created plots, statistics (Gate, Count, % of Parent, Mean X and Mean Y), and basic 
information (Sample Name, Run Time, Cytometer, and Software). In the manual 
mode, the user is able to add or remove elements and adjust formatting. 

 
 

NOTE Real-time changes made to a plot within the Report are also applied to sample’s 
analysis back in the main interface. Statistics are automatically adjusted. 

 
 

From the Experiment Manager panel, the report can either be a sample report or a 
specimen report. A sample report can contain plots, statistical information, 
compensation matrices, and collection information for the sample. A specimen 
report contains such information for all of its samples and basic information of its 
own. Double clicking on Report in the Experiment Manager allows the user to view 
the report interface window. 

After the reports are created, a batch print function (Batch Print Reports) can be 
used to generate PDF files.  

 

Specimen Report 

Sample Report 
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Report Interface 

The report interface window is shown below. It can be opened by double-clicking 
on the report node in the Experiment Manager panel. 

 

The interface window is divided into three main sections: Title Block, Toolbar, and 
Display Area. 

The title bar contains the name of the current report in the window. 

The toolbar contains the functions available to generate and edit the report. 

The display area is the main area of the window. Using this area, the user is able to 
edit the objects displayed and add and delete pages. The objects here forth are 
referred to as report items and include text, graphics, statistical information, 
Spillover Compensation, and plots. 

The toolbar functions are described below: 

 
 

Icon Description 

 
Auto Report Mode: Clicking on this button switches between the automatic 
report generation mode and the manual mode. When selected and in automatic 
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mode, the icon appears with a blue border . When unselected and in manual 
mode, the icon appears without the blue border .  
 

NOTE  The original automatic report can be restored after making 
manually changes in manual mode by re-selecting auto report 
mode. 

  

 
Report Options: Click to open Report Options dialog. Refer to Options Settings 
in this guide for detail information. 

 
Insert Page: This function inserts a page into the report. By default, clicking the 
button inserts a blank page after the current page being viewed. In the display 
window, the current page being viewed has a red border. From the arrow to the 
right of the button, a drop-down menu allows the user to specify Insert Before 
Current Page or Insert After Current Page.  

 
Delete Page: Deletes the current page. If the report is a single page, the page 
cannot be deleted. 

 
Print: Prints the report.  

 
Batch Print Reports: Open the Batch Print Reports dialog. Refer to Batch Print 
Reports in this guide. 

 
Print Preview: Displays a print preview of the report.  

 
PDF: Generates a PDF file of the report. 

 
Insert Text: Inserts a textbox. The user can edit and format the text. Text types 
include text, sample name, sample notes, specimen ID, specimen name, 
operator, run time, cytometer, software. 

  

 
Insert Plot: Click the icon to list the plots for the sample, including dot plots, 
density plots, histogram plots, contour plots, spectrum density plot and cell 
cycle plots. Select the plot to insert. The plot is inserted with the statistics as 
shown below.  
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Insert Sample Statistics: Inserts a table of gate statistics for a sample. In a 
sample report, click the button to insert a gate statistics table for the sample. In 
a specimen report, click the button and select a sample from the dropdown 
menu to insert a gate statistics table for the selected sample. 

 
Insert Spillover Matrix: When user selects Spectral Unmix, clicking this button 
will prompt window below allowing user to Insert the Height or Area parameter-
based Spillover Matrix after unmixing.  

 
When user selects Compensation, clicking this button will prompt window 
below allowing user to Insert the Height or Area parameter-based Spillover 
Matrix.  

 
In a sample report, click the button to insert the selected Spillover Matrix for the 
selected sample. In a specimen report, click the button and select a sample 
from the drop-down menu to insert the selected Spillover Matrix for the 
selected sample. The Spillover Matrix cannot be edited within the report. If the 
Spillover Matrix is modified in the main interface, it will be updated 
automatically in the report window. 

 
Insert Reference Spectra: Inserts the Height or Area parameter-based 
Reference Spectra into the report. In a sample report, click the button to insert 
the selected Reference Spectra for the selected sample. In a specimen report, 
click the button and select a sample from the drop-down menu to insert the 
selected Reference Spectra for the selected sample. User can also select All in 
One Plot to insert all Reference Spectra of selected sample in one plot. This 
option is not available when user selects Compensation to analyze the data. 



Reports 
 
 

NovoExpress (Opteon) Software Guide 350 

  

 
Insert Photodetector Gain: Inserts a table of photodetector gain setting for a 
sample. In a sample report, click the button to insert a table of photodetector 
gain setting for the sample. In a specimen report, click the button and select a 
sample from the dropdown menu to insert a table of photodetector gain setting 
for the selected sample. 

  
Insert Fluorochromes Information: Inserts a table of fluorochrome information 
for a sample. In a sample report, click the button to insert a table of 
fluorochrome information for the sample. In a specimen report, click the button 
and select a sample from the drop-down menu to insert a table of 
fluorochrome information for the selected sample. 

 
Plate Information: Inserts plate information for selected sample, including 
plate ID, barcode of the plate (if scanned), and description. It is available only 
when NovoSampler S is connected. 

 

 
Insert Shape: Click to insert a horizontal line, vertical line, or rectangle. 

 
Insert Picture: Click to select a picture to insert in the prompted window. The 
picture will be resized to an appropriate size with the original aspect ratio and 
inserted in the report.  

 
Select: The default is Select All. From the arrow on the right of the button, 
Select Similar Objects is also available. 

 
Page Orientation: Switches the page layout orientation between portrait and 
landscape. 

 
Zoom: Sets the zoom percentage of the displayed page. When report displays 
is zoomed in or zoomed out (zoom percentage is not 100%), user cannot 
double-click report item to enter into edit mode. 

 

Align: Select two or more objects in a page to activate these features. When 
selecting multiple objects, the first object has white squares on the border, 
while additional objects have black squares. From the four alignment options 
(align top, left, bottom, or right), select the edge to be aligned. The objects will 
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be moved so that the selected edge of all selected objects aligns with the 
object first selected.  

 
Lock Position: Check this item to forbid moving any object of the report. Align 
Top, Align Left, Align Bottom, Align Right buttons will be disabled when Lock 
Position is checked.  

 

Make Same Size / Width / Height: Select two or more objects in a page to 
activate these features. When selecting multiple objects, the first object has 
white squares on the border, while additional objects will have black squares. 
From the three resize options (make same size, width, or height), select the 
desired resize dimension. The selected objects will be resized to match the 
selected dimension of the object first selected.  

 
Previous: In a sample report, click to switch to the previous sample’s report. In 
a specimen report, click to switch to the previous specimen’s report. 

 
Next: In a sample report, click to switch to the next sample’s report. In a 
specimen report, click to switch to the next specimen’s report. 

 
Select: Select to view or edit another report. 

 
Set Page Header and Footer: Click to show header and footer editing interface. 

Page: 1/3 Page: Displays the current page and the total number of pages. 

Automatically Generate Reports 

The report can be generated through an automated or a manual mode. In the 
automated mode, the user performs the analysis and creates the plots in the main 
software interface. The report will be automatically created with the plots and 
statistical information added without the need for additional input from the user. 
The user is not able to add, delete, or modify the contents of the report in this 
mode. 

To switch the mode from manual to automated, click on the Auto Report Mode 
button in the toolbar  . The prompt below will appear to confirm the switch to 
the automated mode. Click OK, to automatically generate the report. 
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To switch the mode from automated to manual, click on Auto Report Mode button 
in the toolbar  . The user can now make modifications to the report. 

 
 

NOTE When creating a report, it may be best to use the automated mode to generate an 
initial report and then switch to manual mode to modify the report. 

 

Report Options 

Report Options dialog provides user interface for user to customize report of auto 
and manual mode. To open Report Options dialog, click the Report Options button 

 in the report window toolbar. The Report Options dialog is shown below: 
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The settings in Plot Options panel are used for customizing plots inside report. 
They are effective for both auto and manual report mode. 
• Show Gate Name in Gate Label:  

If selected, gate name is displayed in gate label on the plot. 
• Show Population Percentile in Gate Label:  

If selected, gate label is displayed with the percentage of the population within 
the gate. 

• Plot Title Options:  

If clicked, a drop-down menu will show as below. 

 

 Show Plot Title:  

If selected, plot title is displayed on the report plot. 
 Sample Name: 

If selected, the sample name is displayed in the report plot title. 
 Specimen Name: 

If selected, the specimen name is displayed in the report plot title. 
 Gating Name: 

If selected, the gating name is displayed in the report plot title. 
 Gating Hierarchy: 

If selected, the gating hierarchy is displayed in the report plot title. 
 
 

The settings in Auto Report Mode Options panel are used for customizing auto 
report. They are only effective for auto report mode. 
•  Number of Plots per Row:  

Sets how many plots are shown in one row. 
• Orientation:  

Sets the page layout orientation to portrait or landscape. 
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• Plot Statistics:  

If selected, shows gate statistics of plot.  
• Sample Statistics: 

If selected, shows gate statistics of sample and the Settings option on the 
right  will become available. User can click it to select to show the gate 
hierarchy. 

 

• Compensation:  

If selected, shows compensation matrix and the Settings option on the right 
will become available. User can click it to select to show the Height Spillover 
Matrix or Area Spillover Matrix. This setting will not be available if Spectral 
Unmix was used to deconvolute the data. 

 

• Plots Align by Workspace:  

If selected, shows the plots in the order of fluorescence channel and 
fluorochromes. If not selected, shows the plots in the order defined in 
Experiment Manager. 

• Fluorochromes Setting:  
If selected, shows the fluorochrome settings, and the Settings option on the 
right will become available.  
When Spectral Unmix was used to deconvolute the data, clicking Settings 
allows user to select to show the Parameter, Emission Channel, Reference 
Spectra, Fluorochrome, Display Name, Marker information.   

 

When Compensation was used for data analysis, clicking Settings allows user 
to select to show Parameter, Virtual Filter, Fluorochrome, Display Name, 
Marker information.  
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• Spillover Matrix after Unmixing:  

If selected, shows Spillover Matrix after unmixing and the Settings option on 
the right will become available. User can click it to show the Height Spillover 
Matrix after Unmixing or Area Spillover Matrix after Unmixing. This setting 
will not be available if Compensation was used for data analysis. 

  

• Photodetector Gain:  

If selected, shows the photodetector gain setting. 
• Plate Information: 

If selected, shows the plate information. This option is available only when 
NovoSampler S is connected. 

• Insert Page Break Before Each Sample: 

Only available for specimen report. If selected, a page break will be inserted 
before each sample. 

• Show Statistics Columns:  

Selects statistical items to display. 
• Show Sample Statistics Rows:  

Selects sample statistical items to display. 
• Select All:  

Selects all associated items to display on report. 
• Select Plots:  

Selects plots to display on report. 
• Raw Plots:  

Check to display the plots from Raw Workspace. 
• Unmixed Plots:  
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Check to display the plots from Unmixed Workspace. 
• Reference Spectra Plots:  

Shows Reference Spectra plot on the report. User can click the Settings option 
on the right to select to show all the Reference Spectra in one plot by checking 
All in One Plot, or show each Reference Spectra individually by checking One 
by One plot, and select either Height or Area parameter is used when plotting 
the Reference Spectra. This setting will not be available if Compensation was 
used for data analysis. 

 

• Set as Default:  

Sets above settings as default setting for new reports. 
• Apply to All:  

Applies above settings to all report in the experiment. 

Report Editor 

In the manual mode, the user is able to freely edit the report. Options include 
adding, removing, and editing objects in the report. 

Add Report Objects 

Objects can be added to the report through the toolbar, Workspace, and 
Experiment Manager panel. To add objects using the toolbar, use the insert 
functions described in Report Interface. From both the Workspace and Experiment 
Manager panel, objects corresponding to the sample can be dragged and dropped 
into the report. 

Select Report Objects 

Click on an object to select it in the report. An object can have one of two selected 
states. After clicking on an object, the object will be highlighted. In this state, the 
object is bordered by a black dashed line with white control points. If the object is 
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then double-clicked, it is in the edit state, and the object is bordered by a red 
dashed line with black control points. Different operations can be performed on 
the object depending on the selected state. The two states are shown below. 

This is the object after being selected: 

 

This is the object selecting and in the editing state: 

 

To have multiple objects selected simultaneously: 
• In the toolbar, click the Select All button  , to select all of the objects in the 

report. 
• Left-click and drag in the report to enclose objects inside of the dashed 

rectangle. Objects within the dashed rectangle will be selected when the 
mouse button is released. 
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• Select an initial object. In the toolbar, click Select All, then Select Similar 
Objects. All objects in the report of the same type as the initial object will be 
selected. 

• Select an object. Press and hold the Ctrl key to select additional items. 

When multiple items are selected, the first item is bordered by a black dashed line 
with white control points and additional items are bordered by black dashed lines 
with black control points. 

Edit Report Objects 

Double-click on a selected object or right-click on the object and select Edit to 
enter the editing mode for that object. This section will describe the editing options 
available for the objects. 

Edit Text 

Double-click on the textbox or right-click on the textbox and select Edit to enter 
editing mode. In this mode, text formatting tools will appear. Right-click on the 
textbox and select Insert to insert sample information including sample name, 
sample notes, specimen ID, specimen name, operator, run time, cytometer and 
software information, as shown below. This can also be accessed by clicking the 
Insert Text  icon’s drop-down menu in the tool bar. 

 

Edit Plots and Statistics 

Double-click on the plot or right-click on the plot and select Edit to enter editing 
mode. Plots can be edited in the report by right-clicking in the plot to access the 
plot tools. Modifications made to the plot will also be updated to the plot in the 
main interface. In addition, if the plots are modified in the main interface, the plots 
in the report will also update automatically.  
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Double-click on the statistics box or right-click on the statistics box and select Edit 
to enter editing mode. Right-click in the selected statistics box to choose the 
columns to display, as shown below. 

 

Filter Statistics 

User can right click the statistics box of the report, click Filter Rows to open the 
Filter Rows window. Check to select the gate(s) to display associated sample 
statistical information in the report and click OK to confirm. 
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When the statistics box shows the gate hierarchy, the Filter Rows window displays 
the gate hierarchy too. When the child gate is checked, the parent gate will be 
automatically checked. 

 

When the statistics box does not show the gate hierarchy, the Filter Rows window 
does not display the gate hierarchy either. 
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Edit Shapes 

Double-click on an inserted shape (horizontal lines, vertical lines, or rectangles) or 
right-click on the shape object and select Edit to ender editing mode. A Shape 
Properties window will appear. In the window, line width, style, and color can be 
set. 

 

Edit Pictures 

Double-click on the picture or right-click on the picture and select Edit to enter 
editing mode. The Open window will appear, and users can select an image to 
replace the current picture. 
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Align Report Project Items 

There are multiple methods to align objects in a report. 
• Use the mouse to drag an object within the report. As the object is dragged, 

smart guides appear when the object is aligned with other objects in the 
report. Drag the object until it is aligned with the appropriate other objects and 
release the mouse button to set the object at the new location. 

• Select the object and use the ￪, ￬, ￩, ￫ keys on the keyboard to move the 
object. Move the object until the object appears to be aligned with the 
appropriate other objects. 

• Select multiple objects. Select the appropriate align tool from the toolbar 
depending on the edge of the object to be aligned (Align Top  ; Align Left 

 ; Align Bottom  ; Align Right  ). The objects will be aligned along the 
selected edge relative to the position of the first selected object. (The first 
selected object will be displayed with white control points, while other selected 
objects will be displayed with black control points.) 

Resize Objects 

There are two methods to resize objects in a report: 
• Select an object. Click and drag on the control points of the object to resize the 

object. 
• Select multiple objects. Select the tool to Make Same Size, Make Same Width, 

or Make Same Height. The objects will be resized to match the appropriate 
dimensions of the first selected object. (The first selected object is displayed 
with white control points, while other selected objects are displayed with black 
control points.) 

Order Object Levels 

When objects are overlapped in the report, the object that is displayed is 
determined by the ordering of the object. To change the ordering of an object, 
select the object. Right-click on the object and select Ordering. Options then 
include Bring to Front, Bring Forward, Send Backward, and Send to Back. Select 
the appropriate operation for the object. Objects toward the front are displayed 
over objects further back. 

Cut, Copy, Paste, and Delete 

• Cut: Select an object. Use the keyboard shortcut Ctrl X or right-click and select 
Cut to cut an object. 
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• Copy: Select an object. Use the keyboard shortcut Ctrl C or right-click and 
select Copy to copy an object. The copied object can be pasted to the office 
software such as Word, PowerPoint, and Excel. 

• Paste: After cutting or copying an object, the object can be paste from the 
clipboard using the keyboard shortcut Ctrl V or right-click and select Paste. 
The object will be pasted at the specified location. 

• Delete: Select an object. Use the keyboard Delete key or right-click and select 
Delete to delete an object. 

Insert or Delete Pages 

To insert or delete pages, use the Insert Page and Delete Page button from the 
toolbar. For more information, Refer to Report Interface in this guide. 

Header and Footers 

Headers and Footers Working Interface 

The header and footer display information at the top and bottom of the pages, 
respectively, in the report. To edit the header and footer, click the Set Page Header 
and Footer button  , from the toolbar. As shown below, the rectangular region at 
the top and bottom of the page for the header and footer is outlined. A toolbar 
containing functions to edit the header and footer is also available. At this time, the 
header and footer can be edited. 
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Toolbar for Header and Footer Functions: 
 

Icon Description 

 
Insert Text: Inserts a textbox.  

 
Insert Page Number: Inserts page numbers. Select between two styles: 1,2,3 ... or 1/3, 
2/3 .... 

 
Insert Shape: Inserts a horizontal line, vertical line, or rectangle.  

 
Insert Picture: Inserts a picture.  

 
Set Page Header and Footer: Click to exit header and footer editing mode. 

Edit Headers and Footers 

To edit the header, click in the header region at the top of the page. Once selected, 
the region is bordered by a red rectangle. The toolbar can now be used to add 
objects to the header. 

To edit the footer, click in the footer region at the bottom of the page. After 
selected, the region is bordered by a red rectangle. The toolbar can now be used to 
add objects to the footer. The default footer includes an object for page number. 

The methods for editing the header and footer are consistent with the rest of the 
report interface with the following exceptions. 
• The level of the objects in the header and footer cannot be ordered. Newer 

created objects are automatically created more towards the top. Objects in the 
header and footer are behind objects created in the main report interface. 
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• Smart guides are not available to help align objects in the header and footer. 
• Copying and pasting objects is unavailable in the header and footer. 
• Variables such as sample name, specimen ID. Specimen name, operator, run 

time, and cytometer and software information cannot be inserted into 
textboxes in the header or footer. 

After editing the header and footer is complete, click the Set Page Header and 
Footer button  , to return to the main report interface. The header and footer will 
display on all pages of the report. 

Copy the Header and Footer Settings to Other Reports 

To transfer the header and footer from one report to another, copy and paste the 
report as a template as described in Templates. 

Report Output 

The reports can be printed or converted to a PDF file. 
• To Print: 

Click the toolbar Print button  . Alternatively, right-click the report node in 
the Experiment Manager panel and select Print. The print window will appear. 
Select the correct printer and print the report. 

• To Convert to PDF: 

Click the toolbar PDF button  . The Save As window will appear to save the 
report as a PDF file. 

Batch Print Reports 

To batch print reports: 

In the main interface window, click the Batch Print Reports button in the Home tab 
of the Menu Bar. Alternatively, select File > Print > Batch Print Reports. The Batch 
Print Reports window will appear. 
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The reports are listed on the left side of the Batch Print Reports window. Use the 
checkboxes to select the reports to be printed. On the right side of the window, 
select either to print the report or generate PDF files for the report.  

If printing, select a printer and click Print.  

If generating a PDF, select a file path to save the PDF files. If the Specimen name 
box is checked, the PDF files will be saved in the format specimen name_sample 
name_YYYYMMDD_hhmmss. If the box is unchecked, the PDF files will be saved 
in the format sample name_YYYYMMDD_hhmmss. Click Print to begin generating 
the PDF files. 

 
 

NOTE One PDF file will be created for each report selected by default. If Merge reports in 
the same specimen/group/experiment is checked, all reports of one 
specimen/group/experiment will be printed into one PDF file. 

 

After clicking Print a progress bar will appear as shown below. 
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During the printing process, click Cancel to stop the printing. 
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9 QC Test 

This chapter describes the procedures to run QC Test and view the report for 
Agilent flow cytometers. 

 

The NovoExpress (Opteon) software QC Test function automatically conducts the 
QC procedure using Instrument QC particles. Click Instrument > QC Test from the 
NovoExpress (Opteon) software to initialize the QC test. The QC Test Report 
tracks the QC test results over time and can be reviewed through Instrument > QC 
Test Report from the NovoExpress (Opteon) software. 

 

Instrument QC particles are polystyrene microspheres with uniform size (average 
diameter of 3 μm). The QC particles contain 5 kinds of microspheres with differing 
fluorescence intensities and one blank microsphere. These fluorescent 
microspheres are internally stained with fluorescent dye, which can be excited by 
all the lasers with known MESF (Molecules of Equivalent Soluble Fluorochrome) 
values for each fluorescent peak, from which the linearity can be calculated.  

There are three test results: 
• Pass 

Indicating that all the performance parameters meet the requirements. 
• Acceptable 

Indicating that the performance parameters are not optimal compared to the 
manufacturing QC criteria. However, continued use of the instrument is still 
allowed and the experiment results should not be impacted.  

• Fail 

Indicating that the performance parameters do not meet the requirements. A 
label in red will show on report to indicate the reason of failure. Please contact 
your local Agilent Technologies representative when the QC test fails. 

The QC Test procedure generally includes following steps:  
• Prepare QC particles sample. 
• Fill in Test Information 
• Electronic Noise Test 
• Optical Noise Test 
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• Calibrate Time Delay 
• Adjust Photodetector Gain 
• Run QC test. 
• System Test (Optional) 
• View QC reports and Levey-Jennings plot 

 

NOTE It is highly recommended to run the QC test on daily basis. Under the situation 
when user has not performed the QC test in the past seven days, the following 
window will be prompted when user starts sample collection for the first time each 
day. 

 
User can click Yes to proceed to perform the QC test or click No to skip the QC test. 
When Do not prompt this message within 7 days is checked, the software will not 
prompt this window in the next 7 days. 

 

NOTE Under the situation when the default gain recorded in the instrument is different 
from the one recorded in latest QC report, following window will be prompted when 
user starts sample collection for the first time each day. 

 

User can click Yes to proceed to re-do the QC test or click No to skip the QC test. 
When Do not prompt this message within 7 days is checked, the software will not 
prompt this window in the next 7 days. 
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NOTE The software prompted windows displayed in this chapter is for illustration purpose 
only. User may observe different windows depending on the Instrument models. 

Prepare QC Particle Sample 

1 Label a 12 × 75 mm tube for the QC test. Add 1 mL dilution buffer (0.8 mL PBS 
and 0.2 mL NovoRinse solution) into the tube. 

2 Take one bottle of QC particles from storage. Invert the bottle to mix the 
particles thoroughly. 

3 Add two drops of QC Particles into the test tube. 
4 Vortex the test tube to mix the QC particles thoroughly.  
5 Place the tube onto the instrument and start the QC test. If NovoSampler S is 

used, place the tube to the A1 well of a 40 tube rack (12X75 mm tubes) and 
run the QC Test immediately. If the prepared QC particle sample is not 
intended to be run immediately, store the sample in a 2-6 ℃ refrigerator away 
from light. The prepared QC particle sample should be used within four hours 
after preparation. 

 
 

NOTE Make sure the QC particle sample is prepared properly following the above 
procedure. Properly prepared QC particle sample would give enough QC particle 
counts during the QC Test. If user selects to perform system test, ensure to prepare 
at least 1 mL of QC particle sample. 

Run QC Test  

1 Import the Instrument QC Particles Lot file. 

Download the Lot File for the specific batch of QC Particles from 
https://www.agilent.com/en/support/qc-particles-lot-file. Launch and log into 
NovoExpress (Opteon) software, click Setting > Experiment > Reagent Lots to 
open Reagent Lots window, click Import to import the lot file. The Lot ID will 
be automatically listed after importing the lot file. Click OK to continue. 

https://www.agilent.com/en/support/qc-particles-lot-file
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2 Ensure the instrument is in Ready status. If NovoSampler S is used, open the 
cover of NovoSampler S and place the sample plate on the tray. Ensure the 
plate is fully seated with the correct orientation onto the shaker.  

3 In the NovoExpress (Opteon) Software, click the QC Test button in the 
Instrument tab of the Menu Bar to open the QC Test window. The window is 
shown below. 

 
NovoExpress (Opteon) QC Test Window when NovoSampler S is not connected 
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NovoExpress (Opteon) QC Test Window when NovoSampler S is connected 

In the window, enter the name of the operator, select the QC particles lot ID, 
select the Well ID (if NovoSampler S is used) and click Next. If the correct QC 
particles lot ID is not listed, please refer to the first step to download and save 
the QC particles Lot File.  

User can check Perform System Test to perform system test after QC test is 
completed. The software will prompt the message below after user clicks 
Next. User needs to ensure 1 mL of QC particle sample is prepared and then 
click OK to continue. 
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NOTE System test is optional but recommended to ensure optimized data analysis 
results. If user unchecks Perform System Test, and the last time the user 
performed this test was more than 7 days ago, the software will prompt the 
message below after user clicks Next. User can click Yes to perform system test or 
click No to skip the system test or click Cancel to keep current selection and close 
this message window. 

 
User can check Export Report to CSV File to export report as a csv file after QC test 
is completed. The exported CSV file (in the format of YYMMDD_hhmmss.csv) is 
automatically saved in C:\Program Files (x86)\NovoExpress (Opteon)\Config\QC 
\QC Report Files by default. 

 

NOTE The default name of the exported CSV file is in the format of QC test date and time. 
For example, if the QC test is performed at 10:30:40 am on January 18, 2019, the 
default name of the exported CSV file will be 190118_103040.csv. 

 

4 Click Run to begin the test. The software will collect electronic and optical 
noise (see figure below) before collecting the events. The results will be 
displayed in real-time in following windows. 
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5 After electronic and optical noise are collected, the software will automatically 
proceed to calibrate time delay. After the calibration completes, the result (i.e., 
Pass or Fail) will be displayed in the QC test report. 
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6 After time delay is calibrated, the software will automatically proceed to adjust 

photodetector gain if the time delay between 488 nm laser and at least one of 
other laser are within the target range. 

 
7 After photodetector gain is adjusted, the software will automatically proceed 

to collect data from the prepared QC particle sample. The results will be 
displayed in real-time in following window. 
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8 After data collection is complete, if user checked Perform System Test, the 
software will automatically proceed to perform the system test as shown 
below and display the QC result in QC Test Report window afterwards. 

  
If user did not check Perform System Test, the software will automatically 
skip the system test and prompt window below. User needs to click the Report 
button to open the QC Test Report window to view the test results. 
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9 From the QC Test Report window, user can view the QC test results for 
various parameters (e.g., Time Delay, CV, MFI, Result). User can click Message 
to view the QC test related messages or click Open Data File to open the 
associated experiment file software automatically created or click Finish to 
close this window or click Print to print the test report.  
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NOTE To view the history of the resulting QC data, click QC Test Report from the 
Instrument tab of the Menu Bar (described in View QC Test Report ). Highlight the 
date to be viewed and select the QC Test Report tab. 

 

NOTE Under the situation when the QC test reports show Failed for any of the channels, if 
user closes the QC test report window, the following dialogue window will be 
prompted. 

 

After user clicks Yes, these channels will not be displayed in the Parameter panel, 
and the Instrument Configuration window will display these channels in grey color 
with message at the lower side as shown below. The blocked channels will be 
excluded from data collection and unmixing.   
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To restore these channels (i.e., include them in the next sample data collection), 
user can open the Instrument Configuration window, and click Restore Blocked 
Parameters, then click OK in the prompted window. The software will be 
automatically restarted to make the changes effective.  

View QC Test Report 

The QC test report function stores previous QC test results and provides a data 
analysis feature to track instrument performance changes over a period time. To 
open the QC Test Report window, click QC Test Report from the Instrument tab of 
the Menu Bar. The window is shown below. 

 

The QC Test Report window contains the following sections. 
 

Interface Description 

Title Area  Displays the report name and the Export CSV File, Open Data File and Print button.  

Query Area  Query a time interval for QC test reports. As shown: 
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QC Test 
Report 

Displays the QC test report for a selected report from the query results. As shown:  

 

Levey-
Jennings 
Report  

Displays the QC test data over time to observe trends in instrument performance. As 
shown: 
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Export CSV 
File 

Export the QC result as a csv file. 

Open Data 
File 

Open the QC data file of the selected report. 

Print Click the Print button in the top right corner of the window to print QC test reports or 
Levey-Jennings reports. 
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10 Troubleshoot 

This chapter provides the information for troubleshooting Instrument and 
associated accessories, including prompted message ID, software messages, 
possible causes, recommended solutions, and procedures to create technical 
support files.  

Troubleshoot Instrument 

The following table lists possible causes for warning and error prompts from the 
status bar when connecting with Instrument. 

 
 

Message 
IDs 

Software 
Messages 

Possible Causes  Recommended Solutions  

0x0001 Collision of SIP  The movement of the SIP is 
blocked by some obstacles. 

Locate and clear the obstacles. The 
instrument will automatically start 
error handling and move the SIP to 
the home position.  

Incorrect plate selected in plate 
manager. 

Select the correct plate in the plate 
manager window. 

Incorrect positioning of plate in 
NovoSampler S. 

Position the plate on the shaker 
correctly. Ensure the plate is seated 
flat on the stage inside the clamps. 
 

NovoSampler S is not calibrated. Re-calibrate NovoSampler S. 

Dirty SIP or SIP Cleaning 
apparatus. 

Clean the SIP or SIP cleaning 
apparatus following the procedures 
described in Preventative 
Maintenance in associated 
instrument operator's guide. 

0x0002 Running out of 
NovoFlow  

NovoFlow solution is not 
sufficient to continue to run any 
samples. 

Refill the NovoFlow container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide. 
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If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0003 Running out of 
NovoRinse  

NovoRinse solution is not 
sufficient to continue to run any 
samples. 

Refill the NovoRinse container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide.  

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0004 Running out of 
NovoClean 

NovoClean solution is not 
sufficient to continue to run any 
samples. 

Refill the NovoClean container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide.  

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0005 Waste container 
is full  

Waste container is too full to 
continue to run any samples. 

Empty the waste container 
following the procedures described 
in Empty Waste in associated 
instrument operator's guide.  

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0006 System voltage 
is out of range 

System Error. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0007 System electric 
current is out of 
range 

System Error. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 
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0x0008 Firmware 
configuration 
error 

System Error. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0009 
0x000A 
0x000B 
0x4009 
0x400D 

…… laser self-
test error 

Specified laser is not functioning 
properly. 

The instrument will automatically 
reset the laser and run a laser self-
test. It takes approximately 5 to 10 
minutes.  

0x000C 
0x000D 
0x000E 
0x400A 
0x400E 

…… laser is not 
connected 

Specified laser is not detected. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x000F NovoSampler 
communication 
lost 

The cable between the 
NovoSampler S and instrument is 
not securely connected. 

Reconnect the cable between the 
NovoSampler S and instrument.  

NovoSampler S is not 
communicating with instrument. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0010 NovoSampler 
has not been 
calibrated 

NovoSampler S is newly installed 
or re-connected. 

Follow the prompted instructions to 
calibrate the NovoSampler S. 

0x0011 NovoSampler 
calibration 
failed…… 

NovoSampler S is not installed 
properly. 

Re-install and calibrate the 
NovoSampler S following the 
procedures described in Installation 
in associated operator's guide. 
Ensure the NovoSampler S is 
seated flat on the stage and tightly 
close to the instrument. 

NovoSampler S cover is opened 
during calibration. 

Close the NovoSampler S cover 
and redo the calibration. 

The optocoupler or motor of 
NovoSampler S is not working 
properly. 

• Restart the instrument and redo 
the calibration. 

• Contact Agilent technical 
support if the error persists. 

0x0012 The movement 
of plate is out of 
range 

The movement of the orbital 
shaker is blocked. 

• Check the path of the orbital 
shaker to make sure there are 
no objects blocking the 
movement. Clear the block if 
there is anything.  

• Re-calibrate the NovoSampler 
S. 

NovoSampler S is not installed 
properly. 

Re-install and calibrate the 
NovoSampler S following the 
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procedures described in Installation 
in associated operator's guide.  

0x0013 Cover of 
NovoSampler is 
opened during 
moving plate 

The cover of NovoSampler S is 
open during moving plate. Or the 
cover is not closed well. 

Close the cover. NovoSampler S 
will automatically reset and be 
ready for operation. 

0x0014 Pressure is out 
of limit 

Waste container is not correctly 
connected to the instrument. Or 
waste tubings are bending and 
clogged. 

Follow the prompted instructions 
from NovoExpress (Opteon) to 
clear the error. If instrument is 
connected, check the quick 
coupling connectors to ensure the 
waste container is correctly 
connected to the instrument. 
Ensure the waste tubings are not 
bending and clogged.  

Sheath in-line filter is clogged. Follow the prompted instructions 
from NovoExpress (Opteon) to 
clear the error. If instrument is 
connected, replace the sheath in-
line filter following the procedures 
described in Replacing Fluidic 
System Consumables in instrument 
operator's guide. 

Sample injection probe or flow cell 
is clogged. 

Follow the prompted instructions 
from NovoExpress (Opteon) to 
clear the error.  

0x0015 NovoSampler 
firmware error 

NovoSampler S firmware is not 
working properly. 

Re-install or upgrade the 
NovoSampler S firmware. 

0x0016 
0x0017 
0x0018 
0x400B 
0X400F 

…… laser does 
not emit 

Specified laser is not connected 
properly, or laser is not working 
properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0019 
0x001A 
0x001B 
0x400C 
0x4010 

…… laser 
communication 
error 

Specified laser is not 
communicating with the 
instrument properly or the laser is 
not working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x001C Sample injection 
probe reset 
failed 

Bad connection or optocoupler is 
not working properly. 

• Click the OK button in the 
prompted dialog box or wait 10 
seconds for automatically error 
handling.  

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 
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0x001D Sampling Pump 
reset failed 

Bad connection or optocoupler is 
not working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0020 System 
initialization is 
paused 

Liquid level in the reagent 
containers is not within normal 
range when instrument is 
powered up. 

• Make sure that the instrument 
reagent containers are placed 
correctly and the liquid level in 
the containers is within the 
normal range. 

• Click OK on the prompted 
dialog to continue system 
initialization. 

0x0021 Sheath fluid 
pump reset 
failed 

Bad connection or optocoupler is 
not working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0023 Resetting 
NovoSampler to 
home position 
failed 

NovoSampler S is not working 
properly. 

• Click Instrument → 
NovoSampler S → Reset in 
NovoExpress (Opteon) software 
to reset NovoSampler S.  

•  Restart the NovoSampler S. 

0x0100 Instrument cover 
opened 

Instrument cover is opened or not 
tightly closed. 

Close the instrument cover. 

0x0101 NovoFlow 
running low 

NovoFlow solution is below the 
pre-set volume limit. 

Refill the NovoFlow container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0102 NovoRinse 
running low  

NovoRinse solution is below the 
pre-set volume limit. 

Refill the NovoRinse container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0103 NovoClean 
running low 

NovoClean solution is below the 
pre-set volume limit. 

Refill the NovoClean container 
following the procedures described 
in Add Instrument Reagents in 
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associated instrument operator's 
guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0104 Waste container 
is close to full 

Waste is above the pre-set volume 
limit. 
 

Empty the waste container 
following the procedures described 
in Empty Waste in associated 
instrument operator's guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station S (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0105 Cover of 
NovoSampler is 
opened  

Cover of NovoSampler S is 
opened. Or the cover is not closed 
well. 

Close the cover. 

0x0106 NovoSampler is 
disconnected 
when powered 
up 

The NovoSampler S is 
disconnected when powered up 

• Shut down instrument.  
• Reconnect the cable of the 

NovoSampler S to instrument.  
• Turn on instrument and follow 

the prompts to calibrate the 
NovoSampler S. 

• Contact Agilent technical 
support if the error persists. 

0x0109 Fluidics Station 
is not connected 

Cable between the fluidics station 
S and the instrument is not 
properly connected. 

• Power down the instrument.  
• Reconnect the cable between 

the fluidics station S and the 
instrument.  

• Power up the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x010A 
0x010B 
0x010C 
0x010D 

… liquid level 
sensor failure 

Specified liquid level sensor in the 
fluidics station S (or Cart) is not 
working properly. 

• Reconnect the fluidics station S 
(or Cart) cable.  

• Restart the instrument.  
• Contact Agilent technical 

support if the error persists. 

0x010F Sheath filter is 
clogged. Please 
replace the 
sheath filter and 

Sheath in-line filter is clogged. Replace the sheath in-line filter 
following the procedures described 
in Replacing Fluidics System 
Consumables in associated 
instrument operator's guide. 
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run the Priming 
procedure 

0x0110 Recovering 
collision error 

Plate stops at an incorrect 
position. 

No action is needed. Instrument will 
automatically recover the error. 

0x0111 Orbital shaker 
homing position 
reset failure 

Orbital shaker of NovoSampler S 
is not working properly. 

No action is needed. The 
NovoSampler S can be used 
normally. 

0x0112 0.05 µm sheath 
fluid 
ultrafiltration 
(UF) filter is 
clogged 

0.05 µm sheath fluid ultrafiltration 
(UF) filter is clogged. 

Replace the 0.05 µm sheath fluid 
ultrafiltration (UF) filter following 
the procedures described in 
Replacing Fluidics System 
Consumables in associated 
instrument operator's guide. 

0x0113 The sample tube 
compartment 
door is open 

The sample compartment door is 
not closed properly or the door 
sensor is not working properly. 

• Close the door. 
• Contact Agilent technical 

support if the error persists 

0x1001 Fluidics 
procedure run 
error 

Fluidics procedure file is 
damaged. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x300C Data 
Communication 
error between 
main board and 
AD board 

AD Board or Main Board is not 
working properly  

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists 

0x300D Photodetector 
module 
communication 
error 

Photodetector module is not 
working properly or not properly 
connected to the AD board. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x3102 Failed to read 
photodetector 
information 

Photodetector sensor is not 
working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x3106 Photodetector 
module not 
detected 

Photodetector module is not 
working properly or not properly 
connected to the AD board. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x6100 Communication 
error between 
NovoSampler 
and the orbital 
shaker 

The orbital shaker is not 
communicating to NovoSampler 
S is not working properly. 

• Restart NovoSampler S through 
NovoExpress (Opteon).  

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x7000 Fluidics cart 
firmware error 

NovoCyte Fluidics Cart firmware 
is not working properly. 

• Restart the instrument. 
• Replace the NovoCyte Fluidics 

Cart. 
• Contact Agilent technical 

support if the error persists. 
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0x7001 NovoFlow liquid 
level sensor is 
not connected 

NovoFlow liquid level sensor is 
not connected or does not work 
properly. 

• Reconnect the NovoFlow liquid 
level sensor. 

• Contact Agilent technical 
support if the error remains 
after reconnection. The sensor 
may be damaged and need to 
be replaced. 

0x7002 Waste liquid 
level sensor is 
not connected 

Waste liquid level sensor is not 
connected or does not work 
properly. 

• Reconnect the waste liquid level 
sensor. 

• Contact Agilent technical 
support if the error remains 
after reconnection. The sensor 
may be damaged and need to 
be replaced. 

0x7100 NovoCyte 
Fluidics Cart 
communication 
lost 

NovoCyte Fluidics Cart is not 
properly connected to the 
instrument. 

• Ensure the DVI cable between 
the fluidics cart and the 
instrument is properly 
connected. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0xA020 Laser board 
firmware error 

Laser board firmware is not 
working properly. 

• Re-install or upgrade the laser 
board firmware. 

0xA021 Laser board 
communication 
lost 

Laser board is not properly 
connected to the instrument. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0xA100 The temperature 
of the 
Photodetector 
module is 
abnormal and 
cannot work 
normally 

Photodetector module is not 
working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

 Communication 
error (code: xx, 
xx). Please 
restart 
Instrument and 
NovoExpress). 

USB cable between the 
instrument and workstation is not 
connected properly. 

• Reconnect the USB cable 
between the instrument and the 
workstation.  

• Restart the instrument, 
workstation and NovoExpress 
(Opteon) software. 

• Contact Agilent technical 
support if the error persists. 



Troubleshoot 
 
 

NovoExpress (Opteon) Software Guide 390 

Technical Support Request 

In case you need to contact Agilent technical supports, use the Technical Support 
Request from Home menu to create a request. Technical Support Request 
Creation Wizard automatically collects instrument configurations, NovoExpress 
(Opteon) system logs, current screenshot, current experiment file and other 
information that helps diagnosis and troubleshooting of NovoCyte Opteon Spectral 
flow cytometer. You can also attach any other files using this function.  
1 Click Home > Technical Support Request to open the Technical Support 

Request Creation Wizard. 

  

2 Click Next button and input request description. 
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3 Click Next button and select the files to be attached. Any related files including 
experiment files (*. ncf) can be attached. 

 

4 Click Create button to start creating technical support request. 
5 Click Finish. 

 

After the request creating process is completed, send the created request files 
to Agilent technical support.  

 



Version History 
 
 

NovoExpress (Opteon) Software Guide 392 

11 Version History 
 

Date Changed by Version/Description 

05/01/2024  Edition 1.00: Initial release. 

07/22/2024  Edition 1.01: Added Distance Filter function in Option 
Setting and Sample tab in software main window, revised 
QC procedure with system test function added.  

03/03/2025  Edition 1.02: Updated Chapter 3, 5, 9 to include newly 
added functions from NovoExpress (Opteon) Software 
v2.1.0.  
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